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Introduction
This section provides an overview of the TIBCO iProcess® Workspace (Browser). 

What is the TIBCO iProcess Workspace 
(Browser)?
The TIBCO iProcess Workspace (Browser) is a Business Process Management (BPM) 
application that runs over the internet or an intranet. As a BPM application, it automates 
the movement of data/information through your business process, whatever your business 
may be. It may automate the process of filing an insurance claim, a loan application, or any 
process that has multiple steps.

The TIBCO iProcess Workspace (Browser) application is run in a browser (e.g., Microsoft 
Internet Explorer). You connect to a TIBCO iProcess Engine over the internet or an intranet 
by entering a web address that is determined by the location at which your TIBCO software 
is installed.

After connecting to the TIBCO iProcess Engine by entering a valid user name and password, 
you will be presented with screens that allow you to perform the functions your specific 
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application was designed to perform. Each time you initiate an action in your client 
application (i.e., by clicking on something), a request is sent to the TIBCO iProcess Engine 
instructing it to either send data to the client or to perform some sort of action (e.g., save 
the data you’ve just entered).

All data pertinent to your business process is stored in a database on the TIBCO iProcess 
Engine. The iProcess Workspace (Browser) provides a way for you to access and 
manipulate that information via the internet.

Understanding a Business Process
At the heart of the iProcess Workspace (Browser) is the iProcess “procedure,” which defines 
the flow of information in your application. Procedures are defined with a TIBCO tool 
called TIBCO Business Studio™. A procedure consists of a number of “steps,” including 
manual steps (which require user action), automatic steps (which are executed 
automatically by the iProcess Engine), and condition steps (which branch based on the 
result of a condition). 

An example of a very simple procedure is shown below.

Someone using the iProcess Workspace (Browser) starts a “case” of a procedure, which 
typically causes a screen to be displayed onto which the user enters information. For 
example, if the procedure defines the processing of a loan application, the first screen may 
involve entering demographic information for the applicant. The next step might involve 
another person reviewing the application — the procedure would be defined such that the 
information entered in the first step is automatically sent to the person(s) responsible for 
reviewing it. The application process will progress through the steps of the procedure until 
it is completed.

The following table provides definitions of terms that are used throughout this document 
and in your iProcess Workspace (Browser).



TIBCO iProcess® Workspace (Browser) User Guide

10 | Introduction

Term Description

Procedure Represents the definition of a business process, which ensures that 
information flows in a consistent and timely manner through the system. An 
iProcess procedure is defined using TIBCO Business Studio. An example is 
shown in the illustration above.

Case This is a particular instance of an iProcess procedure. A case is created when a 
procedure is “started,” and remains in existence until that instance of the 
procedure is purged from the system.

Step A procedure is made up of a number of steps, which define the activities that 
take place within the flow of a procedure. Each step defines what must be 
done, who must do it, and, optionally, a deadline by which it must be done.

Work Queue This is a list of work items (see below) that are awaiting action. A work queue 
can belong to an individual user (personal work queue) or to a group of users 
(group work queue). If it is a group work queue, any user that belongs to that 
group has access to the work items in that group queue.

Work Item A work item represents an action item listed in a work queue. It relates to a 
step in an active case. A user manages the work items in their work queue by 
performing some sort of action upon them, such as entering data on a form, 
forwarding the item to another user or group, “keeping” it (placing it back in 
the work queue for further action at a later time), or “releasing” it (completing 
the required action and sending it on to the next step in the procedure).

You may not necessarily need to understand the entire structure of the procedure(s) you 
are working on. Generally, users are focused on performing some sort of work on the work 
items that appear in their work queue. The type of work you perform will depend on the 
type of business you are in and how your procedure was designed.

Functions Performed by the TIBCO iProcess 
Workspace (Browser)
The following are the types of functions you are typically performing with the TIBCO 
iProcess Workspace (Browser):
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• Open and view work queues:

— User work queue - Each user has a “personal” work queue into which work items 
are sent that user is responsible for dealing with.

— Group work queue - Users may be added to a “group,” which gives that user 
access to the group’s work queue. For example, all applications in need of review 
may be sent to the “Reviewer” group queue. All users that have been added to 
the Reviewer group have access to, and are able to process, work items in the 
Reviewer work queue.

• Apply filter and/or sort parameters to a work queue so only the desired work items 
are listed in the desired order.

• Open individual work items.

• Enter information into forms that are displayed when you open a work item.

• Either “keep” a work item, which closes it and places it back in the work queue, or 
“release” a work item, which causes the case to advance to the next step in the 
procedure.

• Forward work items to a different work queue (user or group).

• Start a case of a procedure.

• Suspend or reactivate a case.

• View the history of a case.

• Allow temporary access to your personal work queue to another user.

• Temporarily redirect work items from your work queue to another work queue.

While these are the primary functions you’ll be performing, there are many additional 
functions that can be performed with the iProcess Workspace (Browser). These are 
described in the remainder of this document.

The TIBCO iProcess Workspace (Browser) 
Screen Layout
The TIBCO iProcess Workspace (Browser) screen consists of the following sections.
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Each of these sections are described below.

Mode Selection

This section contains buttons/icons that allow you to select the type of information that is 
displayed in the other sections of the screen. The available selections are:

• Work Queues - Displays the work queue list in the Primary List section. 

• Procedures - Displays the procedure list in the Primary List section. 

• Options - Displays user options in the Data Display section. User options allow you 
to specify settings such as display options, layout options, etc.

For more information about user options, see User Options.

• Session Activity - Displays the session activity log in the Data Display section. The 
session activity log provides information about the activity that has taken place 
during the current login session. 

For more information about the session activity log, see Login Session.
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• Server Info - Displays a server information window in the Data Display section. This 
provides technical information about the server, such as TCP port, IP address, etc. 

For more information about the server information window, see Viewing Server 
Information.

Note: You can display either buttons with text on them, or icons, in the Mode 
Selection section by clicking the arrow between the Primary List and Mode 
Selection sections:

This arrow acts as a toggle, switching between the buttons with text and icons.

Primary List

This section always contains either the work queue list or procedure list, depending on the 
selection made in the Mode Selection section. If one of the other mode selections are 
made (Options, Session Activity, or Server Info), this section will still display either the 
procedure or work queue list, whichever was most recently selected.

For information about the work queue list, see The Work Queue List.

For information about the procedure list, see The Procedure List.

Secondary List

This section lists either a work item list or a case list, depending on whether you’ve 
selected a work queue or procedure in the Primary List.

If you select a mode other than Work Queues or Procedures, this list is overlaid with the 
options, session activity, or server info, depending on which you select.

The work item and case lists provide a Preview icon that can be used to turn off the 
Preview Pane, which causes the Secondary List to encompass the entire right side of the 
screen.

For information about work item lists, see Work Item Lists.

For information about case lists, see Case Lists.
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Preview Pane

This section displays summary information for the selected work item or case.

The Preview Pane can be turned on or off by:

• clicking the  icon on the work item or case list, or 

• by selecting Preview from the work item or case list View menu.

Both of these cause the Preview drop-down menu to be displayed:

Preview menu from the work item list:

Preview menu from the case list:

The preview settings are as follows:

— Preview On - Open Form/Details in Preview Pane: When you select (single-
click) a work item or case in their respective list, the work item or case summary 
is displayed in the Preview Pane. 

When you open (double-click) a work item or case, the work item form or case 
details are also displayed in the Preview Pane. (Note - You may not be able to 
open a work item form in the Preview Pane, depending on the type of work item 
form your application uses — for more information, see Work Item Form 
Location.)

— Preview On - Float Form/Details: When you select (single-click) a work item or 
case in their respective list, the work item or case summary is displayed in the 
Preview Pane. 

When you open (double-click) a work item or case, the work item form or case 
details are displayed in a separate floating window. 
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— Preview Off: When the Preview Pane is turned off, single-clicking a work item or 
case in their respective lists has no effect. 

When you open (double-click) a work item or case, the work item form or case 
details are displayed in a separate floating window. 

If you are choosing to display the work item form in a separate floating window, the 
separate floating window may be either a dialog or a new browser window, depending on 
the setting of a user option for the logged-in user — for more information, see Floating 
Work Item Form Window . (Note - You may not be able to open a work item form in a 
separate dialog (it may have to be a separate browser window), depending on the type of 
work item form your application uses — for more information, see Work Item Form 
Location.)

If you are choosing to display case details in a separate floating window, the floating 
window will always be a separate dialog — case details cannot be displayed in a new 
browser window.

Selections you make on the Preview menu are not persistent; the next time you log in, the 
Preview menu setting defaults to the setting in user options. For more information, see 
Work Item Preview Default and Case Preview Default .

Resizing the Preview Pane

You can specify that the Preview Pane automatically resize when you open a work item or 
a case. For instance, you may want the Case Details to open so that the Preview Pane 
encompasses 80% of the Data Display area. It will then revert to its original size when you 
close the work item or case.

To configure the Preview Pane to automatically resize, see Layout Options.

Displaying a Floating Window
From the work item or case list, you can display a separate floating window containing 
whatever information is currently displayed in the Data Display section. This allows you to 
create multiple views of the same list, or to view details about multiple work items or cases 
from the same list simultaneously.

To display a separate floating window:

• From the work item list, select Float Work Items List from the View menu.

• From the case list, select Float Cases List from the View menu.
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• From either the work item list or case list, click the  icon.

A separate floating window is displayed containing the same information currently in the 
Data Display section. This floating window is always opened as a separate dialog within 
the application (rather than as a new browser window).

Floating Window Task Bar

As windows are floated, an icon for that window is added to the task bar on the bottom of 
the screen:

The task bar allows you to select one of the floating windows without clicking on the 
window itself — when windows are floating, they can become hidden behind other floating 
windows.

Clicking on an icon in the task bar works as a toggle — successive clicks on an icon causes 
the window associated with that icon to alternately be brought to the foreground and 
background.

Moving a Floating Window

You can move a floating window around the screen by placing the cursor in the window’s 
header bar. When the cursor changes to an icon that contains multi-directional arrows (see 
the illustration), click and hold the left mouse button while moving the window to the 
desired location.

Resizing a Floating Window

Floating windows provide the following methods of resizing the window. 
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• Minimize Toggle - Clicking this button causes the window to minimize — the 
window is removed from the screen, and a button representing the window appears 
on the task bar. Click the button on the task bar to cause the window to reappear.

• Maximize Toggle - Clicking this button toggles between the window expanding to 
cover the entire screen, and collapsing to its original size.

• Dragging to Desired Size - Placing the cursor in the lower right corner of the 
floating window causes the cursor to change to a double arrow. Pressing and 
holding the left mouse button when the double arrow appears allows you to resize 
the window to the desired size.

Closing a Floating Window

To close a floating window, click the x in the upper right corner of the floating window.

Finding Items in a List
The find function allows you to quickly locate items in a list. All four of the primary lists 
(procedure, work queue, case and work item) contain a find function. It is also available on 
other dialogs throughout the iProcess Workspace (Browser). 

When using the find function on work item and case lists, it is often used in conjunction 
with the filter function (for information about the filter function, see Filtering a Work Item 
List and Filtering a Case List). When used on these lists, the intent is for the find function to 
refine the search that has already been done using the filter function. Typically, the filter 
function is used to present a list of work items or cases that are of continual interest. You 
can then use the find function to further refine the search through the list of filtered work 
items or cases. When you are done with the find function, and close it, the list returns to 
the list presented by the filter function. If you want a different list of work items or cases 
that are of continual interest, the list should be filtered using the filter function. (Note that 
the Filter, Sort, and Refresh icons and menu selections are disabled while the find 
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function is being used — you must close the find function to change filter or sort criteria, or 
to refresh the list.)

To use the find function:

Procedure 

1. Click on the Find button in the list window. This causes the “where” fields to be 
displayed.          

Notice the number next to the Find button. This number indicates the number of 
items (work items, cases, work queues, or procedures) in the list.

2. From the first where field drop-down list, select the column you want to use to find 
the item. For example, if you are searching for a work item from a specific 
procedure, you would select the Procedure Name column (the columns available 
will depend on the type of list from which you are searching).           

3. In the second where field, enter the value you are searching for. For example, if you 
are searching for a work item from the “Checkout” procedure, you would enter 
“Checkout” in the second field.         

You can also use the “type ahead” feature, which causes the system to search for 
the value entered as each character is typed in. If it’s enabled, items that match the 
characters you have entered so far are listed. In the example shown here, when “C” 
is entered, all work items from procedures beginning with “C” are listed. When you 
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enter the second character (“h”), all work items from procedures beginning with 
“Ch” are listed, and so on.

To enable the “type ahead” feature, ensure the Type Ahead check box is checked.         

Note: If you are using the find function on the work item list, there is an 
additional check box labelled Server Filter. Checking the Server Filter 
check box disables the Type Ahead check box. For information about 
using the Server Filter check box, see Finding Work Items in the Work 
Item List.

4. Press Enter after entering the value in the second where field — assuming the “type 
ahead” feature is not enabled (see the previous paragraph). If the “type ahead” 
feature is enabled, you will not need to perform this step.

The items that meet the search criteria you entered are displayed in the list. 

If the number to the right of the Find button is displayed in a ##/## format, it indicates 
how many items the find function found. Note, however, that this number can be 
influenced by things other than the find function, depending on the type of list. See the 
following sections for more information about this number for each list type:

• Number of Work Queues in a Work Queue List

• Number of Work Items in a Work Item List

• Procedure List Columns

• Number of Cases in a Case List

Turning the Find Function Off

The Find button acts as a toggle — subsequent clicks turn the find function on and off. 
When the find function is off, the where fields are not displayed and the entire list is 
shown (although, possibly filtered using the filter function).

Turning the find function off does not clear values from the where fields — previously 
entered values are still in the where fields if you toggle the find function back on. 
However, closing the list, then re-displaying the same list causes values in the where fields 
to be cleared.
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Selecting Items in a List
The way in which you select items in a list depends on the type of list, as well as other 
factors, as described below.

Work Queue and Procedure Lists
Selecting a work queue from the work queue list causes the work item list for that work 
queue to be displayed in the Secondary List section of the screen.

Selecting a procedure from the procedure list causes the case list for that procedure to be 
displayed in the Secondary List section of the screen.

The work queue and procedure lists allow you to select only a single item at one time. To 
select a single item:

• Click the desired line with the cursor, or

• use the keyboard up/down arrow keys to move the highlight up or down to the 
desired item.

The selected item is shown in a different color than the rest of the items in the list:

Work Item and Case Lists
The effect of selecting an item from the work item or case list depends on whether or not 
the preview feature is turned on (see Preview Pane):

• If preview is turned off, selecting an item from the work item or case list has no 
effect.

• If preview is turned on:
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— selecting a work item from the work item list causes the work item summary to 
be displayed in the Preview Pane section.

— selecting a case from the case list causes the case summary to be displayed in 
the Preview Pane section.

Selecting a Single Item

To select a single item in the work item or case list:

• Click on the desired line with the cursor, or

• use the keyboard up/down arrow keys to move the highlight up or down to the 
desired item.

The selected item is shown in a different color than the rest of the 
items in the list:

Note: Double-clicking an item on a work item or case list opens that item. When 
you open a work item, the work    item form is displayed. When you open a case, 
the case details are displayed in a tabbed window.                          For more information about 
opening work items and cases,      see Opening Work Items and Opening Cases,       
respectively.

Selecting Multiple Items

You can also select multiple items at one time on the work item and case lists, as many of 
the functions available from these lists can be applied to more than one item at a time 
(e.g., forward work item(s), release work item(s), close case(s), etc.).
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Note: You cannot select multiple procedures from the procedure list nor 
multiple work queues from the work queue list.    To list the cases from multiple 
procedures, or the work items from multiple work queues, you must select and 
list them one at a time.         

However, if you select multiple items in work item or case list, and have the 
preview feature turned on, the Preview Pane will show the summary information 
only for the first work item / case selected.

To select multiple items that are not grouped together:

• Select one of the desired items, press and hold the Ctrl key, then click on the other 
desired items. All selected items are shown in a different color than the rest of the 
items in the list.

To select multiple items in a list that are grouped together:

• Select the first item in the group, press and hold the Shift key, then either click on 
the last item in the group, or move the arrow key until all desired items are selected. 
All selected items are shown in a different color than the rest of the items in the list.
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Refreshing Information in a Window
Each window that contains a list of procedures, cases, work queues, or work items is a 
snap shot of the information in the list when the list was displayed. For example, if you 
click on a work queue to display a list of work items in that work queue, the list contains 
all of the work items in that queue (possibly filtered) at the moment the list was displayed. 
It is not automatically updated to provide the latest items. You must “refresh” the list to 
get the latest information from the iProcess Engine. 

Refresh a list by:

• selecting Refresh... from the View menu, or

• by clicking the  icon.

Note that refreshing the list causes the client application to ask the iProcess Engine to re-
send the information in the list. This can take some time, depending on the number of 
items in the list, the speed of your computer, etc.

If you are working with a work item list, you can also specify that the list automatically 
refresh at specified intervals. For information see, Refreshing the Work Item List.

Customizing Columns in a List
By default, certain columns are displayed in each type of list. For example, the following 
shows the default columns that are displayed in the work item list:

However, these may not be the columns you would like to see. The iProcess Workspace 
(Browser) allows you to customize the columns displayed in each of the list types — work 
item, case, work queue, and procedure list. 

To customize the columns in the currently displayed list, follow these steps:

Procedure 
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1. Choose Select Columns from the View menu on the list whose columns you want to 
change. The following dialog is displayed:             

This dialog shows all of the columns available for the type of list you are working 
with. This example is for the work item list.

The Available Columns section on the Column Selector dialog shows the columns 
that are not currently displayed, but are available to display. The Selected Columns 
section shows the columns that are currently displayed.

2. Select the desired columns, using the following actions:

— Individual columns can be selected by clicking on the desired name.

— Multiple columns can be selected by holding down the Ctrl key while clicking on 
the desired names. 

— A group of columns can be selected by clicking on one name, then holding down 
the Shift key and clicking the last name in the desired group.

3. Move columns to the desired section on the Column Selector dialog:

— Columns can be moved back and forth between lists by selecting the desired 
column(s), then clicking the “>” or “<“ buttons.

— An individual column can be moved from one list to the other by double-clicking 
on the column name.
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— All columns can be moved from one list to the other by clicking on the “>>” or 
“<<“ buttons.

You can also change the columns to the system defaults by clicking the Use Default 
button.

4. Once the desired columns are listed in the Selected Columns section (these are the 
columns that will be displayed), you can change the order in which they will appear 
on the list by using the Order buttons. Click the column whose order you would like 
to change, then click on the ‘+’ or ‘-’ Order button to move the column up or down 
in the list.

5. Click OK when the list on the right contains the columns you would like displayed, in 
the order you would like them displayed.

Note: There is currently no means of making column changes on all work item 
lists.

Changes made to column order using the Column Selector are saved either locally or on 
the server, depending on a configuration setting made by the system administrator:

— If saved locally, and you log into a different machine, the changes you made will 
not be in effect on that new machine — changes made on a specific machine will 
apply only to that individual machine. 

— If saved on the server, and you log into a different machine (and connect to the 
same server), the changes you made will be in effect on the new machine.

Displaying Images in Columns
Some of the columns in lists allow you to display either text or an image in the column. 
Typically, these are columns that contain true or false values (two exceptions are the 
Status and Deadline Status columns on the work item list, which always display images — 
for information about the images in these columns, see Work Item Status and Deadline-
Related Columns, respectively).

When images are displayed in a column, true values are shown as a green check mark; 
false values are shown as a red X.

For example, the following shows the work item list with images in the Unopened Image 
column, whereas the Urgent column does not contain images — it will shown either “true” 
or “false”:
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To display an image in a column, simply choose the “Image” column instead of the “non-
image” column in the Column Selector:

Manually Changing Column Order in Lists
You can also manually change the order of the columns in a list by dragging the column 
left or right to the desired location. 

Manual changes made to column order are saved either locally or on the server, depending 
on a configuration setting made by the system administrator:
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— If saved locally, and you log into a different machine, the changes you made will 
not be in effect on that new machine — changes made on a specific machine will 
apply only to that individual machine. 

— If saved on the server, and you log into a different machine (and connect to the 
same server), the changes you made will be in effect on the new machine.

Help 
There are two kinds of help available in the iProcess Workspace (Browser):

• Tool-tip Help - This type of help allows you to place the cursor on a tool icon to 
cause a box to appear that describes the purpose of the tool.             

Tool-tip help can also be helpful to view column header text when the column width 
is too narrow to see the text. For example:             

• On-line Help - An on-line help system is available that provides descriptions of the 
functions available in the iProcess Workspace (Browser). This help can be accessed 
by clicking on the Help button in the upper right part of the screen.

User Access Profiles
Each user of the iProcess Workspace (Browser) has a user access profile that determines 
what functions and menu selections are available to that user.
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For example, your user access profile determines whether or not you can close cases of a 
procedure. The buttons and menu selections used to close cases will be displayed in the 
application only if your user access profile specifies that you can close cases.

This document describes all functions that are available in the iProcess Workspace 
(Browser), even though you may not be able to see/use that function because of your user 
access profile.

The access profile name assigned to the logged-in user is displayed in the upper-right part 
of the iProcess Workspace (Browser) screen. In the example below, the logged-in user is an 
“Admin” user, which gives the user access to the functions that have been specified for all 
Admin users:

User access profiles are assigned by a system administrator. For more information, see 
TIBCO iProcess Workspace (Browser) Configuration and Customization.
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Logging In and Out
This section describes how to log in and log out of the TIBCO iProcess Workspace 
(Browser).

Logging In
Logging in to the TIBCO iProcess Workspace (Browser) validates your user name and 
password to ensure you are authorized to use the system. It also looks at your user access 
profile to determine how much functionality you are authorized to perform (for information 
about user access profiles, see User Access Profiles).

Your system administrator will determine how you actually start the iProcess Workspace 
(Browser). It may involve starting a browser and entering a URL (Universal Resource 
Locator — or “website address”), or you may click on a link on a specified web page.

After the browser connects to the proper web site, you are presented with a login window:

To log in to the iProcess Workspace (Browser):

Procedure 

1. Enter your user name in the User Name field.

2. Enter your password in the Password field.
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3. Choose a server in the Server field. This field is a drop-down list that may contain 
one or multiple server names, depending on how your system is configured. (The 
names in this drop-down list are TIBCO iProcess Objects Servers, which in turn are 
connected to a TIBCO iProcess Engine.)

4. If you would like your user name to be automatically entered in the User Name field 
the next time you login to the iProcess Workspace (Browser) on this computer, check 
the Remember User Name and Server next time I login box.

Note: The Remember User Name ... check box may or may not be displayed, 
depending on a configuration parameter set by the system administrator.

5. Click OK.

If the login is successful, either the procedure list or the work queue list is displayed, 
depending on how your system is set up.

If your password has expired, a Change Password dialog may be displayed (this 
dialog is displayed only if the appropriate access element is enabled in your access 
profile). If the Change Password dialog is displayed, you must change your 
password before you can proceed.

If there is a problem with the login (e.g., you’ve entered an invalid user name or 
password, or the selected server is not running properly), an error dialog is 
displayed.

Login Session
The period of time between when you log in and log out is called a “login session”. At any 
time during your login session, you can display a log that shows all of your activity during 
the current login session.

To display the login session log, click the Session Activity button/icon:
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An example session activity log is shown below:

The session activity log is maintained locally — it is not returned from the iProcess Engine. 
The log is cleared when you log out.

Note: A “Started Case” entry in the Session Log is only verifiable if the entry 
includes a case number. A case number    is included in the log entry only if the 
addressee of the first step in the case being started is someone other than the 
person starting the case.

In the example below, the first case that was started (a case of the Hiring procedure) does 
not include a case number, because the first step was addressed to the person starting the 
case.

The second case that was started (a case of the Allocate procedure) includes a case 
number, because the first step was addressed to another user.
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The reason the case start cannot be verified if the user starting the case is the addressee of 
the first step is because the user may close the form without keeping or releasing the work 
item (by clicking on the “x” in the upper right corner of the browser window). If this occurs, 
the case does not actually start.

Login Session Timeout

If there is no activity in the iProcess Client for a certain period of time, your login session 
may timeout.

A session timeout can be initiated by the following components:

• the iProcess Client

• the application server

These are described below.

iProcess Client Session Timeout 

There is a configuration parameter (SessionMonitor) in the iProcess Client’s configuration 
file that allows the system administrator to specify a session timeout value. 

If this parameter is configured, and you are logged into the iProcess Client, but are inactive 
for a period of time that exceeds the timeout value, the following warning message is 
displayed first:
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You can click OK to return to the iProcess Client.

If you do not click OK in a specified period of time, you will be automatically logged out 
and the following message is displayed:

You can click OK to remove the message window and log back into the iProcess Client.

Application Server Session Timeout 

There is also a configuration parameter on application servers that specify a timeout value. 

If this parameter is configured, and you are logged into the iProcess Client, but are inactive 
for a period of time that exceeds the timeout value, a message similar to the following is 
displayed (the message varies, depending on the application server you are using):
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Click OK to return to the login window.

Viewing Server Information
After logging in to a server, you can display a window that provides technical information 
about the server. (Technically, when you log in to the system, you are logging into a TIBCO 
iProcess Objects Server, which in turn is connected to a TIBCO iProcess Engine.)

To display the server information window, click the Server Info button in the lower left 
part of the iProcess Workspace (Browser) screen:

An example Server Info screen is shown below:
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Logging Out
When you are finished doing the work you need to do, you should log out of the iProcess 
Workspace (Browser). 

Note: If you just close your browser rather than log out, you will eventually be 
logged out internally. However, the proper “clean up” is performed internally 
when you log out, making the most efficient use of resources. 

To log out of the iProcess Workspace (Browser):
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1. Close (keep or release) any currently open work items.

2. Click Logout in the upper right part of the iProcess Workspace (Browser) screen.

When you are successfully logged out, the Login window is displayed. You can either 
log in again, go to another web site, or close the browser.                         

Note: If there is no activity in the iProcess Workspace (Browser) for a 
certain period of time, the application will timeout, automatically logging 
you out. For more information, see Login Session Timeout.
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Using Work Queues
This section describes work queues and the functions you can perform from them.

The Work Queue List
The work queue list shows all of the work queues to which the logged-in user has access. 

Display the work queue list by clicking on the Work Queues button (or icon) in the lower 
left portion of the iProcess Workspace (Browser) screen:

Note that the work queue names correspond to user names and group names. Each time a 
user or group is added to the TIBCO system, a work queue is created for that user or 
group; all work items addressed to that user or group are sent to their work queue. 
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Note: A time delay may be experienced when displaying a work queue list if 
either the “Redirected” or “Redirected Image” column has been added to the 
list, and the user has access to a large number of work queues.

Information about each work queue is provided in the columns of the list. In the example 
shown above, the number of urgent work items and the number of new (unopened) work 
items in the work queue is shown. The specific information that is displayed on your 
system will depend on how your system was set up.

For information about selecting items from lists, see Selecting Items in a List.

Work Queue Access
Access to work queues is summarized below:

• User Access - All work items that are sent to you appear in your personal work 
queue. Note, however, depending on how the system has been configured by the 
system administrator, you may or may not have access to your personal work 
queue. 

If you do have access to your personal work queue, a queue with your user name 
will appear in the work queue list.

For more information, see Hidden Personal Work Queues. 

• Group Access - Every user who is a member of a group has access to the work items 
in that group’s work queue. All work items that are sent to a group are accessible by 
all members of the group.

User and group work queues are denoted by the icon in the Type column on the 
work queue list (these icons may not be displayed if the columns on your system 
have been changed from the default. See the example below.             
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Note: If the user or group work queue icon is shown in a gray color, it 
means it is a “test” work queue. For information, see Released vs. Test 
Work Queues.

You can list the user and/or group work queues to which you have access by making 
selections from the View menu on the Work Queues window:             

Additional work queue access is available in the following ways:

• Participation Access - You may be given temporary “participation access” to 
another user or group work queue. A work queue supervisor must set up a 
“participation schedule” that specifies the duration of the participation access. 
During that period, the work queue to which you have been given participation 
access will appear in the work queue list, and you will have access to the work items 
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in that work queue. For more information about participation, see Participation 
Access to a Work Queue.

• Redirection Access - Although this does not give you direct access to another work 
queue, it causes work items that were originally destined to another work queue to 
be redirected to your work queue instead. A work queue supervisor must set up a 
“redirection schedule” that specifies the duration of the redirection. For more 
information about redirection, see Redirecting Work Items to Another Work Queue.

Hidden Personal Work Queues

When the system is configured, it can be specified that your personal work queue either be 
shown or hidden by default. If it is shown by default, when you first log in, a work queue 
with your user name appears in the work queue list; if it is hidden by default, a work queue 
with your user name does not appear.

Also, depending on how the system is configured, you may or may not have the authority 
to change the default setting, that is, if the queue is shown by default, you can hide it; if 
the queue is hidden by default, you can display it.

If you have the authority to change the default, the work queue list View menu will contain 
either the Hide Personal Work Queue or Show Personal Work Queue selection 
(depending on its current state):
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Use this menu selection to either hide or show your personal work queue.

Released vs. Test Work Queues
Whenever a user or group is created in TIBCO, both a “released” and “test” work queue is 
created for that user or group:

• Work items that result from cases of procedures with a status of Released are sent 
to the released work queue for the user/group.

• Work items that result from cases of procedures with a status of Unreleased (a new 
procedure being tested for release) or Model (a procedure that has been imported) 
are sent to the test work queue for the user/group.

Typically, you are working with released work queues — the norm in a production 
environment.

You may occasionally be asked to use test work queues — this is done in a testing or 
training environment.

To display released and/or test work queues, make the appropriate selection from the 
View menu on the work queue list:

Viewing Work Items in a Work Queue
To view the list of work items in a work queue, single-click the desired work queue in the 
work queue list:
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Once a work queue is selected, you can also move the highlight bar with the keyboard 
arrow keys to select other work queues.

Either the list of work items in the selected work queue is displayed, or the work items list 
filter dialog is displayed because the number of work items in the list exceeds the specified 
threshold. For more information, see Work Item Lists.

Work Queue List Columns
By default, certain columns are displayed in a work queue list. You can easily customize 
the columns that are displayed by either using the Column Selector, or by changing them 
manually. For information, see Customizing Columns in a List.

The following table describes the columns of information that can be displayed on the 
work queue list:

Column
Name

Description

Deadline 
Items

The number of work items in the work queue that have a deadline.

Description A description of the work queue — typically, the name of the user or group.

First Deadline 
Date/Time

The date and time of the deadline that will be the first to expire in the work 
queue.
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Column
Name

Description

Group Queue 
/ Group 
Queue Image

True - The work queue is a “group” work queue.

False - The work queue is an individual “user” work queue.

Host Name The name of the TIBCO iProcess Engine to which the iProcess Workspace 
(Browser) is connected.

Name The user / group name for the work queue.

Redirected / 
Redirected 
Image1

True - The work queue is currently being redirected to another work queue.

False - The work queue is not being redirected.

Released / 
Released 
Image

True - The work queue is “released” (contains work items from “released” 
procedures).

False - The work queue is a “test” work queue (contains work items from 
“unreleased” or “model” procedures).

Total Items The total number of work items in the work queue.

Type The icon in this column indicates whether it is a user or group work queue, as 
well as whether it is a released or test work queue. For information, see Work 
Queue Access and Released vs. Test Work Queues, respectively.

Unopened 
Items

The number of work items in the work queue that have not been opened yet.

Urgent Items The number of work items in the work queue that have been flagged as 
urgent. Whether or not a work item is urgent depends on a priority value 
given to the step when the procedure was created, as well as a configuration 
value specified in the server. That is, if the priority exceeds (is smaller than — 

1If the “Redirected” or “Redirected Image” column is added to the work queue list, a time delay 
may be experienced when the work queue list is displayed or refreshed if the user has access to a 
large number of work queues.
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Column
Name

Description

with 1 being the highest priority) the configuration value, the work item is 
flagged as urgent.

Number of Work Queues in a Work Queue List
There is an indicator in the header bar of the work queue list to tell you how many work 
queues are in the list. This number is displayed to the right of the Find button. In this 
example, there are 9 work queues.

Note that if this number is displayed in the format “##/##” it means the list is being filtered 
in some way and only some of the work queues are listed. In the example below, 5 of the 9 
possible work queues are listed.

The work queue list can be filtered in one of the following ways: 

• The Find button has been used to filter the list. (For information about using the 
find function, see Finding Items in a List.)

• Only “Released Work Queues” or “Test Work Queues” has been selected from the 
View menu. (For information about displaying released and/or test work queues, see 
Released vs. Test Work Queues.)

• Only “User Work Queues” or “Group Work Queues” has been selected from the View 
menu. (For information about displaying user and/or group work queues, see Work 
Queue Access.)

If one or a combination of these methods have been used to filter the work queue list, the 
number is shown in the ##/## format.
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Displaying Work Queue Loading
The work queue loading feature allows you to display a graphical summary that shows you 
how many work items are currently in one or more of the work queues to which you have 
access. The chart displayed by this feature provides a visual view of the amount of load the 
work queues are experiencing.

You can access work queue loading in one of two ways:

• Select Work Queue Loading Chart from the Tools menu, or click the  icon, on the 
work queue list toolbar.

This displays a work queue loading chart that shows you all of the work queues to 
which you have access. Note that the very first time you display the work queue 
loading chart in this way, it lists all work queues to which you have access. If you 
pare down the list using the Select Work Queues function (see Displaying a Subset 
of Work Queues in the Work Queue Loading Chart), from then on the list only 
contains the subset you have chosen.

• Right-click on one of the work queues in the work queue list, then select Work 
Queue Loading Chart from the context menu.

This displays a work queue loading chart that shows you only the work queue on 
which you right-clicked.

The following is an example work queue loading chart that shows multiple work queues:
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Note: If your personal work queue is hidden by default on the work queue list 
and you do not have the authority to change the default via the Show / Hide 
Personal Work Queue selection on the work queue list View menu, your 
personal work queue is also hidden on the Work Queue Loading Chart. For more 
information about hidden work queues, see Hidden Personal Work Queues.

The red, green, and yellow-colored bars indicate the number of urgent, unopened, and 
with-deadline work items in each work queue. The blue bar shows the total number of 
work items in each work queue. Placing the cursor on the bars of the chart causes the 
exact counts for that work queue to be displayed.

Selections are available on the View menu that allow you to display only the released work 
queues, only the test work queues, or both the released and test work queues. You can 
also use selections on the View menu to display only user work queues, only group work 
queues, or both user and group work queues.

The work queue loading chart can be refreshed at any time by either selecting Refresh 
Work Queues on the View menu, or by clicking on the  icon on the toolbar.

You can close the work queue loading chart by clicking on the X in the upper-right corner.
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Displaying a Subset of Work Queues in the Work Queue Loading Chart

The first time you display the work queue loading chart, it will list all work queues to which 
you have access. You can, however, choose to display only a subset of the available work 
queues by selecting Select Work Queues from the View menu, or by clicking the  icon 

on the Work Queue Loading Chart dialog. The following dialog is displayed:

This dialog contains a check box for each work queue to which you have access. You can 
select or deselect all of the boxes in the list using the first check box on the dialog; you can 
then check/uncheck individual boxes in the list, as desired. When the desired work queues 
are selected, click OK.

The work queue loading chart will list only the work queues that you’ve selected on the 
Work Queue Selection dialog. This selection will persist until you change it again.

Finding Work Queues in the Work Queue List
The work queue list contains a Find function that can be used to quickly find the work 
queue you are looking for. 

To invoke the Find function, either select Find from the View menu or click the  icon on 

the work queue list toolbar.
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The number to the right of the  icon tells you how many work queues are in the list.

As the Find function works the same on all lists, it is described in the Introduction chapter 
— see Finding Items in a List.

Sorting a Work Queue List
You can sort the work queue list on any one of the columns in the list. To sort on a 
column, click on the column header. If the column contains text, it is sorted in alphabetical 
order; if it is numeric, it is sorted in numerical order.

Once you click on a column header, a small arrow head appears in the column header, 
which indicates the order of the sort — if the arrow head is pointing up, the sort is in 
ascending order; if it’s pointing down, the sort is in descending order:

Each successive click on the column header, toggles between ascending and descending 
order.

Refreshing a Work Queue List
When the work queue list is initially displayed, it is a snap shot of the work queues at that 
point in time. You can refresh the list to get the most recent list of work queues from the 
iProcess Engine by selecting Refresh Work Queues from the Viewmenu, or by clicking on 
the  icon on the work queue list toolbar

Do not overuse this feature — refresh the list only when you need an updated list. Each 
time you refresh the list, the iProcess Engine must send a new list to your system, which 
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can impact performance, depending on the number of items in the list, the speed of your 
system, etc.

Note: A time delay may be experienced when refreshing a work queue list if 
either the “Redirected” or “Redirected Image” column has been added to the 
list, and the user has access to a large number of work queues.

Work Queue Supervisors
A user must be designated as a “work queue supervisor” to perform the following tasks:

• Create, modify, or delete participations schedules. A participation schedule gives 
another user temporary access to the work queue. For information about 
participation schedules, see Participation Access to a Work Queue.

• Create, modify, or delete redirection schedules. A redirection schedule causes work 
items to be temporarily redirected to another work queue. For information about 
redirection schedules, see Redirecting Work Items to Another Work Queue.

Each work queue can be assigned one or more work queue supervisors. 

You must have system administrator authority to manage work queue supervisors.

To add or remove a user as the supervisor for a work queue:

1. Select Manage Work Queue Supervisors from the Tools menu on the work queue 
list, or click the  icon.
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The following dialog is displayed:          

The Work Queues section of this dialog lists all work queues (i.e., all users and 
groups) defined on your TIBCO system. 

2. In the Work Queues section, select the work queue for which you want to manage 
supervisors.

This causes the Work Queue Supervisors section to list all users who are currently 
supervisors of the work queue you chose, if there are any:         
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In this example, the Tellers work queue has a single supervisor currently specified, 
swadmin.

3. Manage supervisors for the selected work queue as follows:

To remove a supervisor from the work queue, select the user name in the Work 
Queue Supervisors section, then click on the Remove button.

The user name is removed from the Work Queue Supervisors list.

To add a supervisor for a work queue, click on the Add button. The following dialog 
is displayed:         
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This dialog lists all of the current users on the system, except for those that are 
already designated as a supervisor of the selected work queue.

Select one or more users from the list, then click OK. The Work Queue Supervisors 
dialog is redisplayed, with the newly added users added to the Work Queue 
Supervisors section.

4. Click OK to save the changes you’ve made and close the Work Queue Supervisors 
dialog.

Participation Access to a Work Queue
Allowing a user to “participate” in another user’s or group’s work queue is called 
“participation”. Participation allows the participant user to have access to the work items 
in the other user’s work queue.

To be a participant of a work queue, a user who has been designated as a supervisor for 
that work queue must create a “participation schedule” for the participant user. The 
participation schedule specifies which users will have access to the work queue, and the 
dates and times they will have access.

To set up a participation schedule for a work queue for which you are a supervisor:
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1. Select Manage Work Queue Participation from the Tools menu on the work queue 
list, or click the  icon.

The following dialog is displayed:         

The Supervised work queues section lists all work queues for which you are a 
supervisor — these are the work queues for which you are authorized to set up 
participation schedules.

2. From the Supervised work queues section, select the work queue for which you 
would like to manage a participation schedule.

If the selected work queue does not currently have any participation schedules set 
up, “No participation schedules are defined for this queue” is displayed in the 
Participation Schedule section.

If the selected work queue has one or more participation schedules defined, they are 
listed in the Participations Records section. By default, the first schedule is selected 
(Record 1), and the schedule definition is shown in the Participation Schedule 
section. For example:         
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In this example, bobby has participation access to the work queue from 9:00AM on 
July 12, 2010 until 5:00PM on July 16, 2010, on all of the days listed in the Days field.

3. Manage participation schedules for the selected work queue as follows:

To add a participation schedule for the work queue, click the New button on the 
Work Queue Participation dialog.
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The following dialog is displayed:         

Define each element of the participation schedule as follows:

— Add participants by clicking the Add button. The Add Participants dialog is 
displayed, from which you can select one or more users who will share the 
participation schedule you are going to define. After selecting the desired users 
on the Add Participants dialog, click OK to return to the Add Participation 
dialog.    
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Note: Each of the date and time fields described below have a special 
meaning if the field is left blank. For information about these special 
meanings, see Meaning of Blank Date and Time Fields. 

— Define the start date for the schedule by entering the desired date in the Date 
to start participation field. A “date picker” icon is available to the right of the 
field, which displays a calendar from which you can choose the day/date.

— Define the ending date for the schedule by entering the desired date in the 
Date to stop participation field. A “date picker” icon is available to the right of 
the field, which displays a calendar from which you can choose the day/date.

— Define the start time for the schedule using the first set of “Between” fields. 
Enter the desired start time. Note that the way in which you enter the time — 12-
hour clock, 24-hour clock, with AM and PM, etc. — depends on your locale and 
the way in which your system has been configured. Please consult your system 
administrator.

— Define the ending time for the schedule using the second set of “Between” 
fields. Enter the desired ending time. Note that the way in which you enter the 
time — 12-hour clock, 24-hour clock, with AM and PM, etc. — depends on your 
locale and the way in which your system has been configured. Please consult 
your system administrator.

— Define the days of the week to allow participation using the check boxes in the 
Days section. This defines which days of the week to allow participation during 
the dates/times specified in the preceding fields. For example, the date and time 
fields may specify access from 9am to 4pm, from December 1 to December 15, 
while the days of the week selection specifies that participation access is allowed 
only on Mondays and Tuesdays during that time period.

To edit a participation schedule for the work queue, select the name of the 
participation schedule in the Participation Records section, then click the Edit 
button.

The selected participation schedule is displayed in the Edit Participation dialog. 
Edit the desired elements of the schedule, then click OK to return to the Work 
Queue Participation dialog. (See above for information about the elements in the 
participation schedule.)

To remove a participation schedule from the work queue, select the desired 
schedule in the Participation Records section, then click the Remove button.

The name is removed from the Participation Records list. 
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4. Click OK to save the changes you’ve made to the participation schedules and exit 
the Work Queue Participation dialog.

Meaning of Blank Date and Time Fields

The following table describes the participation schedule behavior when date/time fields are 
left blank:

Field Meaning If Left Blank

Start 
Date

Participation access will begin on the next date allowed by the “days of the week” 
selection.

Start 
Time

Participation access will begin directly after midnight on the days on which access 
is allowed.

End 
Date

Participation access will last indefinitely.

End 
Time

Participation access will end at midnight (which constitutes the end of the day) on 
the days on which access is allowed.

Redirecting Work Items to Another Work Queue
Automatically forwarding work items to another work queue is called “redirection”. 
Redirection allows you to “redirect” one user’s work items to the work queue of another 
user or group for a specified period of time.

Note: For information about forwarding an individual work item from a work 
queue, see Forwarding Work Items.

To redirect work items, a user who has been designated as a supervisor for that work 
queue must create a “redirection schedule”. The redirection schedule specifies to whom 
the work items are being redirected, as well as the date and time the redirection is to start 
and end.

To set up a redirection schedule for a work queue for which you are a supervisor:
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1. Select Manage Work Queue Redirection from the Tools menu on the work queue 
list, or click the  icon.

The following dialog is displayed:         

The Supervised work queues section lists all work queues for which you are a 
supervisor — these are the work queues for which you are authorized to set up 
redirection schedules.

2. From the Supervised work queues section, select the work queue for which you 
would like to manage a redirection schedule.

If the selected work queue does not currently have a redirection schedule set up, 
“Work queue is not redirected” is displayed in the Redirection Schedule section.

If the selected work queue has a redirection schedule defined, it is shown in the 
Redirection Schedule section. For example:         
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In this example, work items sent to bobby’s work queue will be redirected to fanko’s 
work queue from 7:00AM on July 9, 2010 until 3:30PM on July 11, 2010.    

Note: If the Redirection Schedule section contains a “Redirected to” 
name, but the start date and/or stop date is blank, it means the date was 
left blank when the schedule was created. Leaving the start date blank 
causes the redirection to start directly after midnight on the date 
specified (if the date specified is the current date, redirection begins 
immediately). Leaving the stop date blank causes the redirection to last 
indefinitely.

3. Manage a redirection schedule for the selected work queue as follows:

To add a redirection schedule for the work queue, click the Add button on the Work 
Queue Redirection dialog.
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The following dialog is displayed:         

Define each element of the redirection schedule as follows:

— Specify the work queue to which the work items are to be redirected by clicking 
on the desired work queue name in the Select redirection work queue section.               

Note: Each of the date and time fields described below have a special 
meaning if the field is left blank. For information about these special 
meanings, see Meaning of Blank Date and Time Fields.

— Define the start date for the schedule by entering the desired date in the Date 
to start redirection field. A “date picker” icon is available to the right of the 
field, which displays a calendar from which you can choose the day/date. 

— Define the start time for the schedule using the Time fields directly below the 
Date to start redirection field. Enter the desired start time. Note that the way in 



TIBCO iProcess® Workspace (Browser) User Guide

61 | Using Work Queues

which you enter the time — 12-hour clock, 24-hour clock, with AM and PM, etc. — 
depends on your locale and the way in which your system has been configured. 
Please consult your system administrator.

— Define the ending date for the schedule by entering the desired date in the 
Date to stop redirection field. A “date picker” icon is available to the right of 
the field, which displays a calendar from which you can choose the day/date. 

— Define the ending time for the schedule using the Time fields directly below the 
Date to stop redirection field. Enter the desired end time. Note that the way in 
which you enter the time — 12-hour clock, 24-hour clock, with AM and PM, etc. — 
depends on your locale and the way in which your system has been configured. 
Please consult your system administrator.

To edit a redirection schedule for the work queue, click the Edit button on the Work 
Queue Redirection dialog.

The redirection schedule for the work queue is displayed in the Edit Redirection 
Schedule dialog. Edit the desired elements of the schedule, then click OK to return 
to the Work Queue Redirectiondialog. (See above for information about the 
elements in the redirection schedule.)

To remove a work queue’s redirection schedule, select the desired work queue on 
the Work Queue Redirection dialog, then click the Remove button.

4. Click OK to save the changes you’ve made on the Work Queue Redirection dialog.

Meaning of Blank Date and Time Fields

The following table describes the redirection schedule behavior when date/time fields are 
left blank:

Field Meaning If Left Blank

Date and Time to 
Start Redirection

If both the start date and time are left blank, redirection will start 
immediately.

If only the start time is left blank, redirection starts immediately after 
midnight on the date specified. 

(You cannot leave only the start date field blank.)

Date and Time to If both the stop date and time are left blank, redirection will last 
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Field Meaning If Left Blank

Stop Redirection indefinitely.

If only the stop time is left blank, redirection stops at the end of the 
date specified (the stop time defaults to 23:59).

(You cannot leave only the stop date field blank.)
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Working With Work Items
This section describes how to use lists of work items, as well as how to process (open, 
keep, release, etc.) individual work items.

Work Item Lists
A work item list presents all of the work items that are in a particular work queue.

To view a work item list, select (single click) a work queue in the work queue list:

When you select a work queue, one of two screens is displayed:

• The work item list (as in the example above)

• A filter dialog for the work item list 

The window that is displayed depends on how your system has been set up. By default, the 
work item list is displayed. However, there is a user options setting that allows you to 
specify that if the number of work items in the queue exceeds a specified threshold, to 
automatically display the filter dialog first. This allows you to enter a filter expression to 
pare down the list before displaying it. 

For information about specifying whether or not to display the filter dialog first, see Filter 
Options.
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For information about using the filter dialog to filter the work item list, see Filtering a Work 
Item List.

If the work item list is displayed, and the Filter icon on the work item list toolbar has a 
green check mark, the list is currently being filtered — the last filter expression applied to 
the work item list is in effect. For more information, see Filtering a Work Item List.

Also, if the Sort icon on the work item list toolbar has a green check mark, the list is 
currently being sorted — the last sort criteria applied to the work item list is in effect. For 
more information, see Sorting a Work Item List.

Information about each work item is provided in the columns of the work item list. The 
specific information that is displayed on your system will depend on how your system was 
set up — see Customizing Columns in a List.

Selecting Items in a Work Item List
The effect of selecting an item from the work item list (i.e., single-clicking an item, or 
moving the highlight bar with the keyboard arrow keys) depends on whether or not the 
preview feature is turned on:

• If preview is turned off, selecting an item from the work item list has no effect.

• If preview is turned on, selecting a work item from the work item list causes the 
work item summary to be displayed in the Preview Pane section, as follows:             
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The work item summary provides more information about the work item than what 
may be available from the columns in the work item list.    

Note: Double-clicking a work item in the work item list constitutes 
opening the work item. Opening the work item causes the form for that 
work item to be displayed. For information about opening work items, see 
Opening Work Items.

The preview feature can be turned on and off using the  icon on the work item list 

toolbar, or by selecting Preview from the work item list View menu.

The following drop-down menu is displayed:
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You can turn preview on by selecting either of the first two selections — the difference 
between the two is where the work item form will be displayed when you open (double-
click) the work item in the work item list.

You can turn off the preview feature by selecting the Preview Off selection.

For more information about selecting items in general from lists, see Selecting Items in a 
List.

Work Item List Columns
By default, certain columns are displayed in a work item list. You can easily customize the 
columns that are displayed by either using the Column Selector, or by changing them 
manually. For information, see Customizing Columns in a List.

The following table describes the columns of information that can be displayed on the 
work item list:

Column
Name

Meaning

Addressee The user to whom the work item was sent. This is in the form 
username@node, where node is the name of the TIBCO iProcess Engine to 
which the iProcess Workspace (Browser) is connected (which is the same 
value in the Host Node column).

Arrival 
Date/Time

The date and time the work item arrived in the work queue. The order of 
the month and day (DD/MM/YYYY or MM/DD/YYYY) depends on a setting on 
the iProcess Engine to which you are logged in.

Case Description The description that was entered when the case that generated this work 
item was started.

Case Number A unique number used to identify the case. This is generated when the 
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Column
Name

Meaning

case is started.

Deadline 
Date/Time

The date and time the work item’s deadline expires. If the work item does 
not have a deadline, this column is blank.

Deadline 
Expired / 
Deadline 
Expired Image

True - The work item has an expired deadline.

False - The work item does not have an expired deadline.

Deadline Set / 
Deadline Set 
Image

True - The work item has a deadline.

False - The work item does not have a deadline.

Deadline Status An icon appears in this column if the work item has a deadline — it 
indicates whether or not the deadline is expired. For more information, see 
Work Item Deadlines.

Forwardable / 
Forwardable 
Image

True - The step definition in the procedure allows resulting work items to 
be forwarded.

False - The step definition in the procedure does not allow resulting work 
items to be forward.1

Host Node The name of the TIBCO iProcess Engine to which the iProcess Workspace 
(Browser) is connected.

Keep On 
Withdrawal / 
Keep On 
Withdrawal 
Image

True - The step was defined to be “kept on withdrawal” (see Work Item 
Deadlines).

False - The step was not defined to be “kept on withdrawal”.

1Although the step definition does not allow resulting work items to be forwarded, some users 
may still be able to forward the work item (e.g., system administrators) — for more information, 
see Forwarding Work Items.
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Column
Name

Meaning

Locked / Locked 
Image

True - The work item is currently locked (opened) by a user of an 
application other than the TIBCO iProcess Workspace (Browser) 
application.

False - The work item is not currently locked by a user of an application 
other than the TIBCO iProcess Workspace (Browser) application.1

Locked By The name of the user who has the work item open (locked).

Long Locked / 
Long Locked 
Image

True - The work item is currently locked (opened) by a user of the TIBCO 
iProcess Workspace (Browser) application.

False - The work item is not currently locked (opened) by a user of the 
TIBCO iProcess Workspace (Browser) application.1

Mail Id A number that uniquely identifies the work item; primarily used internally.

Orphaned / 
Orphaned Image

True - The work item still appears in the work queue even though it has 
been released by another user. It will be removed when the list is 
refreshed.

False - The work item has not been released and is available to be 
processed.

Priority A value that indicates the relative importance of the work item. This is 
specified when the step that generated the work item is defined in the 
procedure.

Procedure 
Description

A description of the procedure from which the work item was generated.

Procedure Name The name of the procedure from which the work item was generated.

Reference A unique number that identifies the case from which the work item was 

1For more information about the difference between a “lock” and a “long lock”, see Opening / 
Locking Work Items Multiple Times.
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Column
Name

Meaning

generated.

Releasable / 
Releasable 
Image

True - The work item contains no input fields (required or optional) — it is 
directly releasable.

False - The work item contains input fields.

Started By The user that started the case from which the work item was generated. 
This is in the form username@node, where node is the name of the TIBCO 
iProcess Engine to which the iProcess Workspace (Browser) is connected 
(which is the same value in the Host Node column).

Status An icon that indicates the current status of the work item. For more 
information, see Work Item Status.

Step Description A description of the step related to the work item.

Step Name The name of the step related to the work item.

Suspended / 
Suspended 
Image

True - The work item is in a case that has been suspended.

False - The work item’s case has not been suspended.

Unopened / 
Unopened 
Image

True - The work item has not been opened, i.e., it is a “new” work item.

False - The work item has been opened.

Urgent / Urgent 
Image

True - The work item is flagged as urgent. Whether or not a work item is 
urgent depends on a priority value given to the step when the procedure 
was created, as well as a configuration value specified in the server. That 
is, if the priority exceeds (is smaller than — with 1 being the highest 
priority) the configuration value, the work item is flagged as urgent.

False - The work item has not been flagged as “urgent”.

Version The version of the procedure from which the work item was generated.
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Column
Name

Meaning

WQParameter 1-
4

These “work queue parameter” fields may contain case data that was 
entered on a form. These fields must be specifically configured to display 
case data so that they (the WQParameter fields) can be used to filter or 
sort the work item list.

Number of Work Items in a Work Item List
There is an indicator in the header bar of the work item list to tell you how many work 
items are in the list. This number is displayed to the right of the Find button. In this 
example, there are 34 work items.

Note that this number may indicate the number of work items in the list after it has been 
filtered using the filter dialog — if the list has been filtered in this way, there will be a red 
check mark on the Filter icon (for information about using the filter dialog to filter work 
items, see Filtering a Work Item List).

This number can also be shown in two other formats:

• ##(##) - This format (e.g., 60(466)) is displayed if you have clicked on the Find 
button, but you are not using the “server filter” feature with the find function. For 
more information about using the find function and the server filter feature, see 
Finding Work Items in the Work Item List.

The number in the parentheses is the number of work items in the list. The number 
outside the parentheses is the number of work items that have been downloaded 
from the iProcess Engine; the find function will search through only the work items 
that have been downloaded from the iProcess Engine (work items are downloaded 
from the iProcess Engine only when you view the page containing those work items; 
viewing additional pages of work items causes more work items to be downloaded).         



TIBCO iProcess® Workspace (Browser) User Guide

71 | Working With Work Items

• #/##(##) - This format (e.g. 10/60(466)) is displayed if you have clicked the Find 
button and have entered search criteria to find work items in the list, but you are 
not using the “server filter” feature with the find function. For more information 
about using the find function and the server filter feature, see Finding Work Items in 
the Work Item List.

The number before the forward slash is the number of work items that it found 
based on the criteria you entered (it only searches through the work items that have 
been downloaded from the iProcess Engine (60 in this example)).         

 

Work Item List Page Size
When a list of work items is displayed on your screen, only a page of work items is 
displayed at one time. This is done to speed up the display, especially if there are a very 
large number of work items.

If the list contains more work items than the number specified for the page, you can step 
through the multiple pages by clicking on the arrow icons in the lower right corner of the 
list:

In this example, there are 1992 work items in the list, and it is currently displaying the first 
page (which is specified as 20).

The number of work items in a page defaults to 20. You can change this number by 
selecting Page Size from the View menu on the work item list (note that this function is 
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disabled if the local find function is currently active — see Finding Work Items in the Work 
Item List). The following dialog is displayed:

Enter the number of work items you would like displayed on each page.

You can also make this page size persistent by checking the “default page size” box. If 
checked, the size specified becomes the default page size for work item lists every time 
you log in to the current machine (it is only saved locally; if you log into a different 
machine, it is not in effect).

Note: From a performance standpoint, it’s important that you understand that 
when a page of work items is displayed, the information about the work items in 
the page is downloaded from the iProcess Engine. Because of that, you should 
keep the page size at a reasonable number. If the page size is a large number, 
you could experience a delay when displaying a work item list due to the 
amount of information that must be downloaded.

Note: If you click a column header to sort the work items by that column, the 
sort is applied only to each individual page. It does not sort down through the 
entire work item list. For more information, see Sorting the Work Item List Using 
Column Headers. (If you need to sort through the entire list, make the page size 
large enough to encompass the entire list, or sort using the sort dialog. For 
information about the sort dialog, see Sorting a Work Item List.)
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Finding Work Items in the Work Item List
The work item list contains a Find button that can be used to quickly find work items in 
the work item list.

For general information about using the find function, see Finding Items in a List. Note, 
however, that the find function works somewhat different when used with the work item 
list because of the way in which work items are downloaded from the server.

When used on the work item list, the find function can be used in one of the following two 
modes:

• Local Find - When using the find function in this mode, the system only searches 
through the pages of work items that have been downloaded from the server so far. 
Work items are downloaded from the server only when you view the page on which 
the work items are listed. For instance, if you’ve viewed two pages each containing 
20 work items, only those 40 work items have been downloaded — the find function 
in local mode will only search through those 40 work items.

To perform a local find, ensure that the Server Filter check box is not checked 
before entering your find criteria:         

  

Also note that the Type Ahead feature is available to use if you are performing a 
local find (it is not available when using the server find mode). For information 
about using the Type Ahead feature, see Finding Items in a List. 

• Server Find - When using the find function in this mode, the system actually 
performs the search on the server, looking through the entire work item list, not just 
the work items that have been downloaded to the client. Note, however, that if you 
have filtered the list using the filter dialog prior to using the find function, the find 
function will only search through the work items that have satisfied the filter criteria.

The thing to bear in mind when using the server find mode is that it requires that a 
message be sent to the server, and that the search be performed on the entire list 
(possibly filtered) at the server. This can take some time if it is a very large list. (If it’s 
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a very large list, you should pare it down first using the filter dialog prior to using 
the find function.)

To perform a server find, ensure that the Server Filter check box is checked before 
entering your find criteria:         

  

Also note that the Type Ahead feature is NOT available to use if you are performing 
a server find (it is available when using the local find mode). 

Wild card characters can also be used with the Server Find function, where “?” 
matches any single character, and “*” matches zero or more of any character.

The state of the Server Filter check box will persist between work item lists, as well as 
between logins. That is, whenever you display a work item list, and click on the Find 
button, the Server Filter check box will be in the same state you left it the last time you 
used the find function (it is not checked by default the very first time you click Find). (Note 
that the server filter state is only saved locally; if you log into a different machine, it will 
likely be different.)

Using the Find Function With the Filter Function

When using the find function on work item lists, it is often used in conjunction with the 
filter function (for information about the filter function, see Filtering a Work Item List). 
When used on the work item list, the intent is for the find function to refine the search that 
has already been done using the filter function. Typically, the filter function is used to 
present a list of work items that are of continual interest. You can then use the find 
function to further refine the search through the list of filtered work items. When you are 
done with the find function, and close it, the list returns to the list presented by the filter 
function. If you want a different list of work items that are of continual interest, the list 
should be filtered using the filter function.

Note: The Filter, Sort, Refresh, and Auto-Refresh icons and menu selections 
are disabled while the find function is being used — you must close the find 
function to change filter or sort criteria, or to refresh the list. Also, if you have 
the auto-refresh feature turned on, it is temporarily disabled while the find 
function is being used.
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Refreshing the Work Item List
When a work item list is initially displayed, it is a snap shot of the work items at that point 
in time. You can refresh the list to get the most recent list of work items from the iProcess 
Engine by:

• selecting Refresh Work Items from the Tools menu, or 

• by clicking the  icon.

If you have defined filter and/or sort criteria for the work item list, they will be applied on 
the refreshed list of work items — the work item list is displayed if the number of work 
items does not exceed the specified number; the filter dialog is displayed if the number of 
work items exceeds the specified number (for more information, see Filtering a Work Item 
List).

Auto-Refresh of Work Item Lists

Work item lists also have an “auto-refresh” feature that, when enabled, causes the work 
item list to be automatically refreshed at specified intervals. The other list types do not 
have this feature.

To enable or disable the auto-refresh feature, either select Auto-Refresh from the work 
item list View menu, or click the  icon. The following dialog is displayed:

To enable auto-refresh, check the Auto-refresh check box, specify the number of seconds 
you would like between refreshes (the minimum you can specify is 5 seconds), then click 
OK.

There is an indicator on the left side of the work item list status bar that tells you the 
current state of the auto-refresh feature:
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This indicator changes to “Refreshing...” when the list is in the process of being refreshed.

You can specify whether auto-refresh is enabled or disabled by default every time you log 
in. This is done on the Options dialog — see Auto-Refresh of Work Item Lists. 

Work Item Status
By default, the first column in the work item list displays icons that indicate the work 
item’s status. The following table shows the possible icons and their meanings:

Icon Work Item Status

The work item is “new” (i.e., it has never been opened).

The work item has been opened since it arrived in the work queue.

If the icon is “grayed out”, it indicates the work item is part of a suspended case. 
The work item cannot be opened while the case is in a suspended state. A 
suspended work item may be one that has never been opened, or one that has been 
opened since it arrived in the work queue.

For more information, see Case Suspensions.

The work item is currently locked by a user.

The work item is flagged as urgent. Note that this icon can be displayed in 
combination with any of the other icons. For example, the work item might be 
“new” and “urgent”. For example:
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Icon Work Item Status

Opening a Case from the Work Item List
Opening a case causes the case details to be displayed. Case details are presented in a 
tabbed format that contains Summary, History, Outstanding, and Data tabs. As the 
names of the tabs imply, you can view a summary of the case, the case history details, 
information about the outstanding work items in the case, and view/modify the case data 
fields.

You can open the case that is associated with a particular work item, by selecting the work 
item in the work item list, then:

— select Open Case from the Tools menu,             

Note: You cannot open a case for multiple work items from the work 
item list. If you select multiple work items, the Open Case function 
becomes disabled.

— right-click the mouse button on the desired case and select Open Case from the 
drop-down menu, or

— click the  icon on the work item list.

All of these methods of opening a case cause the selected case to be displayed:
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Note that when opened from the work item list, the case details are always displayed in a 
separate dialog — i.e., they cannot be displayed in the preview pane).

For information about using each of the tabs in the case details, see the following:

• Summary Tab - Case Summary

• History Tab - Case History

• Outstanding Tab - Outstanding Work Items in the Case

• Data Tab - Case Data Fields

Filtering a Work Item List
“Filtering” a list of work items involves entering filter criteria so that only some of the work 
items are shown in the list, rather than all of them. Filtering a list of work items allows you 
to display only the work items you are interested in. For example, you may only be 
interested in work items that arrived in the work queue after Dec. 15, 2004. You can filter 
the list so that only those work items are shown.

The filtering function allows you to build a “filter expression” that is applied to all work 
items for the work queue that was selected. If the work item satisfies the filter expression 
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(e.g., it arrived after Dec. 15, 2004), it is shown in the work item list; if it does not satisfy 
the filter expression, it is not shown in the list (and is not downloaded from the iProcess 
Engine).

You can filter the work item list at any time by:

• clicking the  icon, or 

• by selecting Filter... from the View menu on the work item list. 

This displays the filter dialog, on which you can specify a filter expression. This is explained 
in the following subsections.

The filter dialog may also be automatically displayed when you attempt to open a work 
queue from the work queue list. This occurs if the number of work items in the work queue 
exceeds a threshold that you’ve specified in your user options (see Work Item Filters).

If the number of work items exceeds the threshold specified in your user options, the filter 
dialog is automatically displayed:
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Note: If you had applied a filter expression the last time you viewed the work 
item list,      that same filter expression will be applied when you open the list again 
— in other words, the most recently applied filter expression will remain in      effect 
until you remove it or change it.

If a filter expression is still active, the Filter icon is shown with a green check 
mark (as shown below), and if the filter dialog is      displayed, the previously 
entered filter expression will be shown in the Expression section.

 

Filter expressions for a particular list are saved either locally or on the server, 
depending on a configuration setting made by the system administrator:

— If saved locally, and you log into a different machine, the filter you 
defined for a particular list will not be in effect on that new machine 
— filters defined on a specific machine will apply only to that 
individual machine. 

— If saved on the server, and you log into a different machine (and 
connect to the same server), the filters you defined will be in effect on 
the new machine. 

Notice the “465 items will be returned” message in the upper left part of the example 
filter dialog. This is the number of work items that will be returned if you click the OK 
button to display the work item list. If this is a large number, you should enter a filter 
expression so that a smaller list is returned, making it easier to find the work items you 
want to work on.

The message on the upper right part of the filter dialog tells you the current threshold 
number that is specified in your user options — in this example, it’s 200. For information 
about specifying this number, see Work Item Filters).

Building a Filter Expression
The filter dialog allows you to build a “filter expression” that is used to evaluate each work 
item to determine if it should be included in the list.

The following summarizes building a filter expression:

• Choose a field to filter on. A “field” in this context is not necessarily a field that    
appears on a form in a work item — although it can be. These also include “system 
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fields,” which contain information about the work item that is stored in the     system, 
such as the date/time the work item arrived in the work queue, whether or not the 
work item is “new” (i.e., unopened), etc.

• Choose an operator that will be used in your filter expression, e.g.,’=’ (equals), ’<’    
(less than), ’>’ (greater than), etc.

• Enter the value to be compared against the value in the field you chose. (The value 
entered in    the Value field must match the data type for the field selected. For 
information about the valid data types,     see Value Data Types.)

For example, to list only work items that arrived in the work queue after Dec. 15, 2004:

— Field: Arrival Date

— Operator: >

— Value: 15/12/2004

You can choose multiple fields to filter on.

At any time while building the filter expression, you can “apply” the expression by clicking 
the Apply button. The “##### items will be    returned” message is updated to inform you 
of the number of work items that satisfy the filter expression you’ve built. This is the 
number of work items     that will be listed when you click the OK button.

You can also click the OK button at any time without first clicking the Apply button — this 
causes any filter expression(s) you’ve entered to    be applied and the list displayed. But you 
will not know the number of work items that will be returned in the list until after the list is     
displayed — clicking Apply first allows you to know how many will be returned before the 
list is displayed.

Also note that you can use the Close button to close the filter dialog without applying the 
filter expression (assuming you have not    yet clicked Apply). Any expression you’ve entered 
will remain on the filter dialog, so that if you return to the filter dialog again prior to     
closing the work item list, the expression you had entered will still be available.

You can clear/remove the currently displayed filter expression at any time by clicking on 
one of the ”eraser” icons on the right side of the filter    dialog.

Each step required to build the filter expression is described in more detail in the following 
subsections.

Choosing a Field to Filter On

To choose a field to filter on:
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1. Click the arrow on the right side of the Field column. The following drop-down list is 
displayed:         

This drop-down list provides a comprehensive list of the fields you can filter on. It 
consists       of:

• System Fields - These fields contain information that is provided by the       
system, e.g., the date and time the work item arrived in the work queue, the 
case number the work item is associated with,       etc.

A comprehensive list of available system fields is provided        in System Fields 
Available for Filtering Work Items.

• Case Data Fields -       These fields contain case data that was entered into a field 
on the form associated with a work item, e.g., a customer name or invoice       
number.

A system administrator determines which case data fields are available to 
filter on, and in which work queues       they are available. 

There are two types of case data fields that you can use to filter the work 
item       list:

— Work queue parameter       fields - These are special fields that can be used 
to store work queue-specific data. Unless the system administrator 
assigned different names       to these fields, they appear in the Field drop-
down list as WQ Parameter1 - 4, as follows:         
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Filtering on a work queue parameter field allows you to filter on the value 
in the work queue        parameter field. For instance, if the system 
administrator assigned the “customer name” field to the “work queue 
parameter 1" field, you could        then filter on “WQ Parameter1” to display 
only the work items in the work queue that contain a certain customer 
name.

Note: Work queue parameter fields are an “older” method of 
designating fields for filtering and sorting. A more recent 
method is using Case        Data Queue Parameter (CDQP) fields 
(described below). Because of their improved flexibility, CDQPs 
are likely to be used in recently developed         systems. 

— Case Data Queue          Parameter (CDQP) fields - These are similar to work 
queue parameter fields; they hold case data that was entered on a form 
associated         with a work item. 

A system administrator must assign case data fields to CDQP fields to 
make those fields         available for filtering (and sorting). If this has been 
done, the name of the field appears in the Field drop-down list. In the 
following example, the Occupation field is a         case data field that appears 
on a form and that has been designated a CDQP, causing it to appear in 
the Field drop-down list:           
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It’s important to understand that CDQP fields contain “work item data” 
(as opposed to “case data”.) “Work item data” is the data         associated with 
a work item while it’s in a work queue — if you enter information in a 
form, then “keep” the work item, the information          you’ve entered is 
written to work item data. “Case data” is the information that is written to 
the database after you’ve          “released” the work item — if you enter 
information in a form, then “release” the work item, the information 
you’ve entered is          written to case data. For more information about these 
types of data,          see Case Data Fields.

2. Select the desired field from the drop-down list. 

For a list of the available system fields, see System Fields Available for Filtering Work 
Items.

Choosing an Operator for the Filter Expression

The Oper. field allows you to select an operator for the filter expression. Click on the arrow 
on the right side of the Oper. field. The following drop-down list is displayed:

Select the appropriate operator from the list (you can also type in the operator). The 
selections are:
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Operator Description

? Equal to (regular expression equality operator1)

< Less than

<= Less than or equal to 

< > Not equal to

= Equal to

> Greater than

>= Greater than or equal to 

Specifying a Value for the Filter Expression

Enter the value in the Value field that you would like compared to the value in the field 
you selected in the Field field.

For example, to list the work items that are currently locked by user “susieq”, enter 
“susieq” in the Value field:

  

1Using this operator allows you to enter “regular expression” syntax to perform more complex 
string search functions. As regular expressions are beyond the scope of this document, see an 
outside source for information about valid regular expression syntax.
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Note: When the iProcess Workspace (Browser) sends a Date field value to the 
iProcess Engine for filtering, it      must be enclosed in exclamation characters (e.g., 
!12/12/2005!), and Time field values be enclosed in ‘#’ characters (e.g., #12:00#). 
Therefore, once      you’ve entered a valid date or time in the Value field for those 
field types, the value shown in the Expression window is automatically      enclosed 
in the applicable characters. For example:                         

 

DateTime field values are sent to the iProcess Engine enclosed in quotes (e.g., 
“12/12/2005 10:30”). 

 

Value Data Types

The value entered in the Value field must match the data type for the field selected. (For 
information about the valid data types for each of the system fields, see the list of system 
fields on System Fields Available for Filtering Work Items.)

The following are the types of data that can be entered in the Value field:

Data Type Description

Numeric Consists of one or more of the numbers 0-9. Used for things like the case 
number and work item priority.

Note that all of the system fields that are flags (i.e., fields that have either a 
true or false state (e.g., urgent , forwardable , etc.)) are numeric: 0 or 1, where 
0 indicates false and 1 indicates true.

Text Consists of any number of letters, numbers, or special characters (e.g., #, $, 
etc.). Used for things like the addressee name, case description, etc.

Date The default date format1 is “dd/mm/yyyy”.

1The order of the day, month, and year, as well as the date and time separator characters are 
specified on the TIBCO iProcess Engine. These may be different on your system, depending on 
how it was set up. 



TIBCO iProcess® Workspace (Browser) User Guide

87 | Working With Work Items

Data Type Description

Example: 25/12/2005

Time The default time formata is “hh:mm”, using a 24-hour clock.

Example: 18:30

DateTime The default date/time formata is “dd/mm/yyyy hh:mm”.

Example: 25/12/2005 18:30

The date and/or time format that is currently specified on your TIBCO iProcess Engine is 
shown on the filter dialog when you select a date or time field in the Field drop-down list. 
For example:

The iProcess Workspace (Browser) also provides information about the format required for 
other types of fields selected from the Field drop-down list. In the following example, the 
client is telling you that since the “Forwardable” work item flag has been selected, the 
valid values are 1 (for forwardable) and 0 (for not forwardable):

Using Wild Cards in the Filter Value

You can use the following “wild card” characters in the value you enter in the Value field 
when filtering on text fields (note that wild cards can’t be used with non-text fields (for a 
list of the field types, see System Fields Available for Filtering Work Items)):
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Wild Card Character Description

* The asterisk matches zero or more of any character.

? The question mark matches any single character.

Wild card characters may be substituted for one or more characters in your filter value. For 
example:

• To list the work items that are from a procedure whose name begins with the letters 
“LO”:         

 

• To list the work items that are currently locked by users whose user name begins 
with “s”:         

Filtering on Empty Fields

The special SW_NA value can be used in filter expressions to list work items that contain a 
field that is empty (the “NA” means “not assigned”). 

Note, however, this value must be typed into the Expression section (free-form area — for 
information about building free-form expressions, see Building a Free-Form Filter 
Expression). If it is typed into the Value field, the system will enclose SW_NA in quotes in 
the expression — you don’t want quotes around it.

For example, to list the work items containing an Occupation field in which a value has not 
been entered:
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Conversely, to list the work items containing an Occupation field in which a value HAS 
been entered, type in this expression (using the “not equal” operator):

Ranges of Values

Ranges of values can be specified, although it requires you to enter special syntax in the 
Expression section. A range of values must be in the following form:

FilterField=[Val1-Val2|Val3|Val4-Val5|...]

This allows you to specify one or more ranges, each separated by a vertical bar character 
(|), all enclosed in square brackets ([ ]). You can also include individual values in the 
expression. 

For example, the following expression will return all work items that have a case number 
between 300 and 500, as well as the work item with a case number of 633:

You can enter the entire expression free-form in the Expression section, if desired. Or, you 
can select the field and operator from the Field and Oper. field drop-down lists. You may 
or may not be able to enter the entire value in the Value field, depending on the filter field 
chosen. If required, modify the expression in the Expression section so that it is in the 
form shown above.

If dates and/or times are used in a range of values, they must be specified in the following 
format:
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Dates/Times Format Required

Date1 !dd/mm/yyyy!

Time #mm:hh#

DateTimea “dd/mm/yyyy  mm:hh”

For example, the following expression will return all work items that arrived in the work 
queue between the dates of Jan. 01, 2006 and Jan. 31, 2006 (inclusive):

And the following expression will return all work items that arrived in the work queue 
between the times of 8am and 10am, as well as between the times of 2pm and 2:30pm (all 
inclusive):

Filtering on the Current Date

The SW_DATE system field contains the current date. You can use this system field in filter 
expressions. For instance, you can search for all work items that have arrived in the work 
queue today (see the example below).

Note, however, this value must be typed into the Expression section (free-form area — for 
information about building free-form expressions, see Building a Free-Form Filter 
Expression). If it is typed into the Value field, the system will enclose SW_DATE in quotes 
in the expression — you don’t want quotes around it. 

For example, to list the work items that have arrived in the work queue today:

1The order of the day, month, and year can be modified by the system administrator. The correct 
order is shown on the filter dialog if you select a date field in the Field drop-down list.
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Conversely, to list the work items that arrived in the work queue any day other than today:

Applying the Filter Expression
To apply the filter expression shown in the Expression window, you can:

• Click the OK button. This causes any filter expression(s) you’ve entered to be applied 
and the list displayed. But you will not know the number of work items that will be 
returned in the list until after the list is displayed.

• Click the Apply button. The system will apply the filter expression and calculate how 
many work items satisfy the expression. This number is shown on both the top and 
the bottom of the filter dialog (22 in this example):
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If you clicked Apply, and the number of work items that will be returned from the iProcess 
Engine is satisfactory, click the OK button to display the work item list (for information 
about the work item list, see Work Item Lists).

If the number of work items that will be returned is still too large, you can modify the filter 
expression by changing any of the selections in the Field, Oper., or Value fields, then click 
Apply again to get a new work item count. 

Anytime you add, delete, or modify a filter expression on the filter dialog, and have not yet 
clicked the Apply button to apply it, the following message is shown to notify you that the 
changed filter expression has not been applied:

Whenever the message shown above is displayed, the Apply button will be active.

You can also click one of the “eraser” icons to delete filter expressions. Clicking the one to 
the right of the filter fields clears that row of fields; clicking the one to the right of the 
Expression window clears all filter expressions entered so far.

Note that if you apply the filter expression, then view the work item list, the Filter icon 
now contains a red check mark to indicate that a filter has been applied on the list:
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Specifying Multiple-Clause Filter Expressions
You can use logical operators to combine multiple “clauses” in your filter expressions. 

A “clause” is a field/operator/value set. The expression:

SW_ARRIVALDATE = !20/10/2005! AND SW_ADDRESSEE = ”susieq” 

contains two clauses, separated by the AND operator. The following are the logical 
operators that can be used to separate clauses:

Operator Description

AND The expression is true if the first clause and the second clause are true.

OR The expression is true if the first clause or the second clause is true.

Logical ANDs and ORs are entered into a filter expression using the AND/OR field. Click the 
arrow to display the drop-down list and select either AND or OR. When you select an AND 
or OR, another set of fields is displayed, in which you can specify the clause that will be 
ANDed or ORed to the preceding clause.

Example 1

This example returns work items that arrived in the work queue on or before 20/10/2005, 
and that have a case description that begins with “C”:

In this example, both clauses must be true for a work item to be returned in the list.
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Example 2

This example returns work items that either have an expired deadline or are flagged as 
urgent:

In this example, either one of the clauses can be true for the work item to be returned in 
the list.

Specifying More Than Two Clauses

If you specify more than two clauses, they are always evaluated in pairs from left to right. 
Consider the following:

In this example, the entire filter expression created is this:

SW_EXPIRED = 1 AND SW_URGENT = 1 OR SW_CASEDESC = "C*”

The system will evaluate this expression as if there are parentheses around the first two 
clauses in the expression. For example:

(SW_EXPIRED = 1 AND SW_URGENT = 1) OR SW_CASEDESC = "C*”

As you continue to add clauses to the expression, the system continues to evaluate from 
left to right. For example, if you added a fourth clause to the expression above, it would 
include the following implied parentheses:

((SW_EXPIRED = 1 AND SW_URGENT = 1) OR SW_CASEDESC = "C*”) AND SW_
PRONAME = "LOAN"
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Building a Free-Form Filter Expression
After specifying filter criteria in the Field, Oper., and Value fields, the filter expression 
appears in the Expression window:

The expression that appears in the Expression window is what is actually sent to the 
iProcess Engine. You are free to edit this text in any way desired. Note, however, that the 
results may not be what you expect if the expression is not in the format required by the 
iProcess Engine. For example, dates must be enclosed in exclamation characters 
(!07/05/2006!), times must be enclosed in the ‘#’ character (#18:30#). These special 
characters are automatically added for you when you use the Field, Oper., and Value fields 
to build the expression.

You can also add parentheses to the expression in the Expression window to create more 
complex filter expressions.

The system field names that appear in the Expression window (e.g., SW_DEADLINEDATE) 
are listed in the table of system fields on System Fields Available for Filtering Work Items.

Favorite Filter Expressions
The “favorites” feature allows you to save your favorite (i.e., commonly used) filter 
expressions. This allows you to quickly select an expression by name, rather than requiring 
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you to enter each element of the expression.

To use the favorites feature, click the Favorites button on the filter dialog:

The following dialog is displayed:

In this example, there have already been two favorites saved: “High priority w/expired 
deadline” and “New Urgent”.

To use one of the saved favorites:

1. Select the desired favorite in the Saved Favorites section.

2. Click the Load button.

The filter expression associated with that name is automatically entered into the 
Expression section on the filter dialog and is automatically applied to the work item 
list — the “### items will be returned” text is displayed on the filter dialog indicates 
how many work items satisfied the filter expression.
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Saving a New Favorite Filter Expression

To save a new favorite filter expression:

 1. Build the filter expression you would like to save using the filter dialog. See Building 
a Filter Expression.

 2. Click the Favorites button on the filter dialog. The Favorites Manager dialog is 
displayed.

 3. In the field on the bottom of the Favorites Manager dialog, enter the name you 
would like to give the filter expression you are saving in the favorites (the entry in 
this field defaults to the current date and time).

 4. Click Save to save the new favorite. 

System Fields Available for Filtering Work Items
The following table lists the system fields that can be included in expressions when filtering 
work items. 

The text in the Description column in the table below corresponds to the text in the Field 
field drop-down list on the Filter dialog. When you choose a field from the Field field drop-
down list, the actual system field name (e.g., SW_CASEDESC) is entered in the filter 
expression in the Expression window on the Filter dialog.

Description System Field 
Name

Data Type Comments

Arrival Date SW_ARRIVALDATE Date

Arrival 
Date/Time

SW_ARRIVAL DateTime
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Description System Field 
Name

Data Type Comments

Arrival Time SW_ARRIVALTIME Time

Case 
Description

SW_CASEDESC Text

Case Number SW_CASENUM Numeric

Deadline Date SW_
DEADLINEDATE

Date

Deadline 
Date/Time

SW_DEADLINE DateTime

Deadline 
Expired 

SW_EXPIRED Numeric 1 - expired deadline
0 - no expired deadline

Deadline Set SW_
HASDEADLINE

Numeric 1 - has deadline
0 - no deadline set

Deadline Time SW_
DEADLINETIME

Time

Forwardable SW_FWDABLE Numeric 1 - is forwardable
0 - not forwardable

Host Name SW_HOSTNAME Text

Locked By SW_LOCKER Text User name

Priority SW_PRIORITY Numeric

Procedure 
Description

SW_PRODESC Text

Procedure 
Name

SW_PRONAME Text
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Description System Field 
Name

Data Type Comments

Releasable SW_RELABLE Numeric 1 - releasable (no input fields)
0 - not Releasable

Started By SW_STARTER Text username@node

Step 
Description

SW_STEPDESC Text

Step Name SW_STEPNAME Text

Suspended SW_SUSPENDED Numeric 1 - suspended
0 - not suspended

Note: This may not be available to 
you if you are using an older iProcess 
Engine.

Unopened SW_NEW Numeric 1 - unopened
0 - has been opened

Urgent SW_URGENT Numeric 1 - urgent
0 - not urgent

WQ 
Parameter1 *

SW_QPARAM1 Text

WQ 
Parameter2 *

SW_QPARAM2 Text

WQ 
Parameter3 *

SW_QPARAM3 Text

WQ 
Parameter4 *

SW_QPARAM4 Text

* The actual name that appears in the Filter field drop-down list for the work queue 
parameter fields may be different than those shown here if the system administrator has 
assigned different names to them.
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Note: For information about data types used in system fields,    see Value Data 
Types. 

Sorting a Work Item List
The iProcess Workspace (Browser) allows you to sort the information in the columns of the 
work item list so they are in the order you would like them listed.

For example, you may want to list all “new” (unopened) work items first, then sort those by 
arrival date/time, from oldest to most recent. This example requires you to sort on two 
fields: “Unopened” and “Arrival Date/Time ”. 

To specify how work items in the work item list are sorted:

• click the  icon, or 

• select Sort... from the work item list View menu.

The following dialog is displayed:
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The list on the left shows all of the fields that are available to sort on. To sort the work 
item list, you must move the desired fields from the list     on the left to the list on the right, 
then arrange them in the desired priority (order). This is described in the following 
subsections:

By default, all work item lists are sorted by Procedure Name, followed by Case Number, 
then Step Name, all in ascending order. If you     specify one or more sort fields using the 
sort dialog, the default sort fields are replaced by your specification. For example, if you 
specify to sort on      case description only, that is the only field on which the list will be 
sorted.
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Note: If you had applied sort criteria the last time you viewed the work item list, 
that same sort     criteria will be applied when you open the list again — in other 
words, the most recently applied sort criteria will remain in effect until you 
remove it or     change it.             

If previously applied sort criteria is still active when the work item list is 
displayed, a green check mark will be shown with     the Sort icon.

Sort criteria for a particular list is saved either locally or on the server, 
depending on a configuration setting made by the system administrator:

• If saved locally, and you log into a different machine, the sort you defined 
for a particular list do not reflect     on that new machine — sort criteria 
defined on a specific machine will apply only to that individual machine. 

• If saved on the server, and you log into a different machine (and connect 
to the same server), the sort criteria you       defined can be in effect on the 
new machine.

Selecting Sort Fields
The Available Fields list on the sort dialog provides a list of the fields you can sort on. It 
consists of:

• System Fields - These fields contain information that is provided by the system, 
e.g., the date and time the work item arrived in the work queue, the case number 
the work item is associated with, etc.

A comprehensive list of available system fields is provided in System Fields Used to 
Sort Work Items.

• Case Data Fields - These fields contain case data that was entered into a field on 
the form associated with a work item, e.g., a customer name or invoice number.

A system administrator determines which case data fields are available to sort on, 
and in which work queues they are available. 

There are two types of case data fields that you can use to sort the work item list:

— Work queue parameter fields - These are special fields that can be used to 
store work queue-specific data. Unless the     system administrator assigned 



TIBCO iProcess® Workspace (Browser) User Guide

103 | Working With Work Items

different names to these fields, they appear in the Available Fields list as WQ 
Parameter1 - 4, as follows:          

Sorting on a work queue parameter field allows you to filter on the value in the 
work queue parameter field. For instance, if the     system administrator assigned 
the “customer name” field to the “work queue parameter 1" field, you could 
then sort on “WQ Parameter1”.          

Note: Work queue parameter fields are an “older” method of 
designating fields for filtering and sorting.       A more recent method is 
using Case Data  Queue Parameter (CDQP) fields (described below). 
Because of their improved flexibility, CDQPs are likely to be used in 
recently developed systems.

— Case Data Queue Parameter (CDQP)     fields - These are similar to work queue 
parameter fields; they hold case data that was entered on a form associated with 
a work item. 

A system administrator must assign case data fields to CDQP fields to make 
those fields available for sorting (and filtering).      If this has been done, the name 
of the field appears in the Available Fields list. In the following example, the 
Occupation field is a case      data field that appears on a form and that has been 
designated a CDQP, causing it to appear in the list:         

 

To specify sort fields:

1. Select the desired sort field(s) from the Available Fields list:

— Individual fields can be selected by clicking on the desired name. 
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— Multiple fields can be selected by holding down the Ctrl key while clicking on the 
desired names. A group of fields can be selected by clicking on one name, then 
holding down the Shift key and clicking on the last name in the desired group.

2. Move the columns to the desired list:

— Fields can be moved back and forth between lists by selecting the desired field
(s), then clicking the “>” or “<“ buttons.

You can also move an individual field to the other list by double-clicking on the 
field name.         

— All fields can be moved from the Sort Fields section by clicking the “<<“ button.

Note: You can specify a maximum of 10 sort fields for a work item list.

Specifying Sort Priority
The order in which the sort fields are listed in the Sort Fields window specifies the priority 
of the sort. If you have multiple sort fields listed, all work items will first be sorted by the 
first sort field, then they will be sorted by the next sort field, and so on. For example, if you 
specified “Unopened” as the first sort field, then “Arrival Date/Time” as the second sort 
field (both ascending), the work items would be sorted in the following fashion: 

Unopened Jan. 1, 2006

Unopened Jan. 2, 2006

Unopened Jan. 3, 2006
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Opened Jan. 1, 2006

Opened Jan. 2, 2006

Opened Jan. 3, 2006

In the example shown above, all unopened work items will be listed first, followed by the 
opened work items. Within each group of unopened and opened work items, they are 
sorted by arrival date/time.

To change the priority, select the desired sort field(s) in the Sort Fields window, then click 
on the “+” or “-” button to move the field(s) up or down in the list.

Specifying a Sort Direction
The list of work items can be sorted in either ascending or descending order:

When a sort field is added to the Sort Fields list, it is ascending by default, which is 
denoted by the up arrow next to the field name:

To change the sort direction, select the desired sort field(s) in the Sort Fields list, then 
click the up or down arrow buttons on the sort dialog:

The arrow next to the field name changes to indicate the new sort direction:
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System Fields Used to Sort Work Items
The following table lists the system fields available for sorting work items:

Sort Field Data Type

Arrival Date/Time DateTime

Case Description Text

Case Number Numeric

Deadline Date/Time DateTime

Deadline Expired Numeric

Deadline Set Numeric

Deadline Timea Time

Forwardable Numeric

Host Name Text

Locked By Text

Priority Numeric

Procedure Description Text

Procedure Name Text

Releasable Numeric

Started Bya Text
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Sort Field Data Type

Step Description Text

Step Name Text

Unopened Numeric

Urgent Numeric

WQ Parameter1b Text

WQ Parameter2b Text

WQ Parameter3b Text

WQ Parameter4b Text

a. Sorting by Deadline Time, Locked By, and Started By are inherently inefficient — sorting by these fields 
may slow down the sorting process.

b The actual name that appears in the Available Fields list on the sort dialog for the work queue parameter 
fields may be different than those shown here if the system administrator has assigned different names to 

them.

Note that the way in which the system sorts the values in the sort fields depends on the 
type of data in that field. For instance, since the “Procedure Description” field is text data, 
that field is sorted alphabetically; and since the “Arrival Date/Time” field is a DateTime 
data type, it is sorted chronologically according to the date/time.

Note: For information about data types used in system fields,    see Value Data 
Types. 

Sort As Different Data Type

The way in which the system sorts the values in the sort fields depends on the type of data 
in that field (e.g., text data is sorted alphabetically, numeric data is sorted numerically, 
etc.).

You can, however, tell the application to sort the data in a field using a data type that is 
different than the field’s data type when sorting on the following fields:



TIBCO iProcess® Workspace (Browser) User Guide

108 | Working With Work Items

• Case description

• Work queue parameter fields 

• Case Data Parameter Queue (CDQP) fields

For instance, you can tell it to sort the data in the Case Description system field (which is a 
text field) as numeric data.

To sort one of these sort fields as a different data type, select the desired sort field in the 
Sort Fields list, then click on the desired data type in the Sort As field (note that the Sort 
As field is active only when you’ve selected one of the fields that can be sorted as a 
different data type):

The value of the sort field will be converted to the specified data type before doing the 
sorting. For example, text fields containing numeric information could be sorted as 
numbers by setting the sort type accordingly. Note, however, that if the sort field does not 
contain something readily convertible to the specified type, the sort results may not be 
what you expect. For example, if sorting text as a numeric field but some of the text fields 
contain non-numeric data, the results may not be what you expected.

Applying the Sort Criteria
After specifying the sort fields, priority, direction, and so on, click the OK button to apply 
the sort criteria you’ve specified. 

Anytime you modify a sort criteria, and have not yet clicked the OK button to apply it, the 
following message is shown to notify you that the changed sort criteria has not been 
applied:
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Whenever the message shown above is displayed, the OK button gets active.

When you click the OK button, a green check mark appears on the Sort icon to indicate 
sort criteria has been applied.

Sorting the Work Item List Using Column Headers
You can quickly and easily sort the work item list on any one of the columns in the list. To 
sort on a column, click on the column header. If the column contains text, it is sorted in 
alphabetical order; if it is numeric, it is sorted in numerical order; if it is a date, time, or 
DateTime, it is sorted in chronological order.

Once you click a column header, a small arrow head appears in the column header, which 
indicates the order of the sort — if the arrow head is pointing up, the sort is in ascending 
order; if it’s pointing down, the sort is in descending order:

Each successive click on the column header, toggles between ascending and descending 
order.

If the work item list consists of multiple “pages” (see Work Item List Page Size), each page 
is individually sorted on the column you have clicked.
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Note: The ability to sort using column headers is controlled through user access 
privileges — if you do not have the authority to sort using column headers, the 
arrow head does not appear in the header when you click it.

Processing Work Items
A work item represents a step in a case (see the illustration of a procedure on 
Understanding a Business Process). Typically, a work item has an electronic form 
associated with it that must be opened and filled out (some forms may only display 
information and will not have fields to fill out). You can then keep the work item in your 
work queue so that it can be opened again and completed at a later time. When the form 
is completed, the work item is released so that the case can progress, possibly resulting in 
another work item that represents the next step in the case.

Opening Work Items
Opening a work item causes the form associated with that work item to be displayed, 
allowing you to enter information into the form.

Opening a work item also “locks” that work item, causing a lock icon ( ) to appear in the 
Status column.

If you attempt to open a work item that you’ve already opened, a message is displayed 
informing you that if you open it again, there could be a loss of data — the system will save 
any changes in data for the first of those work items that is kept or released. When you 
attempt to keep or release the second instance of the work item, an error is returned; your 
only option will be to click Cancel to close the work item, losing any changes made on that 
form.

If any user of the TIBCO iProcess Workspace (Browser) attempts to open a work item that 
another user has already opened, a message is displayed on their screen informing them 
that the work item is already opened. They will not be allowed to open it. (Multiple users 
can have access to a work item if the work item was sent to a group work queue; another 
user may also have access to a work item if “participation” has been used to give a user 
access to another user’s work queue.)
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Note: A user of the TIBCO iProcess Workspace (Browser) application can open a 
work item, then log in at a different workstation using the same username and 
open that same work item. The first one to release the work item will be 
successful; the second one to attempt to release the work item will fail.

Also, if a user opens a work item using an application other than the TIBCO iProcess 
Workspace (Browser), then you attempt to open that same work item with the TIBCO 
iProcess Workspace (Browser), a message is displayed telling you the work item is already 
open; it will not allow you to open it.

Work items can be opened from either the work item list or from the list of outstanding 
work items (Case Detail / Outstanding tab) using one of the following methods:

• Double-click on the desired work item in the list.

• Select one or more work items in the list, then:

— press the Enter key,

— select Open Selected Work Item(s) from the Tools menu on the list,

— right-click the mouse button on the selected work item(s) and select Open 
Selected Work Item(s) from the drop-down menu, or

— click the  icon on the list toolbar.

If you are opening work items from the list of outstanding work items, they are always 
opened in a floating form, i.e., they cannot be opened in the Preview Pane.

If you are opening work items from the work item list, you cannot open multiple work 
items if you are displaying the work item forms in the Preview Pane. If you are opening 
forms in the Preview Pane, and you select multiple work items, the Open Selected Work 
Item(s) function is disabled.

Opening the First Available Work Item

When opening work items from the work item list, you can also open the “first available” 
work item, where “first available” means a work item that is not locked nor suspended, 
starting from the first work item in the list.

To open the first available work item, use one of the following methods:

• Select Open First Work Item from the Tools menu on the work item list,
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• right-click the mouse button anywhere on the work item list and select Open First 
Work Item from the drop-down menu, or

• click the  icon on the work item list toolbar.

Opening the Next Available Work Item

When opening work items from the work item list, you can also open the “next available” 
work item, where “next available” means a work item that is not locked nor suspended, 
starting from the currently selected (highlighted) work item.

To open the next available work item, select (highlight) the work item where you want the 
search for the next available work item to start, then:

• Select Open Next Work Item from the Tools menu on the work item list,

• right-click the mouse button on the selected work item and select Open Next Work 
Item from the drop-down menu, or

• click the  icon on the work item list toolbar.

Note: There is also a way to cause work items to automatically open. For 
information about this, see Automatically Opening Work Items.

Work Item Form Location

The location at which the work item form is displayed when you open a work item 
depends on whether or not the preview feature is turned on.

• If preview is turned off, the work item form is always opened in a separate floating 
window. Note that the window in which the form opens may be either a dialog or a 
new browser window, depending on a user options setting — for more information, 
see Layout Options.

• If preview is turned on, the work item form may be opened either in the Preview 
Pane or a separate floating window, depending on the current preview setting. 

The preview setting can be viewed or set by:

— clicking the  icon on the work item list toolbar, or 

— by selecting Preview from the work item list View menu.

The following drop-down menu is displayed:
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The check mark indicates the currently selected preview option.

— If the Preview On - Open Forms in Preview Pane selection is checked, the 
work item form is opened in the Preview Pane.

Note that the Preview Pane may be set to automatically resize when a work item 
is opened, then return to the previous size when the work item is closed. For 
information about how this done, see Work Item Preview Default.

— If the Preview On - Float Forms selection is checked, the work item form is 
opened in a separate floating window. Note that the window in which the form 
opens may be either a dialog or a new browser window, depending on a user 
options setting — for more information, see Layout Options.

Note: You may or may not be able to open work item forms in the 
Preview Pane or in a separate dialog,       depending on how your forms 
were created, as follows:                 

— if your application uses forms created with TIBCO® General 
Interface (GI forms), you can choose to open      them in any of 
the three available formats: Preview Pane, separate dialog, 
or separate browser window.

— if your application uses any non-GI form (also referred to as 
“external forms”), they will always be      opened in a separate 
browser window, regardless of the setting of the Preview 
selections.
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Note: If you have chosen to display the work item forms in floating 
windows, and there are multiple work items selected when you    open 
them, a floating window for each selected work item is displayed.                       But 
if you have chosen to display the work item forms in the Preview 
Pane, you cannot open multiple work items at one time — if you 
select    more than one work item, the Open Selected Work Item(s) 
function becomes disabled.

Opening / Locking Work Items Multiple Times

Be aware that in an “enterprise” environment, there may be other applications besides the 
TIBCO iProcess Workspace (Browser) application that affect the work items you see in work 
queues.

For this reason there are two “locked” flags that indicate the locked/opened status of work 
items:

• Locked - This flag indicates that a user of another application besides the TIBCO 
iProcess Workspace (Browser) application has the work item locked (opened). These 
work items cannot be opened by any user of the TIBCO iProcess Workspace 
(Browser) application.

• Long Locked - This flag indicates that a user of the TIBCO iProcess Workspace 
(Browser) application1 has the work item locked (opened). Note that the same user 
who has the work item locked can log in using the same username at a different 
workstation and open the work item that is already open. The first one to release 
the work item will be successful; the second one to attempt to release the work item 
will fail. 

Columns are available in the work item list that show the state of each of these flags (for 
information about changing the columns that show in the work item list see, Opening a 
Case from the Work Item List):

1If a work item is locked with the TIBCO iProcess Workspace Lite application (a TIBCO client 
application that allows persons with disabilities to access iProcess BPM functionality using 
standard accessibility aids, such as screen readers and magnifiers), it also sets the Long Locked 
flag to true.
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In this example, a user using an application other than the TIBCO iProcess Workspace 
(Browser) application has locked the work item (the Locked flag is true). Notice, however, 
that regardless of the application that locked the work item, the Status column shows the 
work item is locked, and the Locked By column shows who has the work item locked.

Automatically Opening Work Items

The work item list provides an auto-repeat feature that causes the next available work item 
to be automatically opened after you have released a work item, where “available” means 
a work item that is not locked nor suspended. This allows you to process work items in 
succession without manually opening each one.

To turn on the auto-repeat feature:

• click the  icon on the work item list, or 

• select Auto-Repeat Open Work Item from the Tools menu.

The auto-repeat feature works as a toggle — clicking the  icon causes it to remain 

highlighted while the feature is enabled.

And selecting Auto-Repeat Open Work Item from the Tools menu causes a check mark to 
appear next to the selection, indicating the feature is active:
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If the auto-repeat feature is turned on, but you keep or cancel a work item (rather than 
release it), the auto-repeat process ends (it does not toggle it off, but it does not open the 
next available work item).

The auto-repeat toggle is persistent — it remains in its current state until you change it. 
Note, however, that the auto-repeat state is saved either locally or on the server, 
depending on a configuration setting made by the system administrator:

— If saved locally, and you log into a different machine, the auto-repeat state from 
the previously logged-in machine will not be in effect on the new machine — the 
auto-repeat setting made on a specific machine will apply only to that individual 
machine. 

— If saved on the server, and you log into a different machine (and connect to the 
same server), the auto-repeat state from the previously logged-in machine will 
be in effect on the new machine.

Filling in a Work Item Form

The form that appears when you open a work item is specific to your installation. Each 
company that uses the iProcess Workspace (Browser) creates their own forms that relate to 
the specific business they are in.

Your company will instruct you in properly filling out the forms that they have designed for 
the iProcess Workspace (Browser). The following is an example of what a form may look 
like:
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Note that the form may open in the Preview Pane, a separate dialog, or a separate browser 
window, depending on how your system is set up. For more information, see Preview Pane.

Use the Tab key to move from field to field on the form. 

A “date picker” is available to enter dates in date fields. Click on the calendar icon next to 
the date field. A calendar is displayed from which you can choose a date; clicking on a date 
in the calendar causes it to be entered in the field.

Keeping Work Items
Keeping a work item causes any information you have entered in the form to be saved, 
then the work item is closed (and unlocked) and placed back in the work queue. The work 
item is then available to be opened and completed at a later time.

To keep a work item, click the Keep button on the work item form.



TIBCO iProcess® Workspace (Browser) User Guide

118 | Working With Work Items

Releasing Work Items
Releasing a work item means that you are done with that work item. If there are any fields 
on the form associated with the work item that are marked as “required,” they must be 
filled in before the system will allow you to release the work item.

Releasing the work item causes any information you’ve entered to be saved, then the work 
item is closed (and unlocked) and it is removed from the work queue. The case advances 
to the next step in the procedure, possibly resulting in another work item appearing in 
someone’s work queue.

To release a work item from the work item form, click the Release button on the form:

Releasing a Work Item from the Work Item List

You can release a work item from the work item list (i.e., rather than from the work item 
form). However, the work item must be directly releaseable, meaning that it cannot have 
any data entry fields on the form associated with the work item (if it has a form). It does 
not mean the input fields have been filled in — the form cannot have input fields.

To release work items that are directly releasable, highlight one or more work items in the 
work item list, then:

— select Release Work Item(s) from the Tools menu on the work item list,

— right- click the mouse button on the desired work item(s) and select Release 
Work Item(s) from the drop-down menu, or

— click the  icon.

If a work item is not directly releasable, the Release Work Item(s) function will be 
disabled when you select the work item.

Canceling Changes
You can cancel any changes made on a work item form by “undoing” the changes. 
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To undo your changes, click the Undo button on the work item form. The work item is 
closed and returned to the work queue without saving changes.

Unlocking Work Items
Work items are automatically unlocked when you keep or release them; normally, you do 
not need to explicitly unlock work items.

This function is for those rare occasions when a work item was left open for some reason 
(e.g., a system crash).

Unlocking a work item using the unlock function causes any changes that were made on 
the form while the work item was open to be discarded.

Any user can unlock a work item that they have opened.

To unlock a work item that was opened by another user, you must have system 
administrator authority. 

To unlock work items, highlight one or more locked work items in the work item list, then:

• click the  icon, or 

• select Unlock Work Item(s) from the Tools menu.

A message is displayed confirming that the work item was unlocked.

Forwarding Work Items
You can select and manually forward one or more work items to another work queue (for 
information about setting up automatic forwarding of work items, see Redirecting Work 
Items to Another Work Queue).

Note that there are several levels of access permission that determine whether or not you 
can manually forward work items, as follows:

• User access profile - If your user access profile does not allow you to forward work 
items, the Forward Work Item(s) menu selection and icon do not appear on the 
work item list.

• Step definition - When the procedure is defined, the designer specifies whether or 
not work items representing each step are forwardable. There is a Forwardable 
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column (as well as a Forwardable Image column) that indicates whether or not the 
step definition allows the work item to be forwarded. 

• User definition on the server - A user attribute on the server can be set for each 
user that allows that user to:

— forward work items that are “forwardable” based on the step definition (see 
above), 

— forward any work item, regardless whether or not the work item is “forwardable” 
based on the step definition (see above), or

— never be able to forward work items.

If one or more of the work items you’ve selected are not forwardable, either because the 
step definition does not allow it, or because your user attribute definition does not allow it, 
the Forward Work Item(s) menu selection and icon are grayed out:

Additionally, if a work item is currently locked or it is in a case that is currently suspended, 
it cannot be forwarded.

For work items that can be forwarded. there are two ways in which you can forward them:

• Using the “drag and drop” method - To forward using this method, select one or 
more work items in the work item list, then “drag and drop” them onto the work 
queue to which you want to forward them.

You are asked to confirm before the work items are forwarded.

Using this method, you can forward only to work queues to which you have access 
(as those are the work queues that are displayed in your work queue list).

• Using the Forward dialog - To forward using this method, select one or more work 
items in the work item list, then select Forward Work Item(s) from the Tools menu 
on the work item list, or click the  icon on the work item list toolbar.
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A dialog similar to the following is displayed:         

This dialog lists all work queues on the system, or only the work queues to which 
you have access, depending on how your user access profile is set up (see User 
Access Profiles).

Select the desired work queue from the list (you can forward to only one work 
queue at a time), then click OK. The selected work items are forwarded and the 
work item list is automatically updated.

Work Item Deadlines
When a step is defined in a procedure, a deadline may be specified on that step to ensure 
that the work item associated with the step is completed within a specified period of time. 
For example, the step may specify that the work item must be completed within three 
days, otherwise a notification is sent to a manager.

Deadline-Related Columns
By default, the work item list displays the Deadline Status and Deadline columns, as 
follows:
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The following is a list of all of the deadline-related columns that can be displayed in the 
work item list:

• Deadline Status - If the work item has a deadline, this column displays a “clock” 
icon — the icon’s color indicates the deadline’s status; if the work item does not 
have a deadline, nothing is displayed in this column (it’s blank). The possible clock 
icons are as follows:

Icon Deadline Status

The work item has an unexpired deadline (the clock icon is blue).

The work item has an expired deadline (the clock icon is red).

• Deadline Date/Time- If the work item has a deadline, the date and time of the 
deadline is displayed in this column; if the work item does not have a deadline, 
nothing is displayed in this column (it’s blank).

• Deadline Set or Deadline Set Image - This is a true/false indicator of whether or 
not a deadline has been set on the work item. The non-image column will state 
either “true” or “false” The image column will contain either a green check mark (for 
true) or a red X (for false).

• Deadline Expired or Deadline Expired Image - This is a true/false indicator of 
whether or not the work item has an expired deadline. The non-image column will 
state either “true” or “false” The image column will contain either a green check 
mark (for true) or a red X (for false). (If the work item does not have a deadline, 
these columns will show false.)

For more information about the use of images in columns see, Displaying Images in 
Columns.

The work queue list may also contain a First Deadline Date/Time column that tells you 
the date and time of the earliest deadline in that work queue, as well as a Deadline Items 
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column that tells you the number of work items in that work queue that have deadlines. 
For example:

Deadlines with Case Suspension
Deadlines are not affected by a case suspension (see Note that refreshing the case history 
refreshes the information for this single case.). If a case is suspended, deadlines will 
continue to expire, although no action is carried out until the suspension is lifted. In other 
words, if a deadline expires during suspension, the process will wait until the suspension is 
removed, then the process will continue down the deadline link to generate the next work 
item.

Note, however, that if a deadline expires for a work item while the case is suspended, the 
work item list is not updated to reflect the expired deadline until after the suspension is 
lifted.

Deadline Withdrawals
The deadline for a step may be defined in such a way that when the deadline expires, the 
work item is withdrawn from the work queue. 

Withdrawals will not occur while a case is suspended. If a deadline defined to withdraw 
expires while a case is suspended, the withdrawal will not occur until the case suspension 
is lifted.

Keep on Withdrawal

When a deadline withdrawal is defined in a step, the definer can also specify that the work 
item “not be deleted upon withdrawal” (also referred to as “keep on withdrawal”). This 
means that if the deadline expires, the process flow moves down the “deadline link” path, 
and the work item is officially “withdrawn”, but it is not removed from the work queue. 
Instead, it will be handled differently when it is eventually released.
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Work items that are “not deleted upon withdrawal” are still considered “outstanding” after 
their deadlines expire, even though they have officially been withdrawn (for information 
about outstanding items, see Outstanding Work Items in the Case). 

Since the work item is still in the work queue, it can still be opened, kept, and released. 
When the work item is eventually released (or the sub-procedure case completes, if the 
step is a sub-procedure call), the following occur:

• the normal release actions are NOT processed, i.e., the process flow does not 
continue down the normal path (as is normal for withdrawn steps), and 

• data that was entered into the fields of the work item is still applied to the main 
case data.

The work item list provides the following columns to view the “keep on withdrawal” 
definition for the work item:

• Keep on Withdrawal - Displays “true” if the “keep on withdrawal” flag for the work 
item is set to true; displays “false” if the flag is set to false. (See Work Item List 
Columns.)

• Keep on Withdrawal Image - Displays a green check mark if the “keep on 
withdrawal” flag for the work item is set to true; displays a red X if the flag is set to 
false.

Recalculating Deadlines
You can recalculate all of the deadlines in a case using the trigger event function. This 
causes the deadlines to be recalculated in either the main case only, or the main case and 
all sub-cases — you specify which when the trigger event function is initiated.

For information about using the trigger event function to recalculate deadlines, see 
Triggering an Event.
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Working With Procedures
This section describes how to work with the procedure list.

The Procedure List
The procedure list provides a list of procedures to which you have access. 

Display the procedure list by clicking on the Procedures button (or icon) in the lower left 
portion of the iProcess Workspace (Browser) screen:

There are two primary functions that are performed from the procedure list:
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— Starting a case of a procedure - This involves selecting the desired procedure 
in the list, then clicking the Start Case button. (Note - It is common for cases to 
be started programmatically, therefore, the Start Case button may not be used 
to start cases on your system.)

If the logged in user has permission to start cases of a procedure, “Start” is 
shown in the Permission column for that procedure.

For details about starting cases, see Starting a Case of a Procedure.

— Viewing a list of cases of the procedure - This involves single-clicking on the 
desired procedure to display a list of the cases of that procedure. 

If the logged in user has permission to view the cases of a procedure, “History” is 
shown in the Permission column for that procedure. 

For information about using the case list, see Working With Cases.

For information about selecting items from lists, see Selecting Items in a List.

Procedure Permissions
Only procedures to which you have permission are listed in the procedure list. There are 
two types of permissions:

• Start - This gives you permission to start cases of the procedure. 

• History - This gives you permission to view the list of cases of the procedure. Note 
that “History” in this context does not mean you have “case history” permission; 
rather it means you have “procedure history” permission — you can view the cases 
that have been started for that procedure.

You can have one or both of these permissions. They are shown in the Permission column 
of the procedure list:
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Case start and history permissions are granted when the procedure is defined. Note that 
for both permissions, unless the procedure definer explicitly gives one or more users that 
permission, all users are given permission by default.

Note: Every user also has a user access profile that is determined by the type of 
user they are. Your user type is    specified by the system administrator — it is 
shown in the upper right part of the iProcess Workspace (Browser) screen.     In the 
example below, the user franko is an “Admin” user, which gives him access to 
the functions that have been specified for all Admin users:                         

 

Your user access profile may also affect the functionality to which you have 
access. For example, you may have access to start cases according       to the 
procedure definition, although your user access profile doesn’t allow you to start 
cases (which would cause the Start Case        button / menu selection to not be 
displayed). Also, you may have “History” permission, giving you access to the 
case list, although        your user access profile may prevent you from “opening” the 
case.

 

Procedure List Columns
By default, certain columns are displayed in a procedure list. You can easily customize the 
columns that are displayed by either using the Column Selector, or by changing them 
manually. For information, see Customizing Columns in a List.

The following table describes the columns of information that can be displayed on the 
procedure list:
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Column
Name

Meaning

Active Cases The number of cases of the procedure that are still active, i.e., not closed. 
Note that suspended cases are still considered active.

Closed Cases The number of cases of the procedure that have been closed. For more 
information, see Closing Cases.

Description A description of the procedure that was given when the procedure was 
defined.

Host Node The name of the TIBCO iProcess Objects Server on which the procedure is 
defined.

Name The name of the procedure.

Permission Indicates whether or not the logged-in user has “Start” permission (ability to 
start cases of the procedure) and/or “History” permission (can view cases of 
the procedure). For more information, see Procedure Permissions.

Status An icon that indicates the status of the procedure. For more information, see 
Procedure Status.

Sub-
Procedure / 
Sub-
Procedure 
Image

True - The procedure is defined as a sub-procedure.

False - The procedure is defined as a main procedure.

For more information, see Sub-Procedures.

Total Cases The total number of active, suspended, and closed cases of the procedure. 
When a case is purged from the system, it no longer counts in the total.

Version The version number of the procedure definition.
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Note: If you are displaying the Active Cases, Closed Cases, or Total Cases 
columns, and they appear    with a line through the header, it’s because an 
administrator has configured your system to not display case counts. Therefore, 
if you display the case     count columns, they will appear with a line through their 
header. 

Number of Procedures in a Procedure List
There is an indicator in the header bar of the procedure list to tell you how many 
procedures are in the list. This number is displayed to the right of the Find button. In this 
example, there are a total of 22 procedures.

Note that if this number is displayed in the format “##/##” it means the list is being filtered 
in some way and only some of the procedures are listed. In the example below, 11 of the 
22 possible procedures are listed.

The procedure list can be filtered in one of the following ways: 

• The Find button has been used to filter the list. For information about using the find 
function, see Finding Items in a List.

• Only some of the procedure statuses (released, unreleased, model, and withdrawn) 
on the View menu have been selected. For information about selecting procedure 
statuses to display, see Procedure Status.

• Only some of the procedure types (main and sub-procedure) on the View menu have 
been selected. For information, see Displaying Main and/or Sub-Procedures.

If one or both of these methods have been used to filter the procedure list, the number is 
shown in the ##/## format.
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Finding Procedures in the Procedure List
The procedure list contains a Find button that can be used to quickly find the procedure 
you are looking for.

For information about using the find function, see Finding Items in a List.

Displaying Main and/or Sub-Procedures
You can choose the type of procedures to display in the procedure list: 

— only main procedures, 

— only sub-procedures, or

— both main and sub-procedures.

Make the desired selection from the View menu on the procedure list:

The check mark indicates the currently displayed type.

For more information about sub-procedures, see Sub-Procedures.
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Sorting a Procedure List
You can sort the procedure list on any one of the columns in the list. To sort on a column, 
click on the column header. If the column contains text, it is sorted in alphabetical order; if 
it is numeric, it is sorted in numerical order.

Once you click on a column header, a small arrow head appears in the column header, 
which indicates the order of the sort — if the arrow head is pointing up, the sort is in 
ascending order; if it’s pointing down, the sort is in descending order:

Each successive click on the column header, toggles between ascending and descending 
order.

Refreshing a Procedure List
When the procedure list is initially displayed, it is a snap shot of the procedures at that 
point in time. You can refresh the list to get the most recent list of procedures from the 
iProcess Engine by:

• selecting Refresh Procedures from the View menu, or

• clicking on the  icon on the procedure list.

Do not over use this feature — refresh the list only when you need an updated list. Each 
time you refresh the list, the iProcess Engine must send a new list to your system, which 
can impact performance, depending on the number of items in the list, the speed of your 
system, etc.
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Displaying the Cases of a Procedure
To display a list of the cases of a procedure, single-click the desired procedure in the 
procedure list:

Once a procedure is selected, you can also move the highlight bar with the keyboard arrow 
keys to select other procedures.

Either the list of cases for the selected procedure is displayed, or the case list filter dialog is 
displayed because the number of cases in the list exceeds the specified threshold. For 
more information, see Case Lists.

Displaying Procedure Loading
The procedure loading feature allows you to display a graphical summary that shows you 
how many cases there are on the system for one or more of the procedures to which you 
have access. The chart displayed by this feature provides a visual view of the case load for 
each procedure.

You can access procedure loading in one of two ways:

• Select Procedure Loading Chart from the Tools menu on the procedure list, or click 

the  icon on the procedure list toolbar.

This displays a procedure loading chart that shows you all of the procedures to 
which you have access. Note that the very first time you display the procedure 
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loading chart in this way, it lists all procedures to which you have access. If you pare 
down the list using the Select Procedures function (see Displaying a Subset of 
Procedures in the Procedure Loading Chart), from then on the list only contains the 
subset you have chosen.

• Right-click on one of the procedures in the procedure list, then select Procedure 
Loading Chart from the context menu.

This displays a procedure loading chart that shows you only the procedure on which 
you right-clicked.

The following is an example procedure loading chart that shows multiple procedures:

The green and red-colored bars indicate the number of open and closed cases. The blue 
bar shows the total number of cases for each procedure. Placing the cursor on the bars of 
the chart causes the exact counts for that procedure to be displayed.

Selections are available on the View menu that allow you to display the statuses (released, 
unreleased, model, and withdrawn) of procedures you want shown on the chart. For more 
information, see Procedure Status.

The procedure loading chart can be refreshed at any time by either selecting Refresh 

Procedures on the View menu, or by clicking on the  icon on the toolbar.
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You can close the procedure loading chart by clicking on the X in the upper-right corner.

Displaying a Subset of Procedures in the Procedure Loading Chart

The first time you display the procedure loading chart, it will list all procedures to which 
you have access. You can, however, choose to display only a subset of the available 

procedures by selecting Select Procedures from the View menu, or by clicking the  
icon on the Procedure Loading Chart dialog. The following dialog is displayed:

This dialog contains a check box for each procedure to which you have access. You can 
select or deselect all of the boxes in the list using the first check box on the dialog; you can 
then check/uncheck individual boxes in the list, as desired. When the desired procedures 
are selected, click OK.

The procedure loading chart will list only the procedures that you’ve selected on the 
Procedure Selection dialog. This selection will persist until you change it again.

Procedure Status
You can display four statuses of procedures in the procedure list:
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• Released - A procedure with this status can be used in live production. Cases can be 
started, with work items being sent to user/group work queues, etc.

You will typically be dealing with this status of procedure.

• Unreleased - New procedures default to a status of Unreleased. Work items from 
cases of procedures with a status of Unreleased go to a “test” work queue for the 
user or group who is the addressee of the step (for more information about test 
work queues, see Released vs. Test Work Queues). This allows the new procedure to 
be tested/evaluated prior to releasing it. 

• Model - This is the status a Released procedure has after being imported (which is 
something a system administrator would do). This status allows new versions of a 
procedure to be imported without overwriting an existing Released or Unreleased 
version. Work items from cases of procedures with a status of Model go to a “test” 
work queue for the user or group who is the addressee of the step. This allows the 
new version to be tested/evaluated prior to adopting it on the target system. 

• Withdrawn - Procedures with this status are no longer used in a production 
environment. Cases cannot be started against a withdrawn procedure.

The default is to display Released procedures, although you can decide which statuses of 
procedure to display by selecting the desired status(es) on the View menu on the 
procedure list:

You can display any number of the statuses at one time.

Procedure Status Icon
By default, the procedure list displays a Status column that contains icons that represent 
the status of the procedure.
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The possible procedure status icons are:

Icon Status

Released Procedure

Released Sub-Procedure

Unreleased Procedure

Unreleased Sub-Procedure

Model Procedure

Model Sub-Procedure

Withdrawn Procedure

Withdrawn Sub-Procedure

Procedure Versions
When procedures are defined, they are given a two-digit version number, in the format:

<MajorVersion#>.<MinorVersion#>
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For example, 1.0, 1.1, 1.2, 2.0, and so on.

There can be multiple versions on your system at any one time. This allows administrators 
to test a modified procedure while still running the previous version in a live environment.

By default, the Version column is displayed in the procedure list, although your system 
may not show it. For information about customizing the columns in the procedure list, see 
Customizing Columns in a List.

Version History
You can view a procedure’s version history in one of the following two ways:

— Right-click on a procedure in the procedure list to open a context menu, then 
select Versions from the context menu. This allows you to view version history 
without opening a list of cases for the procedure.

or

— Click on the desired procedure in the procedure list; this displays the case list. 

Then either click on the  icon, or select Versions from the Tools menu on 
the procedure list.

A window similar to the following is displayed:
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The section on the top of this window identifies all current and past versions of the 
selected procedure. 

Clicking on one of the versions in the top section causes history information about that 
version to be displayed in the section on the bottom of the window. 

Close the Versions window by clicking on the Close button.

Sub-Procedures
Sub-procedures provide the ability for a case of one procedure to start a case of another 
procedure as one of its steps. 

When a sub-procedure is started, flow is halted along that particular path of the calling 
procedure until the sub-case has completed. When the sub-case completes, flow will 
resume in the main procedure.

When a procedure is defined, it is defined as either a “main procedure” or a “sub-
procedure”. You can directly start a main procedure from the procedure list. Sub-
procedures cannot be directly started; they can only be started by a step in another 
procedure.
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Sub-procedures can be many levels deep, i.e., a sub-procedure can also contain a sub-
procedure call step, and the sub-procedure started by that call step can contain another 
sub-procedure call step, and so on.

When a sub-procedure is started from another procedure, the system looks at the sub-case 
precedence setting to determine which status of the sub-procedure it should start. The 
default is to always start the released status of the sub-procedure, although you can 
specify that it look for other statuses of the sub-procedure to start. For instance, you may 
specify that the system look for a model status of the sub-procedure first, and if it doesn’t 
find one then to look for a released status. For information about setting the sub-case 
precedence, see Sub-Case Version Options.

You can also view the case history for the sub-case by viewing the case history for a main 
case, which shows you when sub-cases are started and completed, as well as the actions 
that are performed within the sub-case. For more information, see Case History.

Also see Displaying Main and/or Sub-Procedures for information about choosing whether or 
not sub-procedures are displayed in the procedure list.
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Starting a Case
This section describes how to start a case of one of the procedures in the procedure list.

Starting a Case of a Procedure
Starting a case of a procedure begins with selecting the procedure you would like to start.

Display the procedure list to view the list of procedures to which you have access:

Notice that the Permission column in the procedure list tells you which of the procedures 
you have permission to start (it also shows if you have “History” permission for the 
procedure). This is specified when the procedure is defined. (For more information, see 
Procedure Permissions.)

Also notice that the sub-procedure shown in the list above (DYN1) does not indicate start 
permission; that’s because sub-procedures cannot be directly started; they must be started 
by a sub-procedure call step in another procedure.

Note: It is common for cases to be started programmatically. Therefore, 
depending on how your system was designed, this may not    be a function you 
will perform.
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You can start a case in one of the following two ways:

— Right-click on a procedure in the procedure list to open a context menu, then 
select Start New Case from the context menu. This allows you to start a case 
without opening a list of cases for the procedure.

or

— Click on the desired procedure in the procedure list; this displays the case list. 

Then either click on the  icon, or select Start New Case from the Tools 
menu on the procedure list.

The following window is displayed:

Enter a case description, then click OK.

The case description may or may not be required, depending on how the 
procedure was defined. If it’s required, “*Required” is displayed in 
this window (as in this example).

Depending on how your procedure was defined, a form may be displayed at 
this time, or starting the case may result in some other action that is 
not apparent to you.

If a form is displayed, see Processing Work Items for information about working with forms.
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Working With Cases
This section describes working with cases of a procedure.

Case Lists
A case list presents all of the cases that have been started for a particular procedure.

To view a case list, select (single click) a procedure in the procedure list:

When you select a procedure, one of two screens is displayed:

• The case list (as in the example above)

• A filter dialog for the case list 

The window that is displayed depends on how your system has been set up. By default, the 
case list is displayed. However, there is a user options setting that allows you to specify 
that if the number of cases for the procedure exceeds a specified threshold, to 
automatically display the filter dialog first. This allows you to enter a filter expression to 
pare down the list before displaying it. 
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Note: From a performance standpoint, it’s important that you understand that 
when a case list is displayed, the information    about all of the cases in the list is 
downloaded from the iProcess Engine. There can potentially be thousands of 
cases for a particular procedure; if you download     all of them, it could take a 
long time. That is why if the number of cases exceeds the specified threshold 
number, the system is suggesting you filter the     cases prior to listing them (they 
are not actually downloaded from the iProcess Engine until you display the case 
list).                         

Also note that there is a configuration parameter that can be set by the system 
administrator that specifies the maximum number of cases to download at one 
time.      For more information, see Limiting the Number of Cases Displayed. 
 

For information about specifying whether or not to display the filter dialog first, see Filter 
Options.

For information about using the filter dialog to filter the case list, see Filtering a Case List.

If the case list is displayed, and the Filter icon on the case list toolbar has a green check 
mark next to it, the list is currently being filtered — the last filter expression applied to the 
case list is in effect. For more information, see Filtering a Case List.

Also, if the Sort icon on the case list toolbar has a green check mark next to it, the list is 
currently being sorted — the last sort criteria applied to the case list is in effect. For more 
information, see Sorting a Case List.

Information about each case is provided in the columns of the case list. The specific 
information that is displayed on your system will depend on how your system was set up 
— see Customizing Columns in a List.

 

Selecting Cases in a Case List
The effect of selecting a case from the case list (i.e., single-clicking an item, or moving the 
highlight bar with the keyboard arrow keys) depends on whether or not the preview feature 
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is turned on:

• If preview is turned off, selecting a case from the case list has no effect.

• If preview is turned on, selecting a case from the case list causes the case summary 
to be displayed in the Preview Pane section, as follows:

The case summary provides more information about the case than what may be 
available from the columns in the case list.

Note: Double-clicking on a case in the case list constitutes opening the case. 
Opening the case causes the case details for    that case to be displayed. For 
information about opening cases, see Opening Cases. 

The preview feature can be turned on and off clicking the  icon on the toolbar, or by 
selecting Preview from the case list View menu.
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The following drop-down menu is displayed:

You can turn preview on by selecting either of the first two selections — the difference 
between the two is where the case details will be displayed when you open (double-click) 
the case in the case list. 

You can turn off the preview feature by selecting the Preview Off selection.

For additional information about selecting items in general from lists, see Selecting Items 
in a List.

Case List Columns
By default, certain columns are displayed in a case list. You can easily customize the 
columns that are displayed by either using the Column Selector, or by changing them 
manually. For information, see Customizing Columns in a List.

The following table describes the columns of information that can be displayed on the case 
list:

 

Column
Name

Meaning

Description The case description that was entered when the case was started. See 
Starting a Case of a Procedure.

Host 
Computer

The name of the computer containing the TIBCO iProcess Engine to which 
the iProcess Workspace (Browser) is connected.

Host Node The name of the TIBCO iProcess Engine to which the iProcess Workspace 
(Browser) is connected.
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Column
Name

Meaning

Number A unique number used to identify the case. This is generated when the case 
is started.

Open / Open 
Image

True - The case is currently open (active).

False - The case is closed.

Procedure 
Description

A description of the procedure that was given when the procedure was 
defined.

Procedure 
Name

The name of the procedure that was started to create the case (a case is an 
instance of a procedure).

Reference This is a case reference number that is built from the procedure number and 
case number; it uniquely identifies the case on the host node. For example, 
case reference number 4-1290 — the procedure number is 4 and the case 
number is 1290.

Started By The name of the user who started the case.

Started 
Date/Time

The date and time the case was started.

Status An icon that identifies the current status of the case. For information, see 
Case Status.

Suspended / 
Suspended 
Image

True - The case is currently suspended.

False - The case is not suspended.

For information, see Case Suspensions.

Terminated 
Date/Time

The date and time the case was terminated (i.e., closed). 

Version The version of the procedure that the case is an instance of.
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Number of Cases in a Case List
There is an indicator in the header bar of the case list to tell you how many cases are in 
the list. This number is displayed to the right of the Find button. In this example, there are 
26 cases.

Note that this number may indicate the number of cases in the list after it has been filtered 
using the filter dialog — if the list has been filtered in this way, there will be a green check 
mark next to the Filter icon (for information about using the filter dialog to filter cases, see 
Filtering a Case List).

If this number is displayed in the format “##/##” it means the list is being filtered using the 
Find button. In the example below, 10 of the 26 possible cases are listed.

For information about using the Find button, see Finding Items in a List.

Limiting the Number of Cases Displayed

By default, when a case list is displayed, all available cases for the selected procedure are 
downloaded from the server. If there is a very large number of cases for the selected 
procedure, the list may be slow in displaying.

For this reason, there is a configuration parameter that can be set by the system 
administrator that limits the number of cases that are downloaded. If this parameter is set, 
and you select a procedure that contains a number of cases that exceeds the maximum 
specified, only the specified number are displayed. If this occurs, a message is shown on 
the bottom of the case list that tells you how many were downloaded, as well as the 
number of cases that were not downloaded because they exceeded the maximum number. 
For example:
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If the configuration parameter is not set, or if it is set and the number of cases does not 
exceed the maximum, the message on the bottom of the case list is not displayed.

Finding Cases in the Case List
The case list contains a Find button that can be used to quickly find the case you are 
looking for.

For general information about using the find function, see Finding Items in a List.

When using the find function on case lists, it is often used in conjunction with the filter 
function (for information about the filter function, see Filtering a Case List). When used on 
the case list, the intent is for the find function to refine the search that has already been 
done using the filter function. Typically, the filter function is used to present a list of cases 
that are of continual interest. You can then use the find function to further refine the 
search through the list of filtered cases. When you are done with the find function, and 
close it, the list returns to the list presented by the filter function. If you want a different 
list of cases that are of continual interest, the list should be filtered using the filter 
function.

Note that the Filter, Sort, and Refresh icons and menu selections are disabled while the 
find function is being used — you must close the find function to change filter or sort 
criteria, or to refresh the list.

Refreshing a Case List
When a list of cases is initially displayed, it is a snap shot of the cases at that point in time. 
You can refresh the list to get the most recent list of cases from the iProcess Engine by:

• selecting Refresh Cases from the Tools menu, or 
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• by clicking the  icon.

Be aware that every time you refresh a list, it causes the entire list to be downloaded from 
the iProcess Engine. For information about the impact of this, see the note on Case Lists. 

Note that if you have defined filter and/or sort criteria for the case list, they will be applied 
on the refreshed list of cases — the case list is displayed if the number of cases does not 
exceed the specified number; the filter dialog is displayed if the number of cases exceeds 
the specified number. (For more information, see Filtering a Case List.)

Case Status
By default, the first column in the case list displays icons that indicate the case’s status. 
The following table shows the possible icons and their meanings:

Icon Case Status

The case is active.

The case is suspended.

The case is closed.

The case has been purged. If the case list is refreshed, the purged case will no 
longer appear in the list.

Filtering a Case List
“Filtering” a list of cases involves entering filter criteria so that only some of the cases are 
shown in the list, rather than all of them. Filtering a list of cases allows you to display only 
the cases you are interested in. For example, you may only be interested in cases that were 
started earlier than a certain date. You can filter the list so only those cases are shown.

The filtering function allows you to build a “filter expression” that is applied to all cases for 
the procedure that was selected. If the case satisfies the filter expression (e.g., the start 
date is earlier than a specified date), it is shown in the case list; if it does not satisfy the 
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filter expression (e.g., the start date is later than a specified date), it is not shown in the list 
(and is not downloaded from the iProcess Engine).

You can filter the case list at any time by:

• clicking on the  icon, or 

• by selecting Filter... from the View menu on the case list. 

This displays the filter dialog, on which you can specify a filter expression. This is explained 
in the following subsections.

The filter dialog may also be automatically displayed when you attempt to display a list of 
cases by selecting a procedure from the procedure list. This occurs if the number of cases 
of the procedure exceeds a threshold that you’ve specified in your user options (see Case 
Filters).

If the number of cases exceeds the number specified in your user options, the filter dialog 
is displayed:

Note: If you had applied a filter expression the last time you viewed the case 
list, that same filter expression will be applied when you open the list again — in 
other    words, the most recently applied filter expression will remain in effect until 
you remove it or change it.         If a filter expression is still active, the Filter icon will 
be shown with a green check mark (as shown below), and if the filter dialog      is 
displayed, the previously entered filter expression will be shown in the 
Expression section.                         

  

Filter expressions for a particular list are saved either locally or on the server, 
depending on a configuration setting made by      the system administrator:         

— If saved locally, and you log into a different machine, the filter you 
defined for a particular list will not be in effect on that new machine 
— filters defined on a specific machine will apply only to that 
individual machine.

— If saved on the server, and you log into a different machine (and 
connect to the same server), the filters   you defined will be in effect on 
the new machine. 
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Notice the “1655 items will be returned” message in the upper left part of the filter 
dialog. This is the number of cases that will be displayed if you click on the OK button to 
display the case list. If this is a large number, you should enter a filter expression so that a 
smaller list is displayed, making it easier to find the cases you want to work on.

The message on the top right of the filter dialog tells you the maximum number of cases 
that will be downloaded without displaying the filter dialog — in this example, it’s 500. For 
information about specifying this number, see Case Filters).

Building a Filter Expression
The filter dialog allows you to build a “filter expression” that is used to evaluate each case 
to determine if it should be included in the list.

The following summarizes building a filter expression:

• Choose a field to filter on. A “field” in this context is not necessarily a field that 
appears on a form in a work item — although it can be. These also include “system 
fields,” which contain information about the case that is stored in the system, such 
as the date/time the case was started, the user who started the case, etc. 

• Choose an operator that will be used in your filter expression, e.g.,’=’ (equals), ’<’ 
(less than), ’>’ (greater than), etc.
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• Enter the value to be compared against the value in the field you chose. (The value 
entered in the Value field must match the data type for the field selected. For 
information about the valid data types, see Value Data Types.)

For example, to list only cases that were started after July 15, 2005:

— Field: Started Date

— Operator: >

— Value: 15/07/2005

You can choose multiple fields to filter on.

At any time while building the filter expression, you can “apply” the expression by clicking 
on the Apply button. The “##### items will be returned” message is updated to inform 
you of the number of cases that satisfy the filter expression you’ve built. This is the number 
of cases that will be listed when you click on the OK button.

You can also click the OK button at any time without first clicking the Apply button — this 
causes any filter expression(s) you’ve entered to be applied and the list displayed. But you 
will not know the number of cases that will be returned in the list until after the list is 
displayed — clicking Apply first allows you to know how many will be returned before the 
list is displayed.

Also note that you can use the Close button to close the filter dialog without applying the 
filter expression (assuming you have not yet clicked Apply). Any expression you’ve entered 
will remain on the filter dialog, so that if you return to the filter dialog again prior to 
closing the case list, the expression you had entered will still be available.

You can clear/remove the currently displayed filter expression at any time by clicking on 
one of the ”eraser” icons on the right side of the filter dialog.

Each of the steps required to build the filter expression is described in more detail in the 
following subsections.

Choosing a Field to Filter On

To choose a field to filter on:

1. Click the arrow on the right side of the Field column. The following drop-down list is 
displayed:         
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This drop-down list provides a comprehensive list of the fields you can filter on. It 
consists of:

• System Fields - These fields contain information that is provided by the 
system, e.g., the date and      time the case was started, the case number, etc.

A comprehensive list of available system fields is provided in System Fields 
Available for Filtering Cases.

• Case Data Fields - These are fields that      are defined by the designer of the 
procedure and that are placed on forms in the procedure. For example, there 
may be a “Last Name” field defined in the       procedure. You can filter the cases 
so that only cases that contain a “Last Name” field with a value of “Smith” 
are displayed. (The example above       contains some CDQP fields — ADDRESS, 
APPDATE, COUNTY, etc.)

Note that case data fields contain “case data” (as opposed to “work item 
data”). (“Work item data” is the data associated with a work item while      it’s in 
a work queue — if you enter information in a form, then “keep” the work 
item, work item data includes those changes. “Case data” is the information 
that       is written to the database after you’ve “released” the work item — if you 
enter information in a form, then “keep” the work item, case data does not       
include those changes.) For more information about these types of data, see 
Case Data Fields.

2. Select the desired field from the drop-down list. The field name may or may not 
immediately appear in the Expression window on the bottom of the filter dialog, 
depending on the data type of the field, as follows:
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— If you select a Text field, the field name immediately appears in the Expression 
window.

— If you select a Numeric, Date, Time, or DateTime field, the field name does not 
immediately appear in the Expression window. For these types of fields, the 
system wants to validate the data you enter before allowing you to apply the 
expression. Therefore, it does not display the expression in the Expression 
window until you have entered a complete valid expression. (For Text fields, any 
value constitutes a valid expression.)

For information about the data type for each system field, see System Fields 
Available for Filtering Cases.

Choosing an Operator for the Filter Expression

The Oper. field allows you to select an operator for the filter expression. Click on the arrow 
on the right side of the Oper. field. The following drop-down list is displayed:

Select the appropriate operator from the list (you can also type in the operator). The 
selections are:

Operator Description

? Equal to (regular expression equality operator)1

< Less than

1Using this operator allows you to enter “regular expression” syntax to perform more complex 
string search functions. As regular expressions are beyond the scope of this document, see an 
outside source for information about valid regular expression syntax.
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Operator Description

<= Less than or equal to

< > Not equal to

= Equal to

> Greater than

>= Greater than or equal to

Specifying a Value for the Filter Expression

Enter the value in the Value field that you would like compared to the value in the field 
you selected in the Field field.

For example, to list all cases that were started on Oct. 20, 2005:

Note: When the iProcess Workspace (Browser) sends a Date field value to the 
iProcess Engine for    filtering, it must be enclosed in exclamation characters (e.g., 
!12/12/2005!), and Time field values be enclosed in ‘#’ characters (e.g., #12:00#). 
Therefore,     once you’ve entered a valid date or time in the Value field for those 
field types, the value shown in the Expression window is automatically     enclosed 
in the applicable characters. For example:                         

 

DateTime field values are sent to the iProcess Engine enclosed in quotes (e.g., 
“12/12/2005 10:30”). 
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Value Data Types

The value entered in the Value field must match the data type for the field selected. (For 
information about the valid data types for each of the system fields, see the list of system 
fields on System Fields Available for Filtering Cases.)

The following are the types of data that can be entered in the Value field:

Data Type Description

Numeric Consists of one or more of the numbers 0-9. Used for things like the case 
number.

Text Consists of any number of letters, numbers, or special characters (e.g., #, $, 
etc.). Used for things like the case description and the starter of the case.

Date The default date format1 is “dd/mm/yyyy”.

Example: 25/12/2005

Time The default time formata is “hh:mm”, using a 24-hour clock.

Example: 18:30

DateTime The default date/time formata is “dd/mm/yyyy hh:mm”.

Example: 25/12/2005 18:30

The date and/or time format that is currently specified on your TIBCO iProcess Engine is 
shown on the filter dialog when you select a date or time field in the Field drop-down list. 
For example:

1The order of the day, month, and year, as well as the date and time separator characters are 
specified on the TIBCO iProcess Engine. These may be different on your system, depending on 
how it was set up.



TIBCO iProcess® Workspace (Browser) User Guide

157 | Working With Cases

The iProcess Workspace (Browser) also provides information about the format required for 
other types of fields selected from the Field drop-down list. In the following example, the 
application is telling you that you must enter either an “A” (to list active cases) or “C” (to 
list closed cases):

Using Wild Cards in the Filter Value

You can use the following “wild card” characters in the value you enter in the Value field:

Wild Card Character Description

* The asterisk matches zero or more of any character.

? The question mark matches any single character.

Wild card characters may be substituted for one or more characters in your filter value. For 
example:

• To list the cases with a case description that begins with the letters “Ca”:

• To list the cases with a case number from 2250 through 2259:

Filtering on Empty Fields

The special SW_NA value can be used in filter expressions to list cases that contain a field 
that is empty (the “NA” means “not assigned”). 
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Note, however, this value must be typed into the Expression section (free-form area — for 
information about building free-form expressions, see Building a Free-Form Filter 
Expression). If it is typed into the Value field, the system will enclose it in quotes in the 
expression — you don’t want quotes around it.

For example, to list the cases containing an Occupation field in which a value has not been 
entered, type in this expression:

Conversely, to list the cases containing an Occupation field in which a value HAS been 
entered, type in this expression (using the “not equal” operator):

Ranges of Values

Ranges of values can be specified, although it requires you to enter special syntax in the 
Expression section. A range of values must be in the following form:

FilterField=[Val1-Val2|Val3|Val4-Val5|...]

This allows you to specify one or more ranges, each separated by a vertical bar character 
(|), all enclosed in square brackets ([ ]). You can also include individual values in the 
expression (as shown with Val3). 

For example, the following expression will return all cases that have a case number 
between 1700 and 1800, as well as the case with a case number of 1850:

You can enter the entire expression free-form in the Expression section, if desired. Or, you 
can select the field and operator from the Field and Oper. field drop-down lists. You may 
or may not be able to enter the entire value in the Value field, depending on the filter field 
chosen. If required, modify the expression in the Expression section so that it is in the 
form shown above.

If dates and/or times are used in a range of values, they must be specified in the following 
format:
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Dates/Times Format Required

Date1 !dd/mm/yyyy!

Time #mm:hh#

DateTimea “dd/mm/yyyy  mm:hh”

For example, the following expression will return all cases that were started between the 
dates of Jan. 01, 2006 and Jan. 31, 2006 (inclusive):

And the following expression will return all cases that were terminated between the times 
of 9am and 11am, as well as between the times of 3pm and 3:30pm (all inclusive):

Applying the Filter Expression
To apply the filter expression shown in the Expression window, you can:

• Click the OK button. This causes any filter expression(s) you’ve entered to be applied 
and the list displayed. But you will not know the number of cases that will be 
returned in the list until after the list is displayed.

• Click the Apply button. The system will apply the filter expression and calculate how 
many cases satisfy the expression. This number is shown on both the top and the 
bottom of the filter dialog (150 in this example):

1The order of the day, month, and year can be modified by the system administrator. The correct 
order is shown on the filter dialog if you select a date field in the Field drop-down list.
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If you clicked Apply, and the number of cases that will be returned from the iProcess 
Engine is satisfactory, click the OK button to display the case list (for information about the 
case list, see Case Lists).

If the number of cases is still too large, you can modify the filter expression by changing 
any of the selections in the Field, Oper., or Value fields, then click Apply again to get a 
new case count. 

Anytime you add, delete, or modify a filter expression on the filter dialog, and have not yet 
clicked the Apply button to apply it, the following message is shown to notify you that the 
changed filter expression has not been applied:

Whenever the message shown above is displayed, the Apply button will be active.

You can also click one of the “eraser” icons to delete filter expressions. Clicking the one to 
the right of the filter fields clears that row of fields; clicking the one to the right of the 
Expression window clears all filter expressions entered so far.

Note that if you apply the filter expression, then view the case list, the Filter icon will now 
contain a green check mark to indicate that a filter has been applied on the list:
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Specifying Multiple-Clause Filter Expressions
You can use logical operators to combine multiple “clauses” in your filter expressions. 

A “clause” is a field/operator/value set. The expression:

SW_STARTEDDATE < !20/10/2005! AND SW_STATUS = ”A” 

contains two clauses, separated by the AND operator. The following are the logical 
operators that can be used to separate clauses:

Operator Description

AND The expression is true if the first clause and the second clause are true.

OR The expression is true if the first clause or the second clause is true.

Logical ANDs and ORs are entered into a filter expression using the AND/OR field. Click the 
arrow to display the drop-down list and select either AND or OR. When you select an AND 
or OR, another set of fields is displayed, in which you can specify the clause that will be 
‘AND’ed or ’OR’ed to the preceding clause.

Example 1

This example will return all cases that were started on or before 20/10/2005, and that are 
currently active (i.e., they have a status of “A”):

In this example, both clauses must be true for a case to be returned in the list.
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Example 2

This example will return all cases that were started by either user “susieq” or “bobr” (note 
that when using the “Started By” field, the user name must be followed by “@node”, 
where node is the name of the server on which that user is defined):

In this example, either one of the clauses can be true for the case to be returned in the list.

Specifying More Than Two Clauses

If you specify more than two clauses, they are always evaluated in pairs from left to right. 
Consider the following:

In this example, the entire filter expression created is this:

SW_STARTER = "susieq@server1" OR SW_STARTER = "bobr@server1" AND SW_
STATUS = "C"

The system will evaluate this expression as if there are parentheses around the first two 
clauses in the expression. For example:

(SW_STARTER = "susieq@server1" OR SW_STARTER = "bobr@server1") AND SW_
STATUS = "C"

As you continue to add clauses to the expression, the system continues to evaluate from 
left to right. For example, if you added a fourth clause to the expression above, it would 
include the following implied parentheses:

((SW_STARTER = "susieq@server1" OR SW_STARTER = "bobr@server1") AND SW_
STATUS = "C") AND SW_PRONAME = "LOAN"
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Building a Free-Form Filter Expression
After specifying filter criteria in the Field, Oper., and Value fields, the filter expression 
appears in the Expression window:

The expression that appears in the Expression window is what is actually sent to the 
iProcess Engine. You are free to edit this text in any way desired. Note, however, that the 
results may not be what you expect if the expression is not in the format required by the 
iProcess Engine. For example, dates must be enclosed in exclamation characters 
(!07/05/2010!), times must be enclosed in the ’#’ character (#18:30#). These special 
characters are automatically added for you when you use the Field, Oper., and Value fields 
to build the expression.

You can also add parentheses to the expression in the Expression window to create more 
complex filter expressions.

The system field names that appear in the Expression window (e.g., SW_STARTEDDATE) 
are listed in the table of system fields on System Fields Available for Filtering Cases.
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Saving Favorite Filter Expressions
The “favorites” feature allows you to save your favorite (i.e., commonly used) filter 
expressions. This allows you to quickly select an expression by name, rather than requiring 
you to enter each element of the expression.

To use the favorites feature, click on the Favorites button on the filter dialog:

The following dialog is displayed:

In this example, there have already been two favorites saved: “For Audit” and “New year 
cases”.

To use one of the saved favorites:
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1. Select the desired favorite in the Saved Favorites section.

2. Click the Load button.

The filter expression associated with that name is automatically entered into the 
Expression section on the filter dialog and is automatically applied to the case list 
— the “### items will be returned” text displayed on the filter dialog indicates how 
many cases satisfied the filter expression.

Saving a New Favorite Filter Expression

To save a new favorite filter expression:

3. Build the filter expression you would like to save using the filter dialog. See Building 
a Filter Expression.

4. Click on the Favorites button on the filter dialog. The Favorites Manager dialog is 
displayed.

5. In the field on the bottom of the Favorites Manager dialog, enter the name you 
would like to give the filter expression you are saving in the favorites (the entry in 
this field defaults to the current date and time).

6. Click Save to save the new favorite. 

System Fields Available for Filtering Cases
The following table lists the system fields that can be included in expressions when filtering 
cases. 

The Description column in the table corresponds to the text in the Field field drop-down 
list. The actual system field name (e.g., SW_CASEDESC) is automatically entered in the filter 
expression in the Expression window when you choose the system field description from 
the Field field.
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Description System Field Name Data Type Comments

Case Description SW_CASEDESC Text

Case Number SW_CASENUM Numeric

Case Status SW_STATUS Text “A” = Active
“C” = Closed

Procedure Description SW_PRODESC Text

Procedure Name SW_PRONAME Text

Started By SW_STARTER Text username@node

Started Date SW_STARTEDDATE Date

Started Date/Time SW_STARTED DateTime

Started Time SW_STARTEDTIME Time

Terminated Date SW_TERMINATEDDATE Date

Terminated Date/Time SW_TERMINATED DateTime

Terminated Time SW_TERMINATEDTIME Time

Note: For information about data types used in system fields,    see Value Data 
Types.

Sorting a Case List
The iProcess Workspace (Browser) allows you to sort the information in the columns of the 
case list so they are in the order you would like them listed.

For example, you may want to list all cases started by user “susieq” first, then sort those by 
case-started date/time, from oldest to most recent. This example would require you to sort 
on two fields: “Started By” and “Started Date/Time”.
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To specify how cases in the case list are sorted:

• click on the  icon, or 

• select Sort... from the case list View menu.

The following dialog is displayed.

The list on the left shows all of the fields that are available to sort on. To sort the 
case list, you must move the desired fields from the list on the left to the list on the 
right, then arrange them in the desired priority (order). This is described in the 
following subsections.

By default, all case lists are sorted by case number, in ascending order.
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Note: If you had applied sort criteria the last time you viewed the case list, that 
same sort criteria will be applied    when you open the list again — in other words, 
the most recently applied sort criteria will remain in effect until you remove it or 
change it.         

If previously applied sort criteria is still active when the work item list is 
displayed, a green check mark will be shown with the Sort icon.

  

Sort criteria for a particular list is saved either locally or on the server, 
depending on a configuration setting made by the system      administrator:         

— If saved locally, and you log into a different machine, the sort you 
defined for a particular list will not be       in effect on that new machine 
— sort criteria defined on a specific machine will apply only to that 
individual machine. 

— If saved on the server, and you log into a different machine (and 
connect to the same server), the sort       criteria you defined will be in 
effect on the new machine.

Selecting Sort Fields
The Available Fields list on the sort dialog provides a list of the fields you can sort on. It 
consists of:

• System Fields - These fields contain information that is provided by the system, 
e.g., the date and time the case was started, the case number, etc.

A comprehensive list of available system fields is provided in System Fields Available 
for Sorting Cases.

• Case Data Fields - These are fields that are defined by the designer of the 
procedure and that are placed on forms in the procedure. 

For example, there may be a “Last Name” field defined in the procedure. You can 
sort the cases so that they are listed alphabetically according to the text in the “Last 
Name” field.

Note that case data fields contain “case data” (as opposed to “work item data”). 
(“Work item data” is the data associated with a work item while it’s in a work queue 
— if you enter information in a form, then “keep” the work item, work item data 
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includes those changes. “Case data” is the information that is written to the 
database after you’ve “released” the work item — if you enter information in a form, 
then “keep” the work item, case data does not include those changes.) For more 
information about these types of data, see Case Data Fields.

To specify sort fields:

1. Select the desired sort fields from the Available Fields list:

— Individual fields can be selected by clicking on the desired name. 

— Multiple fields can be selected by holding down the Ctrl key while clicking on the 
desired names. A group of fields can be selected by clicking on one name, then 
holding down the Shift key and clicking on the last name in the desired group.

2. Move the columns to the desired list:

— Fields can be moved back and forth between lists by selecting the desired field
(s), then clicking the “>”    or “<“ buttons.         

— You can also move an individual field to the other list by double-clicking on the 
field name.

— All fields can be moved from the Sort Fields list to the Available Fields list by 
clicking on the “<<“ button.

Note: You can specify a maximum of 5 sort fields for a case list.

 

Specifying Sort Priority
The order in which the sort fields are listed in the Sort Fields window specifies the priority 
of the sort. If you have multiple sort fields listed, all cases will first be sorted by the first 
sort field, then they will be sorted by the next sort field, and so on. For example, if you 
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specified “Case Status” as the first sort field, then “Started Date/Time” as the second sort 
field (both ascending), the cases would be sorted in the following fashion: 

Active Jan. 1, 2006

Active Jan. 2, 2006

Active Jan. 3, 2006

Closed Jan. 1, 2006

Closed Jan. 2, 2006

Closed Jan. 3, 2006

In the example shown above, all active cases will be listed first, followed by the closed 
cases. Within each group of active and closed cases, they are sorted by the date and time 
they were started.

To change the priority, select the desired sort field(s) in the Sort Fields window, then click 
on the “+” or “-” button to move the field(s) up or down in the list.

Specifying a Sort Direction
The list of cases can be sorted in either ascending or descending order:

When a sort field is added to the Sort Fields list, it is ascending by default, which is 
denoted by the up arrow next to the field name:
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To change the sort direction, select the desired sort field in the Sort Fields list, then click 
on the up or down arrow buttons on the sort dialog:

The arrow next to the field name will change to indicate the new sort direction:

System Fields Available for Sorting Cases
The following table lists the system fields available for sorting cases:

Sort Field Data Type

Case Description Text

Case Number Numeric

Case Status
(“A” = Active;
“C” = Closed)

Text

Started Bya Text

Started Date/Time DateTime

Terminated Date/Time DateTime

a. Sorting by Started By is inherently inefficient — sorting by this field may slow down the sorting process.

Note that the way in which the system sorts the values in the sort fields depends on the 
type of data in that field. 
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For instance, since the “Case Description” field is text data, that field is sorted 
alphabetically; and since the “Started Date/Time” field is a DateTime data type, it is sorted 
chronologically according to the date/time.

Sort As Different Data Type

The way in which the system sorts the values in the sort fields depends on the type of data 
in that field (e.g., text data is sorted alphabetically, numeric data is sorted numerically, 
etc.).

You can, however, tell the application to sort the data in a field using a data type that is 
different than the field’s data type. For instance, you can tell it to sort the data in the Case 
Description system field (which is a text field) as numeric data.

To sort a field as a different data type, select the desired sort field in the Sort Fields list, 
then click on the desired data type in the Sort As field:

The value of the sort field will be converted to the specified data type before doing the 
sorting. Note, however, that if the sort field does not contain something readily convertible 
to the specified type, the sort results may not be what you expect. For example, if sorting 
text as a numeric field but some of the text fields contain non-numeric data, the results 
may not be what you expected.

Applying the Sort Criteria
After specifying the sort fields, priority, direction, etc., click on the OK button to apply the 
sort criteria you’ve specified. 

Anytime you modify a sort criteria, and have not yet clicked the OK button to apply it, the 
following message is shown to notify you that the changed sort criteria has not been 
applied:
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Whenever the message shown above is displayed, the OK button will be active.

When you click the OK button, a red check mark appears on the Sort icon to indicate sort 
criteria has been applied.

Sorting the Case List Using Column Headers
You can quickly and easily sort the case list on any one of the columns in the list. To sort 
on a column, click on the column header. If the column contains text, it is sorted in 
alphabetical order; if it is numeric, it is sorted in numerical order.

Once you click on a column header, a small arrow head appears in the column header, 
which indicates the order of the sort — if the arrow head is pointing up, the sort is in 
ascending order; if it’s pointing down, the sort is in descending order:

Each successive click on the column header, toggles between ascending and descending 
order.

Note that the ability to sort using column headers is controlled through user access 
privileges — if you do not have the authority to sort using column headers, the arrow head 
does not appear in the header when you click it.

Opening Cases
Opening a case causes the case details to be displayed. Case details are presented in a 
tabbed format that contains Summary, History, Outstanding, and Data tabs. As the 
names of the tabs imply, you can view a summary of the case, the case history details, 
information about the outstanding work items in the case, and view/modify the case data 
fields.

You can open cases either from the case list or the work item list, as follows:
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Opening Cases from the Case List
• Double-click on the desired case in the case list.

• Select one or more cases in the case list, then:

— press the Enter key,

— select Open Case(s) from the Tools menu on the case list,         

Note: You cannot open multiple cases from the case list if you are 
displaying the case details in the preview pane. If you are opening 
cases    in the Preview Pane, and you select multiple cases, the Open 
Case(s) function is disabled.

— right-click the mouse button on the desired case(s) and select Open Case(s) 
from the drop-down menu, or

— click on the  icon on the case list.

Open a Case from the Work Item List

Select the desired work item in the work item list, then:

— select Open Case from the Tools menu on the work item list,

— right-click the mouse button on the desired case and select Open Case from the 
drop-down menu, or

— click on the  icon on the work item list.

Case Details

All of these methods of opening cases cause the case details to be displayed:
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For information about using each of the tabs in the case details, see the following:

• Summary Tab - Case Summary

• History Tab - Case History

• Outstanding Tab - Outstanding Work Items in the Case

• Data Tab - Case Data Fields

Case Details Location

The location at which the case details are displayed depends on whether you are 
displaying them from the work item list or case list, as follows:

• When displayed from the work item list, case details are always displayed in a 
separate dialog.

• When displayed from the case list, the location of case details depends on whether 
or not the preview feature is turned on, as follows:

— If preview is turned off, the case details are always displayed in a separate 
dialog.

— If preview is turned on, the case may be opened either in the preview pane or a 
separate dialog, depending on the current preview setting. 

If the Preview On - Open Details in Preview Pane selection is checked, the 
case details are opened in the preview pane. (Note that the Preview Pane may 
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be set to automatically resize when the case detail are opened, then return to 
the previous size when the case details are closed. For information about how 
this done, see Case Preview Default .)

If the Preview On - Float Details selection is checked, the case details are 
opened in a separate dialog.

The preview setting can be viewed or set by either clicking the  icon on the 
case list toolbar, or by selecting Preview from the case list View menu. The 
following drop-down menu is displayed:

The check mark indicates the currently selected preview option.

Note: If you have chosen to display case details in a separate dialog, and there 
are multiple cases selected in the case list when you open them,    a separate 
dialog for each selected case is displayed.         

But if you have chosen to display the case details in the preview pane, you 
cannot open multiple cases at one time — if you select more than one case, the 
Open Case(s) function becomes disabled.

Case Summary
To view summary information about a case, open the case. The initial tab displayed is the 
Summary tab:
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This window displays demographic-type information about the case, such as who started 
it, the date and time it was started and/or terminated, etc.

Refreshing the Case Summary

The information displayed in the Summary tab is the information that was downloaded 
from the iProcess Engine when the case list was initially displayed (or the last time it was 

refreshed). You can refresh this information by either clicking on the  icon on the 
Summary tab or by selecting Refresh Case from the Tools menu on the Summary tab.

This refreshes the information for this single case.

Case History
Viewing case history allows you to see the case’s chronological progress through the 
procedure, that is, it shows you which steps (work items) have been processed and who 
processed them. This is sometimes referred to as the case “audit trail.”

To view the case history, open the case, then click on the History tab. A window similar to 
the following is displayed:
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In this example case history, you can see the date and time the case was started, and the 
user name of the person who started it. It also shows when each work item is sent to 
(“processed to”) a work queue, as well as when each work item is opened, kept, and 
released.

If a sub-case is started in the case, it is denoted by a + icon to the left of the line at which 
the sub-case is started. For example:

Click on the + icon to expand that line so that it shows the activities in the sub-case. 
Clicking on the + icon causes it to change to a - icon. To collapse the activity list for the 
sub-case, click on the - icon.

Entries that are displayed in blue indicate that that step is currently outstanding, this is, 
that’s where the process flow is currently sitting. Note that there may be multiple 
outstanding steps because the process flow may branch, resulting in more than one work 
item. Also, if there is an outstanding step in a sub-case, the sub-procedure call step is 
displayed in blue, as well as the step within the sub-case that is outstanding. For example:
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You can also specify whether or not the times in the case history show seconds and 
microseconds. This is controlled using Show seconds and microseconds check box on the 
History tab:

Clicking on this check box causes the case history list to refresh, toggling between 
displaying (when the box is checked) and not displaying seconds and microseconds. Note 
that changes made to the Show seconds and microseconds check box are saved either 
locally or on the server, depending on a configuration setting made by the system 
administrator:

— If saved locally, and you log into a different machine, the changes you made will 
not be in effect on that new machine — changes made on a specific machine will 
apply only to that individual machine. 

— If saved on the server, and you log into a different machine (and connect to the 
same server), the changes you made will be in effect on the new machine.

Viewing a Graphical Case History

The graphical case history feature allows you to view the actions that have taken place in a 
case in the form of a time-line chart, as in the example below:
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To view a graphical case history, open the desired case, click on the History tab, then 
either:

• click on the  icon on the History tab, or 

• select Graphical History from the View menu.

The graphical case history opens in a separate floating window that 
provides a graphical representation of the case using the following:

• Colored horizontal bars - (Note - This is the default display. You can customize the 
display if desired, e.g., the bars can be displayed with hatch patterns instead of 
colors, they can be displayed vertically instead of horizontally, etc. For more 
information, see Configuring the Graphical Case History Display.) The bars illustrate 
one of the following:

— The period of time a work item was in a user’s work queue.

— The period of time a case was suspended.
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— The period of time a case was being processed in a sub-case.

A legend is displayed on the bottom of the window that shows the meaning of each 
color (or hatch pattern).

• Milestone Markers - These markers/icons illustrate when entries of types other than 
those described above are recorded in the case history. The following shows some 
examples of milestone markers.

The possible milestone markers are:

Icon Description

Case start

Case termination

Deadline expired
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Icon Description

Process jump

Event triggered

Error message displayed

Case migrated to another version of procedure

User-defined entry to case history

All other milestones

Graphical Case History Details

Details about any entry in the case history can be viewed by placing the cursor over any 
bar or milestone marker. For example:

You can also view information about the duration of the case by placing the cursor over 
the paging bar on the bottom of the window, as follows:
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Display Features

The following describes features available on the graphical case history display:

• Time Scale - The time scale on the display will vary depending on the amount of 
time that has elapsed since the case was started. It can be seconds, minutes, hours, 
days, etc.

• Zooming - You can zoom in or out to obtain an optimal view of the case history by 
either clicking on the zoom buttons on the top of the display, or by selecting the 
zoom options on the View menu. There is also an indicator to the right of the zoom 
buttons that indicates how much you have zoomed in (2X, 4X, etc.).

• Paging - The paging buttons become active if you zoom in on the display. These 
allow you to move to earlier or later pages, which represent different time periods in 
the case history. The bar to the left of the paging buttons indicate the current page’s 
relative position in the case history.

Displaying Sub-Case Information

If the case contains a sub-case, you can “drill down” into the sub-case to view its case 
history.

The bar that represents the sub-case will contain a link that you can click on to display its 
case history. The case history details also indicate that it represents a sub-case, as shown 
below.
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After drilling down into a sub-case, a link is provided on the toolbar that allows you to 
navigate back to the parent case (or to other sub-cases if you’ve displayed other sub-cases 
to get to the current sub-case):

Configuring the Graphical Case History Display

You can configure/customize the display of the graphical case history by:

• clicking on the  icon on the graphical case history toolbar, or 

• by selecting Configure from the Tools menu.

This displays the Display Options dialog, which allows you to perform various 
customizations of the graphical case history display. Changes to the display will be 
effective only for the current graphical case history display unless you click in the Save 
these settings as the default check box on the bottom of the dialog.

Also note that you can save the size and position of the Graphical Case History dialog, 
making the current size/position the default by checking the Make this graph position 
and size the default check box.

The Display Options dialog allows you to perform the following customizations:

• Time Axis - The time axis can be oriented either horizontally or vertically, which 
subsequently also causes the bars to be displayed horizontally or vertically.
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• Expanded / Compressed Format - In expanded format, each bar and milestone 
marker, for each work queue or step, is displayed on its own row and are organized 
in chronological order.

In compressed format, an attempt is made to display all bars on one row, and all 
milestone markers on another row, for each work queue or step. Note, however, that 
if there are bars that will overlap because of branching that creates multiple work 
items, additional rows of bars will be added. Additional rows are not added for 
overlapping milestone markers — you can zoom in to spread them out on the 
display.

• Group by Work Queue or Step - This option allows you to group the bars and 
milestone markers either by work queue or step. When grouped by work queue, 
each bar represents a work item in that work queue. When grouped by step, each 
bar represents the work queue in which that step (work item) resides.

Note that some types of events may not have a work queue name or a step name 
associated with them. In these situations, the items without a name are grouped 
together in an unlabeled column. Some entries may also specify “System” as the 
work queue name if the entry is not related to a particular work queue. Also, some 
entries not related to a particular step may display information such as “Case Start”, 
“Termination”, etc., for the step name.

• EAI Steps - This option allows you to either display or hide bars related to EAI steps.

• Predicted Steps - This option allows you to either display or hide bars related to 
predicted steps, i.e., steps that are a result of performing the case prediction 
function.

• Step Labels - Steps (which represent work items) can be labeled with their name, 
description, or both.

• Bar Shading - This option allows you to specify that the bars be filled with either a 
color or a hatch pattern. A legend is displayed on the bottom of the graphical case 
history screen that shows the meaning of each color or hatch pattern, depending 
which option is selected.

Filtering Case History Entries

For some cases, the case history can become very lengthy. Filtering the case history entries 
allows you to more easily find those you are interested in.

You can filter case history entries from either the History tab, or from the graphical case 
history display. From either of these displays:
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• click on the  icon, or 

• select Filter from the View menu. 

The Case History Filter dialog is displayed:

This dialog allows you to pick and choose the types of criteria used to filter the case 
history. Only those case history entries that match ALL of the filter criteria specified are 
displayed in the case history. 

After selecting/entering the desired criteria, click on the OK button to apply it. The filtered 
case history entries are displayed, and the Filter icon will display with a green check mark 

( )to indicate the list is filtered.
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The applied filter criteria will persist for the current case history until you remove or 
modify it.

You can also cause the specified filter criteria to be applied to case histories displayed by 
checking the Set as default for all Case History lists check box, then clicking OK.

The following subsections describe details of filtering case history entries using the Case 
History Filter dialog.

Including/Excluding Selected Case History Types

A case history type is just a specific entry that is written to the case history. For instance, 
“Work item released” is a type of entry that is written to the case history every time a work 
item is released in the case.

You can choose to either include or exclude selected types of entries by selecting the 
desired types in the System Types and Custom Types sections, then choosing either the 
Include the selected types or Exclude the selected types radio buttons:

For example, if you select only the “Work item released” type, and Include the selected 
types is selected, only “Work item released” types are displayed in the case history. 
Conversely, if you select only the “Work item released” type, and Exclude the selected 
types is selected, all entry types except the “Work item released” type are displayed in the 
case history. (This assumes no other criteria are specified on the Case History Filter 
dialog.)

There are two groups of entry types you can select:

• System Types - This list provides check boxes for all types of activities that can be 
performed while operating the iProcess Workspace (Browser) application. For 
example, an entry is written to case history whenever a work item is sent to a work 
queue, an entry is written to case history whenever a sub-case is started, etc.

All available system types are listed in the System Types section:
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You can check or uncheck the individual type, as desired, by clicking in the 
appropriate check boxes, or you can check or uncheck all boxes by clicking in the 
Select or deselect all types check box. This allows you to choose which system 
types of entries to display in the case history.

All of the system types available are not described here as their descriptions in the 
System Types section are self explanatory. One notable exception is the “Work item 
sent to queue” system type that actually appears in the case history as “<Step> 
processed to <User>”. “Processed to” means a work item was sent to (i.e., 
“processed to”) a work queue. For more information about “processed to” entries, 
see Including Only “Processed to” Entry Types.

• Custom Types - This list provides check boxes all custom types. These are user-
defined case history entries that were added to the case history using the Add Entry 
function on the case History tab. 

The entry types shown in the Custom Types list are user-defined entries that are 
stored in the auditusr.mes file by a system administrator:

You can check or uncheck the individual types, as desired, by clicking in the 
appropriate check boxes, or you can check or uncheck all boxes by clicking in the 
Select or deselect all types check box. This allows you to choose which custom 
types of entries to display in the case history.
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For information about how custom (user-defined) entries are added to the case 
history, see Adding an Entry to Case History.

User Names (or Sub-Case IDs)

The User Names section allows you to specify that only case history entries containing the 
specified user name(s) or sub-case IDs be displayed. 

Note that only some entries actually contain a user name — for example, “Case started by 
<User>, <Step> released by <User>, etc. In these instances, the entry indicates who initiated 
the action. For some entries, the system initiates the action — for example, “<Step> 
processed to <User>”. In this instance, the entry indicates whose work queue the system 
sent the work item to.

User names must be entered in the following form:

username@servername

where:

— username is the user’s name, e.g., “susieq”.

— servername is the name of the server on which the user was logged in when the 
function that created the entry was performed. (Note - You can avoid having to 
enter the server name by using the “*” wild card, e.g., “susieq*”.)

Note that the User Names field can also be used to filter case history entries on sub-case 
IDs. Just enter a sub-case ID (also sometimes called a “sub-case number”) in the User 
Names field with or without wild cards.

You can specify multiple user names or sub-case IDs in the User Names section. If you 
specify more than one user name/ID, the case history will include entries that apply to any 
of the specified users/IDs. To specify multiple users/IDs, enter the first user name/ID in the 

available field in the User Names section, then click on the  icon to the right of the 
field. This causes another field to appear, in which you can specify another user/ID.
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After adding another user name/ID, a  icon appears next to each of the fields. These 
icons can be used to remove any of the specified names/IDs from the filter criteria.

You can add up to five user names or IDs in the User Names section.

Note: 
Wild card characters

The wild card characters, * and ?, can be used when specifying user names, sub-
cases IDs, step names, and step descriptions, as follows:

• ‘*’ matches zero or more of any character. For example:

— “bo*” matches anything beginning with “bo”. For example, “bo”, 
“bobbl”, “boulton_anne”, etc.

— “s*s” matches anything beginning with “s” and ending with “s”. For 
example, “ss”, “sues”, sid_lewis”, etc.

— “*s” matches anything ending with “s”. For example, “franks”, “ls”, 
“martha_lyons”, etc.

• ‘?’ matches any single character. For example:

— “bill?” matches anything beginning with “bill”, plus one more 
character. For example, “bills”, “bill5”, “billh”, etc.

— “c?ndy” matches “cindy”, “candy”, “c3ndy”, etc.

Also note that all character matching is case insensitive.

Step Names / Step Descriptions

The Step Names and Step Descriptions sections allow you to specify that only case 
history entries containing the specified step name(s) or description(s) be displayed. 
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When procedures are created, each step is given a name, and possibly an optional step 
description. If they were not given a step description, the step name is shown in the case 
history entries. If they were given a step description, the description is shown in the case 
history entries. In the following example, “Request for vehicle” was specified as the step 
description when the step was defined:

The Step Names and Step Descriptions sections can be used to filter the case history 
entries based on the step name or description. Use the appropriate field, depending on 
whether names or descriptions are shown in your case history.

Remember that each “step” in a procedure results in a “work item” in a live case. Most 
case history entries containing a step name/description are referencing an action that 
affects a step (work item), for example, “<Step> processed to <User>”, <Step> opened by 
<User>”, “<Step> released by <User>”, etc.

You can specify multiple step names/descriptions in the Step Names and Step 
Descriptions sections. If you specify more than one step name/description, the case 
history will include entries that apply to any of the specified names/descriptions. To specify 

multiple names/descriptions, enter the first one in the available field, then click on the  
to the right of the field. This causes another field to appear, in which you can specify 
another name/description.

After adding another name/description, a  icon appears next to each of the fields. These 
icons can be used to remove any of the specified names/descriptions from the filter 
criteria.
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You can add up to five step names/descriptions in the Step Names and Step Descriptions 
sections.

The wild card characters, * and ?, can be used when specifying step names/descriptions. 
For information, see Wild card characters.

Date Ranges

The Date Range section allows you to specify that only entries that fall within a range of 
dates be shown in the case history.

You can either type in the desired dates using the format shown in the fields (months are 
spelled out), or click on the calendar icons next to the fields to select the desired dates. 
The desired times can also be typed in, or use the arrow buttons to the right of the time 
fields (to use the arrow buttons, the cursor must be in the Hours, Minutes, or AM/PM field, 
as desired).

To remove a date and time from the fields, click on the eraser icon to the right of the 
fields.

If you leave the beginning date blank, it assumes the beginning of time. If you leave the 
ending date blank, it assumes the current date.

If you leave the beginning time blank, it defaults to 12:00 AM. If you leave the ending time 
blank, it defaults to 11:59 PM. (If you specify a time, you must also specify a date.)

Dates entered are inclusive, that is, case history entries that occur on that date are 
included in the case history (assuming they also meet the specified time criteria).

Always Including Sub-Case Started Entries

The Always include Sub-Case Started entries... check box is provided to allow you to 
specify that “Sub-Case started” entries always be included in the case history, regardless of 
the entry types you have selected. This can be beneficial because an entry you would like 
displayed may be inside a sub-case; if the “Sub-Case started” entry is not displayed, 
nothing inside that sub-case is displayed.



TIBCO iProcess® Workspace (Browser) User Guide

193 | Working With Cases

For example, let’s say you want all “work item released” entries to be displayed, and there 
are “work item released” entries in both the main case and in a sub-case. If you select only 
the “Work item released” system entry, the following may be displayed:

Whereas, if you select the “Work item released” system entry, and check the Always 
include Sub-Case Started entries... check box, the following is displayed:

All “Sub-Case started” entries are displayed so that you can expand them to see if the entry 
types you are interested in are in that sub-case.

Including Only “Processed to” Entry Types

The term “processed to” requires some explanation. When a work item is sent to a user’s 
work queue, the “<Step> processed to <User>” entry is written to the case history. For 
example:

This entry is displayed when the “Work item sent to queue” entry is selected in the System 
Types section on the Case History Filter dialog.

Note, however, there are other case history entries that are considered “processed to” 
entries. They are:

— “<Step> processed to <User>” [“Work item sent to queue” entry type]

— “<Step> forwarded to <User>” [“Work item forwarded” entry type]

— “<Step> redirected to <User>” [“Work item redirected” entry type]

— “<Step> resent to <User>” [“Work item resent to queue” entry type]

— “Sub-Case started from <Step>” [“Sub-case started” entry type]

The reason all of these entries are considered “processed to” entries is because they all 
result in a work item being sent to a user’s work queue.
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You can specify that only “processed to” entries be displayed in the case history by 
checking the Only include ‘Process to’ types of entries for outstanding steps check box. 
Only those entries listed above are displayed.

Adding an Entry to Case History

Entries can be manually added to a case history.

This requires that a file (auditusr.mes file) be set up on the system that contains pre-
defined messages that you can add to the case history — a system administrator will 
typically set up this file so you can choose a message from it. The following is a simple 
example of the contents of this file:

Each line in the file constitutes one user-added entry. The entry is identified by the three-
digit number to the left of the colon. The text to the right of the colon is the message that 
will be added to the case history, where %USER, %DESC, and %STEPNAME are replaced 
with text you enter when you manually add an entry to case history.

To add an entry to case history:

1. Either:

— click on the  icon on the History tab, or

— select Add Entry from the Tools menu (these buttons/menu selections can be 
found on both the “standard” case history display and the graphical case history 
display).

The following dialog is displayed:
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2. Select the desired message number / template from the list. This list is the contents 
of the auditusr.mes file described earlier in this section.         

Note: If your iProcess Engine does not support Add Case History 
“Templates”,    the Add History dialog will contain a Message Number field 
instead of the list of available message numbers. If your system does     not 
support templates, enter the the message number in the Message 
Number field.

3. In the Description field, enter the description text you want to appear in the 
message, if applicable; this text replaces the “%DESC” variable in the pre-defined 
message. This field can be left blank if it does not apply to the message you are 
adding.
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4. In the Addressee field, enter the user name you want to appear in the message, if 
applicable; this user name replaces the “%USER” variable in the pre-defined 
message. This field can be left blank if it does not apply to the message you are 
adding.

5. In the Step name field, enter the step name you want to appear in the message, if 
applicable; this step name replaces the “%STEPNAME” variable in the pre-defined 
message. This field can be left blank if it does not apply to the message you are 
adding.

6. Click OK to add the message to the case history. (The message won’t appear until 
you refresh the case history — for information about refreshing case history, see 
Refreshing the Case History.)

The following is an example using the pre-defined message file shown earlier.

This example results in the following entry being added to the case history:
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Refreshing the Case History

The information displayed in the History tab is the information that was downloaded from 
the iProcess Engine when the case list was initially displayed. You can refresh this 
information by either:

• clicking on the  icon, or 

• by selecting Refresh History from the Tools menu on the History tab.

Note that refreshing the case history refreshes the information for this single case.

Outstanding Work Items in the Case
“Outstanding items” represent the steps at which the process flow is currently sitting. 

“Normal” steps that are outstanding result in a work item appearing in one or more work 
queues. Other step types (event steps, sub-procedure call steps, etc.) result in some other 
action, such as an external program being triggered, a sub-procedure starting, etc. These 
step types do not result in a work item appearing in a work queue, although they are still 
considered “outstanding” because the process flow has halted at that step until whatever 
action was started by that step is complete.

Often, there are multiple outstanding items in a case because the process flow can take 
multiple paths, depending on how the procedure is defined.

An administrator may have a need to know which items are currently outstanding in a 
case, possibly to determine how the case is progressing. There is also a function available 
that allows one or more outstanding items to be withdrawn, and other steps to be made 
outstanding (for information about how to do this, see Jumping to New Outstanding 
Steps).

To view a list of the current outstanding items in a case, open the case, then click on the 
Outstanding tab. The following window is displayed:
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For the most part, the information provided on the list of outstanding items is the same as 
found on work item lists. For descriptions of each of the columns, see Work Item List 
Columns.

An exception is the Work Queue column, which shows you whose work queue the 
outstanding work item is in. If there is no entry in the Work Queue column, the 
outstanding item is for a step that doesn’t result in a work item — it resulted in some other 
action, such as an external program being started, a sub-procedure being called, etc.

A couple of other columns that appear on the list of outstanding work items that don’t 
appear on the work item list are Path and Sub-Case Number — these pertain to sub-cases 
— for information, see Viewing Sub-Case Information.

Also note that the Arrival Date/Time column allows you to determine how long each item 
has been outstanding, i.e., how long the process has been halted along that path (sort on 
this column by clicking on the column header).

For information about changing the columns on the list of outstanding work item, see 
Customizing Columns in a List.

Opening Outstanding Work Items

Work items in the list of outstanding work items can be opened in one of the following 
ways:

• Double-click on the desired work item in the list of outstanding work items.

• Select one or more work items in the list, then:

— press the Enter key,

— select Open Selected Work Item(s) from the Tools menu on the list,

— right-click the mouse button on the selected work item(s) and select Open 
Selected Work Item(s) from the drop-down menu, or

— click on the  icon on the list toolbar.
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Note, however, that you must have access to the work queue in which the work item 
resides to be able to open it. If you select a work item to which you don’t have access, the 
Open Selected Work Item(s) tool and menu selection is displayed. (The Open Selected 
Work Item(s) tool and menu selection is also disabled if you select multiple work items, 
and you don’t have access to any one of the selected work items.)

When opening work items from the list of outstanding work items, they are always opened 
in a floating form, i.e., they cannot be opened in the Preview Pane.

For more information about opening work items in general, see Opening Work Items.

Viewing Sub-Case Information

By default, the outstanding work item list shows outstanding work items that are located 
in sub-cases that are currently outstanding. This is controlled by the Recurse sub-cases 
for outstanding items check box. You can turn off the displaying of sub-case information 
in the current list by unchecking the Recurse sub-cases for outstanding items check box, 
then refreshing the list. You can also change the default setting for this check box using 
user options — see Sub-Case Version Options.

The following example shows both the outstanding sub-procedure call step, as well as the 
outstanding work item in the sub-case:

The following columns are available on the outstanding work item list to provide 
information about sub-procedures that have been started in the case:

• The Path column provides the path to the outstanding step, relative to the main 
procedure. This allows you to determine if the outstanding step is in the main 
procedure or a sub-procedure. For example, if the path is something like “CREDIT”, it 
is a step in the main procedure. If it consists of multiple step names separated by 
vertical bars, the outstanding step is located in a sub-procedure. For example, if the 
path is “CREDIT|CHECK”, the CREDIT step is in the main procedure and the CHECK 
step is in a sub-procedure (CREDIT would be a sub-procedure call step). If the case 
contains dynamic sub-procedure call steps or graft steps that start multiple sub-
procedures, the name of the dynamic sub-procedure call step or graft step in the 
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Path will include an index in square brackets. The index (which is zero based) 
indicates the sequential order in which the sub-procedure was started by the engine 
for that dynamic sub-procedure call step or graft step. It allows you to identify the 
path through multiple sub-procedures to the desired outstanding item. For example, 
a path of “DYNAMIC[0]|STEP1” tells you that DYNAMIC is a dynamic sub-procedure 
call step in the main procedure; the first sub-procedure it started resulted in STEP1 
being outstanding.

• The Sub-Case Number column identifies the case number of the sub-procedure 
started by the sub-procedure call step, dynamic sub-procedure call step, or graft 
step.

Refreshing the Outstanding Items List

The information displayed in the Outstanding tab is the information that was downloaded 
from the iProcess Engine when the case list was initially displayed. You can refresh this 
information by either:

• clicking the  icon, or 

• by selecting Refresh Outstanding Steps from the View menu.

Case Data Fields
Work item data is the data that is entered into forms on a work item that is then kept. 

Case data is the data that is saved in the database each time a work item is released.

The graphic below illustrates that as information is entered into forms in work items, that 
information remains with the work item as long as the work item is kept — it is written to 
case data in the database only when the work item is released (the data associated with 
the work item before it is written to case data, is referred to as work item data).
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Each case of a procedure has its own unique case data. Case data is written to the work 
item when a work item is added to a work queue.

Note that depending on how your procedure is designed, there may be more than one 
work item in a case that contains the same field. The value in the common field in each 
work item will be the value that was in case data when the work item was sent to a work 
queue. As each work item is released, the value in the field in that work item is written to 
case data. That means that when the case is finished, the value of the common field in 
case data will be the value from the last work item released that contained the common 
field.
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To view the case data for a case, open the desired case, then click on the Data tab. The 
following window is displayed:

The Name column lists all fields that are defined in the procedure/case.

The Value column lists the current values for each field in the case. These are the values 
stored in the database for the case — when a work item is opened in this case, these are 
the values that are written to that work item. Note that memo fields work a little different 
than the other field types — for information about memo fields, see Viewing Memo Field 
Values). 

Note: Since work item data is the data that is stored in the work item itself, to 
view work item data, you must open the work item and examine    the values 
entered into the fields on the form.

Viewing Memo Field Values

One of the possible types of fields that can be defined in a procedure is the memo field. 
Memo fields differ from other field types in that they do not have a set size; they can be 
unlimited length.

Memo fields are denoted on the case Data tab by “[Memo]” appearing in the Value 
column, followed by the first 60 characters of data in the memo field. For example:
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Clicking on “[Memo]” causes the text to change to a Memo button. If the cursor is placed 
over the Memo button, tool-tip text displays the first 120 characters of the text in the 
memo field; if the text in the memo field exceeds 120 characters, the tool-tip text is 
followed by “...”. 

Clicking on the Memo button displays the Memo dialog. For example:

You can change the value of the memo field by typing in the desired text, then clicking the 
OK button. The new value will be written to case data (in the database) for this case.

Refreshing Case Data

The case data displayed on the Data tab is a snap shot of the case data at the time the 
case list was downloaded from the iProcess Engine. You can refresh the case data to get 
the most recent data from the iProcess Engine by either:
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• clicking the  icon, or

• selecting Refresh Case data from the View.

Note that refreshing the case data refreshes the information for this single case.

Changing Case Data

You can directly change the values of case data using the Data tab. 

To change case data:

1. Click in the Value column for the field whose case data you want to change:

You can also use the eraser icon to clear the contents of the field.

2. Type in the desired value.          

Note: If you delete the value in a text field, the value is set to an empty 
string. If you delete the value in any other type    of field (numeric, date, 
etc.), the field is set to an uninitialized state.

Notice that once you change the value in any field, the following message is shown 
on the bottom of the Data tab to notify/remind you that there’s been a change:

3. Click the Apply button to write the new value to case data in the database.

Date Fields

Each date field on the Data tab contains a “date picker” icon to the right of the field that 
appears when you click in the date field. Clicking on the date picker icon displays a 
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calendar from which you can easily select a date. The selected date is automatically 
entered into the date field:

Time Fields

Time fields are divided into three sections: hour, minute, and AM/PM designator. You can 
move through the different sections by physically placing the cursor in the section, or by 
tabbing through them.

Each time field on the Data tab also contains a “time picker” icon to the right of the field 
that appears when you click in the time field. Clicking on the time picker icon “up” or 
“down” arrows causes the value in the portion of the field in which your cursor is located 
to increase or decrease, respectively. When the cursor is in the AM/PM portion of the field, 
clicking the “up” or “down” arrow causes it to toggle between AM and PM.

Or, you can just type in the desired values.

Case Suspensions
You can suspend activity in a case. Note that when you suspend a case, you are suspending 
the entire case family, which includes the main case and all of its sub-cases, if any. For 
information about sub-cases, see Sub-Procedures.

When a case is suspended, current work items from that case can no longer be opened.
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If a work item is already open when the case is suspended, the work item can still be kept, 
which causes the work item to become immediately suspended, and it cannot be opened 
again until the case is reactivated. The opened work item can also be released; this causes 
any new work items as a result of the release to become immediately suspended (unless 
they are flagged to ignore suspensions; see Ignoring Case Suspensions).

Other effects of suspending a case are:

• Deadlines will continue to expire. However, if a deadline expires while the case is 
suspended, no action will be carried out until the case is reactivated. Once the 
suspended case is reactivated, the process flow will proceed as if the deadline just 
expired. For more information about deadlines, see Work Item Deadlines.

• Event steps do not recognize suspensions. If you trigger an event, the event is 
processed (because it doesn’t result in a work item), but steps immediately after an 
event step that result in work items are suspended (unless they are flagged to ignore 
suspensions; see Ignoring Case Suspensions). For more information about triggering 
events, see Triggering an Event.

• Withdrawals will not occur while a case is suspended. For example, if a deadline 
expires (which occurs during suspensions), and the deadline definition states to 
withdraw the work item, the withdrawal will occur after the case has been 
reactivated. For more information about withdrawals, see Deadline Withdrawals.

Suspending a Case
To suspend one or more cases, follow these steps:

1. From the case list, select one or more cases, then:

— click on the  icon, or 

— select Suspend Case(s) from the Tools menu.

Or, from the Summary tab for a case, you can suspend that individual case by 
either:

— clicking on the  icon, or 

— by selecting Suspend Case from the Tools menu.

A dialog is displayed to confirm that you want to suspend the selected case(s). 

2. Click OK to confirm.
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Suspension Status
A case’s suspension status can be viewed in the case list in two ways: 

• Case Status Icon - After a case is suspended, the case status icon in the case list 
changes to an orange-colored ball.

• Suspended Column - Depending on how your columns are set up, you may have a 
Suspended or Suspended Image column indicating whether or not the case is 
currently suspended (see Filtering a Case List).

Ignoring Case Suspensions
When a procedure is defined, a step can be flagged to ignore case suspensions. If flagged 
to ignore case suspensions, a step is processed normally even if the case in which it is 
located has been suspended, i.e., work items representing that step can be opened and 
processed as desired.

Reactivating a Suspended Case
Reactivating a suspended case causes the process to flow as usual. Work items that were 
suspended because the case they are a part of was suspended can now be opened and 
processed normally.

To reactivate a suspended case, follow these steps:

1. From the case list, select one or more cases to reactivate, then:

— click on the  icon, or 

— select Activate Case(s) from the Tools menu.
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Or, from the Summary tab for a case, you can reactivate that individual case by:

— clicking on the  icon, or 

— by selecting Activate Case from the Tools menu.

A dialog is displayed to confirm that you want to reactivate the selected suspended 
case(s). 

2. Click OK to confirm.

Predicting the Outcome of a Case
Case prediction provides the means for predicting the expected outcome of a live case. 
Running the case prediction function causes a list of “predicted work items” to be returned 
that represent the work items that are currently due (outstanding work items), as well as 
the work items that are expected to be due in the future.

Included with the predicted work items returned is information about the expected times 
the work items are predicted to start and end, providing information that can be used to 
predict the outcome of the case. This can be used to improve work forecasting and 
estimate the expected completion of cases.

An example use of case prediction is to determine all work expected to be performed for a 
particular patient during his expected stay in the hospital.

The prediction process moves through the case step-by-step using case data that has been 
entered so far in the case. Each step uses an expected duration (decided at design time) to 
calculate a start and end processing time for each step as it progresses through the 
prediction process. When the process is complete, you can use these end processing times 
to predict the outcome of the case.

During the prediction process, deadlines are processed, and withdrawal actions are 
performed, where appropriate.

To perform a case prediction:

1. Open the desired case and display the History tab.

2. Either:

— click the  icon, or 

— select Predict Case from the Tools menu.
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A dialog similar to the following is displayed:

This provides a list of the predicted steps — the currently outstanding steps, and 
steps predicted to be outstanding as the case is processed to completion. For each 
step, it also indicates in parentheses the addressee of the step.

3. Click on a + icon to expand one of the steps to view information about the predicted 
start and end times for the step. Expanding the final step provides information 
about when the case is predicted to be completed:

In this example, the case is predicted to end at 3:27 PM on July 15, 2010. (Whether 
or not the start/end times show seconds and microseconds depends on the setting 
of the Show seconds and microseconds check box on the History tab — for more 
information, see Case History.)

Note that predicted steps can also be viewed using the graphical case history 
feature (you must configure the graphical case history display to show predicted 
steps — see Viewing a Graphical Case History).
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4. Click Close to close the Case Prediction dialog.

Changing the Process Flow in a Case
There are a couple of ways in which the process flow in a case can be altered on an ad-hoc 
basis. One allows you to jump to different steps in the procedure, while the other allows 
you to trigger an event step at any time.

These are described in the following subsections.

Jumping to New Outstanding Steps
The “process jump” feature in the iProcess Workspace (Browser) allows you to change the 
process flow of a case in the following ways:

• You can select currently outstanding steps you would like to “withdraw,” i.e., make 
them no longer outstanding. (For information about outstanding items, see 
Outstanding Work Items in the Case.)

• You can specify a set of steps to “jump to,” making those steps the new outstanding 
items. 

• You can optionally specify new case data when jumping to new outstanding work 
items. For information about case data, see Case Data Fields.

To jump to new outstanding steps:

1. Select the desired case in the case list, or open the desired case and select the 
Summary tab for the case.

2. From either the case list or the Summary tab:

— click on the  icon, or

— select Process Jump from the Tools menu.

If the case you have selected is currently active, a dialog is displayed that indicates 
the system must suspend the case while you are performing the process jump 
operation. This is because the system must display a list of the currently outstanding 
steps in the case — temporarily suspending the case prevents the outstanding steps 
in the case from changing while you are selecting from this list. The suspension is 
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automatically lifted when you are finished with the process jump operation. Click OK 
on this dialog to suspend the case and display the Process Jump dialog (see below).

If the case you have selected was already suspended, the Process Jump dialog is 
displayed:

The Select outstanding steps to withdraw section lists all of the currently 
outstanding work items in the case — these are the work items that can be 
withdrawn. (This is the same list of outstanding work items as from the Outstanding 
tab. For information about this list, such as the available columns, how to display 
sub-case information, etc., see Case Data Fields.) 

Note that, by default, the outstanding work item list shows outstanding work items 
that are located in sub-cases that are currently outstanding. This is controlled by the 
Recurse sub-cases for outstanding items check box. You can turn off the 
displaying of sub-case information in the current list by unchecking the Recurse 
sub-cases for outstanding items check box, then refreshing the list. You can also 
change the default setting for this check box using user options — see Sub-Case 
Version Options.



TIBCO iProcess® Workspace (Browser) User Guide

212 | Working With Cases

The Select new outstanding steps section lists all of the steps in the case, allowing 
you to jump to any of the steps. The Usage URL column will contain a value only if 
the step was defined with this information. The usage URL (uniform resource 
locator) is typically a link that provides information about the step.

3. In the Select outstanding steps to withdraw section, select one or more steps you 
would like to withdraw.

4. In the Select new outstanding steps section, select one or more steps you would 
like to make outstanding.

5. If you want to also change case data when the process jump is performed, click the 
Data button. The following dialog is displayed:

This dialog provides a list of all of the data fields defined in the case. You can 
change the value of one or more of the data fields. (Note that the data shown in this 
dialog is “case data”, not “work item data”. For information about the difference, 
see Case Data Fields.)
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The Case Data dialog also contains a Refresh button to allow you to get the most 
recent case data for the case. 

To change the data in a field, click in the Value column for the desired field, then 
type in the new value:

You can also use the eraser icon to clear the contents of the field.

If the case contains one or more memo fields, they are denoted by “[Memo]” 
appearing in the Value column for that field:

To change the value of a memo field, click on “[Memo]”, which causes it to change 
to a Memo button. Click on the Memo button to display the Memo dialog. Use the 
Memo dialog to modify the value of the memo field as desired, then click OK to save 
the change.

You can also choose to update the “work item data” for the case. To do this, click in 
the Update outstanding work items with new case field values check box. For 
information about the difference between case data and work item data, see Case 
Data Fields.

Click OK to apply the changes you’ve made, or Cancel to discard the changes you’ve 
made. (Note that you must click Apply on the Process Jump dialog for case data 
changes to take effect — clicking Cancel on the Process Jump dialog causes 
changes made to case data to be discarded.)

6. Enter information about why you are performing the process jump in the Reason for 
the process jump field. This is a required field. This information is added to the 
case history entry that shows the process jump:
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In this example case history, “Was overruled by VP” was entered for the process 
jump reason (this example also shows the entry for the withdrawal and the new 
work item becoming outstanding).

7. Click Apply to perform the process jump.

You can view the Outstanding tab for the case to see that the currently outstanding work 
items have changed (see Outstanding Work Items in the Case).

Triggering an Event
An event step is a step in a procedure that allows you to control the process flow in various 
ways, depending on how your procedure was designed. It can be used to perform actions 
such as:

• Suspending the flow of a case until an external action takes place.

• Starting a parallel branch of a case.

• Pausing a case for a specific period of time.

When the process flow reaches an event step, process flow is halted, and remains halted, 
until the user triggers the event. When the event is triggered, the process flow will continue 
again.

However, an event step does not need to be outstanding (i.e., process flow has reached the 
step) to be triggered. You can trigger an event step at any time, such as:

• before the process flow has reached the event step, 

• after the process flow has been halted at the event step, or

• after the event step has been triggered — one event step can be triggered multiple 
times. This allows you to run a segment of the procedure at any time, as many times 
as necessary.
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Also note that other actions can be performed when an even step is triggered. These 
include resurrecting a closed case, as well as recalculating deadlines in the case. These 
actions are described in the following steps used to trigger an event.

Event steps do not result in work items, although they do result in an outstanding item if 
the process flow has reached, and is halted, at the event step. For information about 
outstanding items, see Outstanding Work Items in the Case.

You can trigger an event step on a case that is suspended. However, steps immediately 
after an event step that result in work items are suspended (unless they are flagged to 
ignore suspensions).

To trigger an event step, follow these steps:

1. Select the desired case in the case list, or open the desired case and select the 
Summary tab, then either:

— click on the  icon, or

— select Trigger Events from the Tools menu.

If the case you had selected is a closed case, triggering an event step in the case will 
cause the closed case to be resurrected, i.e., it becomes active again. If the case is 
closed, a dialog is displayed that says that proceeding will cause the closed case to 
become active; click OK to proceed.

The following dialog is displayed:
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This dialog lists all event steps in the case. 

2. If you are using the trigger event to recalculate the deadlines in the case, click on 
the appropriate Recalculate Deadlines radio button, as follows:

— Recalculate deadlines in the main case only - Only deadlines in the main case 
are recalculated.

— Recalculate deadlines in the main and all sub-cases - Also recalculates 
deadlines in sub-procedures that have been started in this case.

The default selection of Do not recalculate deadlines when event is triggered is 
for all other uses of trigger event besides recalculating deadlines.

3. Select the event step you would like to trigger.

4. If you want to also change case data when the event is triggered, click on the Data 
button. The following dialog is displayed:
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This dialog provides a list of all of the data fields defined in the case. You can 
change the value of one or more of the data fields. (Note that the data shown in this 
dialog is “case data”, not “work item data”. For information about the difference, 
see Case Data Fields.)

The Case Data dialog also contains a Refresh button to allow you to get the most 
recent case data for the case. 

To change the data in a field, click in the Value column for the desired field, then 
type in the new value:

You can also use the eraser icon to clear the contents of the field.

If the case contains one or more memo fields, they are denoted by “[Memo]” 
appearing in the Value column for that field:
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To change the value of a memo field, click on “[Memo]”, which causes it to change 
to a Memo button. Click on the Memo button to display the Memo dialog. Use the 
Memo dialog to modify the value of the memo field as desired, then click OK to save 
the change.

If the case contains outstanding work items, you have the option of also updating 
the work item data, as well as the case data.    If the case contains outstanding work 
items, the Update outstanding work items with new case field values check box 
is displayed on the     dialog (it’s not displayed if there are no outstanding work items). 
Ensure this check box is checked if you would like to also update work     item data. 
For information about the difference between case data and work item data,     see 
Case Data Fields.         

Note: If a work item is open when you trigger an event step and update 
its work item data, when the user who has the work item open tries to 
keep or    release the work item, a message is displayed informing them 
that the work item has been updated elsewhere since they opened it. The 
keep or release     operation is cancelled and any changes to field values 
made by the user are lost. Updates to field values made by the trigger 
event are      applied.

Click OK to apply the changes you’ve made, or Cancel to discard the changes you’ve 
made. (Note that you must click OK on the Events dialog for case data changes to 
take effect — clicking Cancel on the Events dialog causes changes made to case 
data to be discarded.)

5. Click OK on the Events dialog to perform the trigger event.

Closing Cases
You can close a currently active case of a procedure, making it inactive. This stops the 
process flow for that case. 

You must have system administrator authority to close cases.



TIBCO iProcess® Workspace (Browser) User Guide

219 | Working With Cases

To close one or more cases, follow these steps:

1. Select one or more cases in the case list, or open the desired case and select the 
Summary tab.

2. Do one of the following:

From the case list, click on the  icon, or select Close Case(s) from the Tools 
menu, or right-click on the selected case(s) and select Close Case(s) from the drop-
down menu.

From the Summary tab, click on the  icon, or select Close Case from the Tools 
menu.

A dialog is displayed to confirm that you want to close the selected case(s). 

3. Either check or uncheck the Trigger events when cases are closed check box as 
follows:

— Check the box to cause a procedure-level event to be triggered when the case is 
closed. This would be used if the procedure definition catches procedure-level 
events to perform some custom business logic either before or after closing the 
case.

— Uncheck the box to prevent an event from being triggered when the case is 
closed.

4. Optionally specify a priority value in the Priority field.

This specifies the priority at which the case close occurs in the background. The 
valid entries are 0 - 999, where 0 causes the method to use the default priority. Out 
of the box, the default priority is set to 50. Therefore, if 0 is specified, it is using a 
priority of 50 (note that an administrator may have changed the default priority 
value to a value other than 50, but that is typically not done). This allows you to 
force case close requests to process before other message requests that are pending 
at the server; a value of 1 is the highest priority. You can also force case close 
requests to defer to other message requests that are sent to the server; a value of 
999 is the lowest priority.

5. Click OK to confirm you want to close the case(s).

The case’s status icon in the case list changes to a red circle (like a stop light) when it is 
closed.
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Also notice that the Terminated Date/Time column shows the date and time the case was 
closed (you must refresh the list for the date/time to appear in the Terminated Date/Time 
column).

Resurrecting a Closed Case
A closed case can be “resurrected” (i.e., it’s status changed to “active”) using the “trigger 
event” function (the procedure/case must contain an event step). For information about 
using the trigger event function to resurrect a closed case, see Triggering an Event.

Note that when a closed case is resurrected using the trigger event function, the process 
flow will proceed from the event step that was used to trigger the event.

The case’s status icon changes to a green circle after it’s been resurrected, plus the 
Terminated Date/Time column is cleared:

Purging Cases
Purging cases permanently deletes them from the system. You can purge cases that have 
any status.

You must have system administrator authority to purge cases.

To purge cases, follow these steps:

1. Select one or more cases in the case list, or open the desired case and select the 
Summary tab.

2. Do one of the following:
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From the case list, click on the  icon, or select Purge Case(s) from the Tools 
menu, or right-click on the selected case(s) and select Purge Case(s) from the drop-
down menu.

From the Summary tab, click on the  icon, or select Purge Case from the Tools 
menu.

Two dialogs are displayed to confirm that you want to purge the selected case(s) 
(because it is non-reversible).

3. On the first confirmation dialog, either check or uncheck the Trigger events when 
cases are purged check box as follows:

— Check the box to cause a procedure-level event to be triggered when the cases 
are purged. This would be used if the procedure definition catches procedure-
level events to perform some custom business logic before purging the cases.

— Uncheck the box to prevent an event from being triggered when the case is 
purged.

4. Optionally specify a priority value in the Priority field.

This specifies the priority at which the case purge occurs in the background. The 
valid entries are 0 - 999, where 0 causes the method to use the default priority. Out 
of the box, the default priority is set to 50. Therefore, if 0 is specified, it is using a 
priority of 50 (note that an administrator may have changed the default priority 
value to a value other than 50, but that is typically not done). This allows you to 
force case purge requests to process before other message requests that are 
pending at the server; a value of 1 is the highest priority. You can also force case 
purge requests to defer to other message requests that are sent to the server; a 
value of 999 is the lowest priority.

5. Click OK to confirm you want to purge the case(s).

The case’s status icon in the case list changes to a black circle after you’ve purged it.

Refreshing the case list causes purged cases to be removed from the list.
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User Options
This section describes setting up user options, which define system behavior based on the 
user that logs into the system.

Introduction
User options establish default settings for each user that logs into the iProcess Workspace 
(Browser). These include things such as whether the procedure list or work queue list is 
displayed when the user first logs in, whether preview is turned on by default, the 
size/location of work item forms, etc.

To set your user options, click on the Options button or icon in the lower left part of the 
iProcess Workspace (Browser) window.

If you are displaying buttons:

If you are displaying icons:

The following dialog is displayed:
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Scroll down this dialog to view all of the available user options. 

You can use the Defaults button to return all options to their default values. (Default 
values are specified in the iProcess Workspace (Browser) configuration file — for 
information, see the TIBCO iProcess Workspace (Browser) Configuration and Customization 
guide.)

The Save and Close button saves any changes you’ve made and closes the Options dialog.

The Close button closes the Options dialog without saving changes.
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Note: If you leave the Options dialog without clicking the Save and Close nor 
Close button (e.g., by clicking one of the other    mode selection buttons), any 
changes made will not be saved.

User Options Persistence
Settings you make on the Options dialog are persisted (i.e., saved) in one of two places, 
depending on a configuration parameter set by the system administrator:

• Locally - If persisted locally, user options you specify will be in effect only when you 
log into TIBCO iProcess Workspace (Browser) from the same machine. If you log into 
the TIBCO iProcess Workspace (Browser) on a different machine (and connect to the 
same server), the user options you specified will not be in effect on that new 
machine — user options defined on a specific machine will apply only to that 
individual machine. 

• On the Server - If persisted on the server, and you log into a different machine (and 
connect to the same server), the user options you defined will be in effect on the 
new machine.

 

Display Options
The Display Options section allows you to set the following user options:

• Language - Specifies the language to display in the iProcess Workspace (Browser).

• Initial Display - Specifies whether the work queue list or the procedure list is 
initially displayed when you start the iProcess Workspace (Browser).

• Work Queue Reference - Specifies whether work queues are referenced by their 
name or description.

• Procedure Reference - Specifies whether procedures are referenced by their name 
or description.

• Auto-Refresh of Work Item Lists - Specifies whether or not the auto-refresh feature 
on work item lists should be enabled or disabled by default every time you log in.
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These are described in the following subsections.

Language
You can specify which language to display on all of the screens and windows in the 
iProcess Workspace (Browser).

To specify the language:

1. Click the Options button/icon to display the Options dialog.

2. Locate the Display Options section on the Options dialog.

3. In the Select language to display field, select the desired language:

4. Click Save and Close to save the changes and close the Options dialog.

Initial Display
The initial display user option allows you to specify which list is initially displayed when 
you log in: work queue list or procedure list.

To specify the default initial display:

1. Click the Options button/icon to display the Options dialog.

2. Locate the Display Options section on the Options dialog.

3. Using the Select which list initially displays at startup radio buttons, select either 
Work Queues or Procedures:
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4. Click Save and Close to save the changes and close the Options dialog.

Work Queue Reference
This user option allows you to specify whether the work queue name or work queue 
description is displayed in the work item list caption.

In the following example, the description (System Administrator) is used as a caption, 
rather than the name (swadmin). (Names and descriptions are chosen by administrators 
when they add users to the system.)

To specify whether the name or description should be used to reference the work queue in 
the work item list:

1. Click the Options button/icon to display the Options dialog.

2. Locate the Display Options section on the Options dialog.
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3. Using the Work Queues may be referenced by name or description radio buttons, 
select either Show Work Queue Names or Show Work Queue Descriptions:

4. Click Save and Close to save the changes and close the Options dialog.

Procedure Reference
This user option allows you to specify whether the procedure name or procedure 
description is displayed in the case list caption.

In the following example, the description (Company Car Allocation) is used as a caption, 
rather than the name (CARPOOL). (Names and descriptions are chosen by administrators 
when the procedure is defined.)

To specify whether the name or description should be used to reference the procedure in 
the case list:

1. Click the Options button/icon to display the Options dialog.
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2. Locate the Display Options section on the Options dialog.

3. Using the Procedure may be referenced by name or description radio buttons, 
select either Show Procedure Names or Show Procedure Descriptions:

4. Click Save and Close to save the changes and close the Options dialog.

Auto-Refresh of Work Item Lists
This display option allows you to specify whether or not the auto-refresh feature on work 
item lists should be enabled or disabled by default every time you log in. When enabled, 
work item lists are automatically refreshed at a specified interval.

For information about the auto-refresh feature, see Auto-Refresh of Work Item Lists.

To set the default behavior of auto-refresh:

1. Click the Options button/icon to display the Options dialog.

2. Locate the Display Options section on the Options dialog.

3. Either check (to enable) or uncheck (to disable) the Auto-refresh lists of work 
items check box to specify the default behavior of the auto-refresh feature whenever 
you log in:

If you check the Auto-refresh lists of work items check box, also specify the 
following:

In the Auto-refresh interval field, specify the auto-refresh interval, in seconds. The 
minimum allowed is 5 seconds.

Choosing the Apply auto-refresh settings to all open lists radio button causes 
auto-refresh settings via the Options dialog to be applied to all work item lists 
currently open, as well as new lists opened in the future. 
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Choosing the Only apply auto-refresh settings to new lists radio button causes 
auto-refresh settings via the Options dialog to only apply to newly opened work 
item lists — not to lists that are currently open. 

4. Click Save and Close to save the changes and close the Options dialog.

Filter Options
The Filter Options section allow you to set the following user options:

• Work Item Filters - Specifies whether or not to display the filter dialog before 
displaying the work item list.

• Case Filters - Specifies whether or not to display the filter dialog before displaying 
the case list.

Work Item Filters
This user option is used to specify whether or not to display the filter dialog before 
displaying the work item list.

To define the work item list filtering option:

1. Click the Options button/icon to display the Options dialog.

2. Locate the Filter Options section on the Options dialog.

3. Using the Work Item Filters radio buttons, select the appropriate option based on 
the descriptions below:
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— Always specify a filter... - If this radio button is selected, the filter dialog is 
always displayed first when you select a work queue from the work queue list. 
This allows you to apply a filter before displaying the work item list.

— Never specify a filter... - If this radio button is selected, the filter dialog is not 
displayed first when you select a work queue from the work queue list. The first 
page of the work item list is always displayed. If you choose to filter the list later, 
you can click on the Filter icon and enter a filter expression.

— Specify a filter if the number... - This radio button is used in conjunction with 
the Threshold field below the Work Item Filters radio buttons. If this radio 
button is selected, the work item list is displayed only if the number of work 
items in the work queue does not exceed the number in the Threshold field. If 
the number exceeds the threshold, the filter dialog is displayed first, allowing 
you to apply a filter before displaying the work item list.

If you specify a threshold value, you can also force the user to filter the work 
items until the number of work items is below the threshold value. To do this, 
select the Force a filter... check box. This causes the filter dialog to be 
displayed, and forces the user to specify a filter that brings the number of work 
items below the threshold before the work item list is displayed.         

Note: For more information about filtering work item lists,    see 
Filtering a Work Item List.

4. Click Save and Close to save the changes and close the Options dialog.

Case Filters
This user option is used to specify whether or not to display the filter dialog before 
displaying the case list.

To define the case list filtering option:

1. Click the Options button/icon to display the Options dialog.

2. Locate the Filter Options section on the Options dialog.

3. Using the Case Filters radio buttons, select the appropriate option based on the 
descriptions below:
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— Always specify a filter... - If this radio button is selected, the filter dialog is 
always displayed when you select a procedure from the procedure list. This 
allows you to apply a filter before the list of cases is displayed.

— Never specify a filter... - If this radio button is selected, the entire case list is 
always displayed whenever you select a procedure from the procedure list. 

— Specify a filter if the number... - This radio button is used in conjunction with 
the Threshold field below the Case Filters radio buttons. If this radio button is 
selected, the case list is displayed when you select a procedure from the 
procedure list only if the number of cases of that procedure does not exceed the 
number in the Threshold field. If the number exceeds the threshold, the filter 
dialog is displayed first, allowing you to apply a filter prior to displaying the case 
list.

If you specify a threshold value, you can also force the user to filter the cases 
until the number of cases is below the threshold value. To do this, select the 
Force a filter... check box. This causes the filter dialog to be displayed, and 
forces the user to specify a filter that brings the number of cases below the 
threshold before the case list is displayed.         

Note: For more information about filtering case lists, see Filtering a 
Case List.

 

4. Click Save and Close to save the changes and close the Options dialog.

Layout Options
The Layout Options section allows you to set the following user options:
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• Case Preview Default - Specifies whether the case details should be shown in the 
Preview Pane by default. This option also allows you to specify whether or not to 
automatically resize the Preview Pane when opening a case, as well as the 
percentage to resize.

• Work Item Preview Default - Specifies whether the work item summary should be 
shown in the Preview Pane by default. This option also allows you to specify 
whether or not to automatically resize the Preview Pane when opening a work item, 
as well as the percentage to resize.

• Floating Work Item Form Window - Specifies the type of window in which work 
items are opened when using floating windows.

• Default Position/Size of Floating Windows - Specifies the default position and size 
of floating windows used for work item forms and case details.

These are described in the following subsections.

Case Preview Default 
This user option specifies the default setting of the Preview feature on the case list. 

Each time you log in, the default specified here is in effect. You can change the current 
setting at any time using the Preview feature drop-down menu shown above. But the next 
time you log in, the default setting is in effect again. 

For more information about the Preview feature, see Preview Pane.

To specify the case preview default:

Procedure 

1. Click the Options button/icon to display the Options dialog.

2. Locate the Layout Options section on the Options dialog.

3. Using the Case Preview Default radio buttons, select the option you would like to 
be set as the default for the Preview feature on the case list:
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Notice that if you choose Preview On - open case detail in preview pane, 
additional radio buttons are displayed that allow you to specify whether or not the 
Preview Pane is automatically resized when a case is opened in the Preview Pane. If 
you choose to resize the Preview Pane, also enter a percentage (from 1% - 100%) in 
the % Percentage of viewing area ... field; this specifies the amount of the viewing 
area the Preview Pane will encompass when a case is open. When you close the case 
details, the Preview Pane reverts to its previous size.

4. Click Save and Close to save the changes and close the Options dialog.

Work Item Preview Default
This user option specifies the default setting of the Preview feature on the work item list. 

Each time you log in, the default specified here is in effect. You can change the current 
setting at any time using the Preview feature drop-down menu shown above. But the next 
time you log in, the default setting is in effect again. 

For more information about the Preview feature, see Preview Pane.

To specify the work item preview default:

Procedure 

1. Click the Options button/icon to display the Options dialog.

2. Locate the Layout Options section on the Options dialog.
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3. Using the Work Item Preview Default radio buttons, select the option you would 
like to be set as the default for the Preview feature on the work item list:

Notice that if you choose Preview On - open work item forms in preview pane, 
additional radio buttons are displayed that allow you to specify whether or not the 
Preview Pane is automatically resized when a work item is opened in the Preview 
Pane. If you choose to resize the Preview Pane, also enter a percentage (from 1% - 
100%) in the % Percentage of viewing area ... field; this specifies the amount of 
the viewing area the Preview Pane will encompass when a work item is open. When 
you close the work item, the Preview Pane reverts to its previous size.

4. Click Save and Close to save the changes and close the Options dialog.

Floating Work Item Form Window 
This user option specifies the type of window in which the work item form is opened. This 
is applicable only if you are opening work item forms in a separate window; it is not 
applicable if you are opening work item forms in the Preview Pane. For information about 
the location in which work item forms are opened, see Preview Pane.
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Note: This function may not be available to you, depending on the type of forms 
you are using. When your application was developed,    the developers chose a 
method of creating the work item forms. The method they chose determines 
whether or not you have this function available     (you may need to ask the system 
administrator which type of forms your application uses).         

— if your application uses forms created with TIBCO® General Interface 
Builder (GI forms), this function is available because GI forms can be 
displayed in any of the three available formats: Preview Pane, 
separate dialog, or separate browser window.

— if your application uses any non-GI form (also referred to as “external 
forms”), this function is not      available because non-GI forms can only 
be displayed in a separate browser window.

 

 

To specify the type of window in which work item forms are opened (when using floating 
windows):

Procedure 

1. Click the Options button/icon to display the Options dialog.

2. Locate the Layout Options section on the Options dialog.

3. Using the When opening a floating work item form, open it in radio buttons, 
select whether you would like work item forms to be opened in a dialog or a new 
browser window:

4. If you have selected to open floating forms in a dialog, also choose whether or not 
to make the dialog modal by checking or unchecking the Modal dialog check box 
(which is shown only if you have selected the A dialog radio button). (When a modal 
dialog is open, you cannot perform any other function until the dialog is closed.)

5. Click Save and Close to save the changes and close the Options dialog.
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Note: The setting of this user option can be overridden for a particular work 
item form by a configuration parameter    set by the system administrator. So, 
even though you specify to open floating windows containing work item forms 
in a separate dialog, for any particular     work item, it may open in a separate 
browser window.

Default Position/Size of Floating Windows
This user option allows you to specify the default position and size of floating work item 
forms. 

To specify the default floating window position and size:

1. Click the Options button/icon to display the Options dialog.

2. Locate the Layout Options section on the Options dialog.

3. Using the Default position and size... fields and check boxes, check either the Full 
Screen or Center check box, or uncheck them both, to specify that you want the 
window/dialog to be full screen, centered in the screen, or in a different position 
(uncheck both boxes):

Some or all of the fields may become inactive, depending on which of the check 
boxes are checked.

4. Optionally enter values in the Left, Top, Width, and Height fields to specify the 
window/dialog position, in pixels.

5. Optionally check the Remember Floating Window Position check box to specify 
you want the system to remember the size and position of the floating window if 
you manually move it or resize it on your screen. 

If this check box is checked, the application will remember if you manually resize 
and/or re-position the work item form on your screen, and will size and position 
future forms. If this check box is not checked, future forms will all open in the 
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position and size specified by the Default position and size... fields — it does not 
remember the size and location of work item forms you have manually 
resized/repositioned.

Also note that the Remember Floating Window Position option is not applicable 
for external forms (i.e., non-GI forms). The size and position of external forms is not 
remembered nor persisted — they always open according to the default settings of 
the Layout Options". 

6. Click Save and Close to save the changes and close the Options dialog.

Outstanding Item Options
This user option specifies the default setting of the Recurse sub-cases for outstanding 
items check box on lists of outstanding work items, which specifies whether or not the 
outstanding work items list should include work items in sub-cases.

For information about the outstanding work items list, see Outstanding Work Items in the 
Case.

To specify this default setting:

1. Click the Options button/icon to display the Options dialog.

2. Locate the Outstanding Item Options section on the Options dialog.

3. In this section, click the appropriate radio button, as follows:

— Recurse sub-cases for outstanding items - This causes the Recurse sub-cases 
for outstanding items check box on outstanding work item lists to be checked 
by default. 

— Only show items from the main case - This causes the Recurse sub-cases for 
outstanding items check box on outstanding work item lists to be unchecked by 
default.
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4. Click Save and Close to save the changes and close the Options dialog.

Session Options
The Session Options section allows you to set the following user options:

• Session Activity Log - Specifies how much information to write to the Session 
Activity log.

• Change Password - Allows the logged-in user to change his/her password.

Session Activity Log
This user option allows you to specify how much information to write to the Session 
Activity log. For information about the Session Activity log, see Login Session.

To specify the amount of session activity logging:

1. Click the Options button/icon to display the Options dialog.

2. Locate the Session Options section on the Options dialog.

3. Using the scrollable list of check boxes, check the activities you would like included 
in the Session Activity log:

4. Click Save and Close to save the changes and close the Options dialog.

Change Password
You can change your password at any time using this option.

To change your password:
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1. Click the Options button/icon to display the Options dialog.

2. Locate the Session Options section on the Options dialog.

3. Click on the Change Password button:

The Change Password dialog is displayed.

4. Enter your existing password in the Old Password field.

5. Enter your new password in the New Password field, then again in the Confirm 
New Password field.

6. Click OK to save the password changes and close the Change Password dialog.

7. Click Save and Close to save the changes and close the Options dialog.

Sub-Case Version Options
This option specifies the default order in which sub-procedure statuses are looked for 
when sub-procedures are started from another procedure.

To specify the sub-case precedence:

1. Click the Options button/icon to display the Options dialog.

2. Locate the Sub-Case Version Options section on the Options dialog.

3. Using the radio buttons in this section, select the desired precedence.

For instance, if you select the Model > Released radio button, when a sub-case is 
started, the system will look for a model status of the sub-procedure first; if no 
model status of that sub-procedure exists, it will look for one with a released status.
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The default is Released — the system will only look for the sub-procedure with a 
released status.

4. Click Save and Close to save the changes and close the Options dialog.

Note: Even though the “Sub-Case Version Options” section name refers to the 
precedence selections as “versions”,    they are really “statuses.”

For more information about procedure statuses,     see Procedure Status.             For more 
information about sub-procedures, see Sub-Procedures.
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User Administration
This section describes how users, groups, roles, and attributes are used in the TIBCO 
iProcess Workspace (Browser) installation.

Administering Users
The following provides definitions The following provides definitions of user-related terms 
used in the iProcess Workspace (Browser).

 

Term Definition

User A user is a person who has been defined on the iProcess Engine, and has been 
given a user name and password, which authorizes that user to log in to the 
iProcess Workspace (Browser).

Each user has a personal work queue into which work items that are addressed 
to that user are placed.

Group A group consists of a number of users. For example, a "Loan Reviewers" group 
might consist of a number of users whose responsibility it is to review loan 
applications.

Each group has a work queue into which work items that are addressed to the 
group are placed.

All users that are members of the group have access to the work items in the 
group’s work queue.

Role A role is a job title or function, such as “Account Manager.” One user is assigned 
to the role. Then when a procedure is defined, the addressee of a step can be 
the “Account Manager.” Work items sent to “Account Manager” are actually sent 
to the user assigned to that role. That way if the person assigned to the job title 
(role) changes, all you have to do is change the user assigned to the role, rather 
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Term Definition

than change the procedure definition.

Attribute An attribute is a property/characteristic of a user. When a user is defined on the 
system, attributes are specified for the user. One of particular importance for 
the iProcess Workspace (Browser) is the MENUNAME attribute. This attribute, 
which is assigned a value such as “User”, “Manager”, “Admin”, etc., specifies the 
user’s access to functions in the application. For more information, see User 
Access Profiles.

Users, groups, roles, and attributes can be created, changed, or deleted using the TIBCO 
iProcess User Manager. Information about using the User Manager can be found in the 
TIBCO iProcess Workspace (Windows) Manager’s Guide.
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TIBCO Documentation and Support Services
For information about this product, you can read the documentation, contact TIBCO 
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the Product Documentation website, 
mainly in HTML and PDF formats.    

The Product Documentation website is updated frequently and is more current than any 
other documentation included with the product.

Product-Specific Documentation

Documentation for TIBCO iProcess® Workspace (Browser) is available on the      TIBCO 
iProcess® Workspace (Browser) Product Documentation page. 

How to Contact Support for TIBCO Products

You can contact the Support team in the following ways:    

 l To access the Support Knowledge Base and getting personalized content about 
products you are interested in, visit our product Support website.     

 l To create a Support case, you must have a valid maintenance or support contract 
with a Cloud Software Group entity. You also need a username and password to log 
in to the product Support website. If you do not have a username, you can request 
one by clicking Register on the website.      

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee 
subject matter experts to share and access their collective experience. TIBCO Community 
offers access to Q&A forums, product wikis, and best practices. It also offers access to 
extensions, adapters, solution accelerators, and tools that extend and enable customers to 
gain full value from TIBCO products. In addition, users can submit and vote on feature 

https://docs.tibco.com/
https://docs.tibco.com/
https://docs.tibco.com/products/tibco-iprocess-workspace-browser
https://docs.tibco.com/products/tibco-iprocess-workspace-browser
https://support.tibco.com/
https://support.tibco.com/
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requests from within the      TIBCO Ideas Portal. For a free registration, go to      
TIBCO Community.    

https://ideas.tibco.com/
https://community.tibco.com/
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Legal and Third-Party Notices
SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED, 
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE 
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE 
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG 
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED  SOFTWARE IS NOT LICENSED TO BE USED OR 
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER 
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS 
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO 
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN 
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS 
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP 
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE 
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF 
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this 
document may be reproduced in any form without the written authorization of Cloud Software 
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, and iProcess are either registered trademarks or 
trademarks of Cloud Software Group, Inc. in the United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of 
their respective owners and are mentioned for identification purposes only. You acknowledge that all 
rights to these third party marks are the exclusive property of their respective owners. Please refer to 
Cloud SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is 
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

Cloud SG software may be available on multiple operating systems. However, not all operating 
system platforms for a specific software version are released at the same time. See the “readme” file 
for the availability of a specific version of Cloud SG software on a specific operating system platform.

https://www.cloud.com/legal
https://scripts.sil.org/OFL
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES 
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED 
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN 
THE PRODUCT(S), THE PROGRAM(S),  AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY 
TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR 
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT 
NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer 
to the Virtual Patent Marking document located at https://www.cloud.com/legal.

Copyright © 2005-2025. Cloud Software Group, Inc. All Rights Reserved.

https://www.cloud.com/legal
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